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Introduction

icrosoft Visual Basic 2013 is an important upgrade and enhancement of the popu-

lar Visual Basic programming language and compiler, a technology that enjoys an
installed base of millions of programmers worldwide. Visual Basic 2013 is not a stand-
alone product but a key component of Microsoft Visual Studio 2013—a comprehensive
development system that allows you to create powerful applications for Microsoft
Windows 8.1, the Windows desktop, the web, Windows Phone 8, and a host of other
environments.

Whether you purchase one of the commercial editions of Visual Studio 2013 or you
download Visual Basic Express 2013 for a free test-drive of the software, you are in for
an exciting experience. The latest features of Visual Basic will increase your productivity
and programming prowess, especially if you enjoy using and integrating information
from databases, entertainment media, webpages, and websites. In addition, an impor-
tant benefit of learning Visual Basic and the Visual Studio Integrated Development
Environment (IDE) is that you can use many of the same tools to write programs for
Microsoft Visual C# 2013, Microsoft Visual C++ 2013, HTML5 and JavaScript, and other
popular languages.

Microsoft Visual Basic 2013 Step by Step is a comprehensive introduction to Visual
Basic programming using the Visual Basic 2013 software and Windows 8.1. I've
designed this practical, hands-on tutorial with a variety of skill levels in mind. In my
opinion, the best way to master a complex technology like Visual Basic is to follow the
premise that programmers learn by doing. Therefore, by reading this book and working
through the examples, you'll learn essential programming techniques through carefully
prepared tutorials that you can complete on your own schedule and at your own pace.

Although | have significant experience with college teaching and corporate proj-
ect management, this book is not a dry textbook or an "A to Z" programmer’s refer-
ence; instead, it is a practical hands-on programming tutorial that puts you in charge
of your learning, developmental milestones, and achievements. By using this book,
programmers who are new to this topic will learn Visual Basic software development
fundamentals in the context of useful, real-world applications; and intermediate Visual
Basic programmers can quickly master the essential tools and techniques offered in the
Visual Basic 2013 and Windows 8.1 upgrades.

I've taken a multiplatform approach in this book, so in addition to learning Visual
Basic programming skills you'll learn to create a wide variety of applications, including
Windows Store apps, Windows Forms (Windows desktop) apps, console apps, web apps
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(ASP.NET), and Windows Phone 8 apps. Each of these application types has a place and
a purpose in real-world development.

To complement this comprehensive approach, the book is structured into 5 topically
organized parts, 21 chapters, and dozens of step-by-step exercises and sample pro-
grams. By using this book, you'll quickly learn how to create professional-quality Visual
Basic 2013 applications for the Windows operating system, Windows Phone 8 platform,
and a variety of web browsers. You'll also have fun!

Who should read this book

This is a step-by-step programming tutorial for readers who enjoy learning to do new
things by doing them. My assumption is that you already have some experience with
programming, possibly even an earlier version of Visual Basic, and that you are ready to
learn about the Visual Studio 2013 product in the context of building applications that
you can market in the Windows Store, Windows Forms (Windows desktop) for personal
and enterprise purposes, web (ASP.NET) applications that run in browsers, and apps for
the Windows Phone 8 platforms.

This book’s content will supply you with concrete Visual Basic coding techniques as
well as a broad overview of programming strategies suitable for Visual Basic develop-
ment. The book’s extensive collection of step-by-step exercises has a broad focus; they
are written for technical people who understand programming and are not simply
targeted toward hobbyists or absolute beginners. In addition, you will learn about the
capabilities of the Windows 8.1 operating system and the specific design guidelines that
Microsoft recommends for Windows 8.1 and Windows Phone 8 applications.

Assumptions

This book is designed to teach readers how to use the Visual Basic programming
language. You will also learn how to use the Visual Studio 2013 IDE and development
tools. This book assumes no previous experience with Visual Studio 2013, but it is
written for readers who understand programming and are not absolute beginners. |
assume that you are familiar with programming basics or have studied some version of
BASIC or Visual Basic in the past and are now ready to move beyond elementary skills
to platform-specific techniques.

If you have no prior knowledge of programming or Visual Basic, you might want to
fill in some of the gaps with my introduction to Visual Basic 2012 and Windows Store
development, Start Here! Learn Visual Basic 2012 (Microsoft Press, 2012). From time
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to time, | will refer to the exercises in that book to give you additional resources for
your learning.

Microsoft Visual Basic 2013 Step by Step also assumes that you have acquired and
are running the Windows 8.1 operating system and that you want to learn how to
create applications for the Windows Store platform and other environments. To make
the most of your programming practice, you will need to know a little about how to
perform common tasks in Windows 8.1, how to customize the Start page and user
interface, how to work with information on the web, and how to adjust basic system
settings. If you also have Windows 8.1 installed on a tablet or touchpad device, all the
better, because a fundamental design emphasis of Windows 8.1 is to make touch and
gestures a natural way to manipulate content. You can build your applications on a
laptop or desktop running Visual Studio 2013 and Windows 8.1 and then test out the
applications on your tablet or touchpad.

In terms of the Visual Studio software, | assume that you are using one of the full,
retail versions of Visual Studio 2013, such as Visual Studio Professional, Premium, or
Ultimate. This will enable you to create the full range of application types that | describe
in this book, including Windows Store apps, Windows Forms (Windows desktop) apps,
console apps, Web Forms (ASP.NET) apps, and Windows Phone 8 apps.

If you don't have access to a full, retail version of Visual Studio 2013, you can experi-
ment with the Visual Studio 2013 software by downloading free versions of the suite
designed for specific platforms. These limited-feature or “Express” versions of Visual
Studio 2013 are called Express for Windows, Express for Windows Desktop, Express for
Windows Phone, and Express for Web. The Visual Studio website (http.//www.microsoft.
comyvisualstudio) provides access to the retail and Express versions of Visual Studio, and
it explains the differences among all of the available versions.

Who should not read this book

You might be disappointed with this book if you are already a knowledgeable Visual
Basic programmer and are just looking to explore the new features of Visual Studio
2013. The Step By Step series is targeted toward readers who are professional develop-
ers but who have little to no previous experience with the topic at hand. If you are an
advanced Visual Basic developer, you are likely to grow weary of the step by step exer-
cises that introduce essential features such as decision structures, XAML markup, data
access strategies, or using the .NET Framework.

Introduction Xix


http://www.microsoft.com/visualstudio
http://www.microsoft.com/visualstudio

XX

Developers who have a lot of experience will feel that I'm exploring the obvious—
but what is obvious to experienced programmers often isn't obvious at all to someone
who is learning to use a new development platform. If Windows Store or Windows
Phone programming with Visual Basic is a new concept for you, this is the place to start.

Organization of this book

This book is divided into five sections, each of which focuses on a different aspect

or technology within the Visual Studio software and the Visual Basic programming
language. Part I, “Introduction to Visual Studio development,” provides an overview of
the Visual Studio 2013 IDE and its fundamental role in .NET application creation and
then moves into step-by-step development walkthroughs on the Windows Store and
Windows Forms (Windows desktop) platforms.

Part Il, “Designing the user interface,” continues the focus on application creation in
the Visual Studio IDE, emphasizing the construction of Windows Store apps, Windows
Forms (Windows desktop) apps, and console apps. In particular, you'll learn how to
work with XAML markup, XAML styles, important controls, and new Windows 8.1
design features, including command bar, flyout, tiles on the Windows Start page, and
touch input.

Part Ill, “Visual Basic programming techniques,” covers core Visual Basic program-
ming skills, including managing data types, using the .NET Framework, structured error
handling, working with collections and generics, data management with LINQ, and
fundamental object-oriented programming skills.

Part IV, "Database and web programming,” introduces data management tech-
nigues in Windows desktop and Windows Store applications, including binding data to
controls and working with XML documents and Microsoft Access data sources. You'll
also get an overview of ASP.NET web development strategies, along with a complete
walkthrough of web development on the Web Forms (ASP.NET) platform.

Finally, Part V, "Microsoft Windows Phone programming,” provides an overview
of the features and capabilities presented by the Windows Phone 8 platform. You'll
identify key hardware characteristics in the Windows Phone ecosystem, the market-
ing opportunities tendered by the Windows Phone Store, and you'll create a complete
Windows Phone 8 app step by step.
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Finding your best starting point in this book

This book is designed to help you build skills in a number of essential areas. You can use

it if you're new to programming, switching from another programming language, or
upgrading from Visual Studio 2010 or Visual Basic 2012. Use the following table to find

your best starting point in this book.

If you are ...

New to Visual Basic programming

Follow these steps

1.

Install the sample projects as described in
the section “Installing the code samples,”
later in this Introduction.

Learn essential skills for using Visual
Studio and Visual Basic by working
sequentially from Chapter 1 through
Chapter 21.

Use the companion book Start Here!
Learn Microsoft Visual Basic 2012 for
additional instruction as your level of
experience dictates.

Upgrading from Visual Basic 2010 or 2012

Install the sample projects as described in
the section “Installing the code samples.”

Read Chapter 1, skim Chapters 2 through
4, and complete Chapters 5 through 21.

Interested primarily in creating Windows
Store apps for Windows 8.1

Install the sample projects as described in
the section “Installing the code samples.”

Complete Chapters 1 through 3, Chapter
5, Chapters 7 through 16, and Chapter
18.

Interested primarily in creating Windows
Forms (Windows desktop) apps for
Windows 8.1, Windows 8, or Windows 7

Install the sample projects as described in
the section “Installing the code samples.”

Complete Chapters 1 through 2, Chapter
4, Chapter 6, Chapter 10, and Chapters 11
through 17.

Introduction
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Conventions and features in this book

This book presents information using the following conventions designed to make the
information readable and easy to follow:

Each exercise consists of a series of tasks, presented as numbered steps (1, 2,
and so on) listing each action you must take to complete the exercise.

The names of all program elements—controls, objects, methods, functions,
properties, classes, variable names, and so on—appear in italics.

As you work through steps, you'll occasionally see tables with lists of properties
that you'll set in Visual Studio. Text properties appear within quotes, but you
don't need to type the quotes.

Boxed elements with labels such as “Note” provide additional information or
alternative methods for completing a step successfully.

Text that you type (including some code blocks) appears in bold.

A plus sign (+) between two key names means that you must press those keys at
the same time. For example, “Press Alt+Tab” means that you hold down the Alt
key while you press the Tab key.

A vertical bar between two or more menu items (for example, File | Close)
means that you should select the first menu or menu item, then the next, and
so on.

System requirements

You will need the following hardware and software to work through the examples in
this book:

Introduction

The Windows 8.1 operating system. (Depending on your Windows configura-
tion, you might also require Local Administrator rights to install or configure
Visual Studio 2013.) Note that while the full versions of Visual Studio 2013 do
support earlier versions of Windows, such as Windows 8 and Windows 7 SP1,
the features described in this book require Windows 8.1, and the screen shots
will all show this environment.



A full retail edition of Visual Studio 2013, required for completing all of the
exercises in this book (Visual Studio 2013 Professional, Premium, or Ultimate).
The Visual Studio website (http.//www.microsoft.com/visualstudio) explains the
differences among these versions. Alternatively, you can experiment with the
Visual Studio 2013 software by downloading free versions of the suite designed
for specific platforms. The limited-feature versions of Visual Studio 2013 are
called Express for Windows, Express for Windows Desktop, Express for Windows
Phone, and Express for Web. You will need to download all four of these
Express versions to get the necessary software to complete the book’s exercises.
(However, even with these Express editions, there will be a few gaps; for exam-
ple, you will be unable to complete Chapter 10, “Creating console applications.”)

An Internet connection to view Visual Studio help files, try out the Windows
Store and Windows Phone Store, and download this book’s sample files.

A computer with 1.6 GHz or faster processor.

1 GB RAM (32-bit) or 2 GB RAM (64-bit).

16 GB available hard disk space (32-bit) or 20 GB (64-bit) for Windows 8.1.
DirectX 9 graphics device with WDDM 1.0 or higher driver.

1024 x 768 minimum screen resolution.

If you want to use touch for user input, you'll need a multitouch-capable laptop,
tablet, or display. A multitouch-capable device is optional for the exercises in this book,
although one is useful if you want to understand what such devices are capable of.
Typically, a programmer will develop software on a desktop or laptop computer and
then test multitouch functionality on a multitouch-capable device.

Although this book develops applications for Windows Phone 8, a Windows Phone is
not required to complete the book'’s step-by-step exercises.
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Code samples

Most of the chapters in this book include step-by-step exercises that let you interac-
tively try out new material learned in the main text. All sample projects can be down-
loaded from the following page:

http://aka.ms/VB2013_SbS/files

Follow the instructions to download the Visual_Basic_2013_SBS_Sample_Code.zip file.

Installing the code samples

Follow these steps to install the code samples on your computer so that you can use
them with the exercises in this book:

1. Unzip the Visual_Basic_2013_SBS_Sample_Code.zip file that you downloaded
from the book’s website. (Name a specific directory along with directions to
create it, if necessary.) | recommend My Documents\Visual Basic 2013 SBS for
the files.

2. If prompted, review the displayed end user license agreement. If you accept the
terms, select the accept option, and then click Next.

Using the code samples

The code samples .zip file for this book creates a folder named Visual Basic 2013 SBS
that contains 19 subfolders—one for each of the chapters in the book that have exer-
cises. To find the examples associated with a particular chapter, open the appropriate
chapter folder. You'll find the examples for that chapter in separate subfolders. The
subfolder names have the same names as the examples in the book. For example, you'll
find an example called Music Trivia in the My Documents\Visual Basic 2013 SBS\Chapter
02 folder on your hard drive. If your system is configured to display file extensions of
the Visual Basic project files, look for .sIn as the file extension. Depending on how your
system is configured, you might see a Documents folder rather than a My Documents
folder.
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We've made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on our
Microsoft Press site at oreilly.com:

http://aka.ms/VB2013_SbS/errata

If you find an error that is not already listed, you can report it to us through the
same page.

If you need additional support, email Microsoft Press Book Support at mspinput@
microsoft.com.

Please note that product support for Microsoft software is not offered through the
addresses above.

We want to hear from you

At Microsoft Press, your satisfaction is our top priority, and your feedback is our most
valuable asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in
advance for your input!
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Visual Basic 2013
development opportunities
and the Windows Store

After completing this chapter, you will be able to

m  Describe the development opportunities provided by Microsoft Visual Basic 2013.
m  Understand requirements for distributing applications in the Windows Store.

Are you ready to start working with Microsoft Visual Basic 20137 In this chapter, you'll get an over-
view of the features and capabilities of the Microsoft Visual Studio 2013 development system and
the different editions of Visual Studio that you can purchase or download for free. You'll learn about
emerging hardware and software platforms and their uses and the impressive range of applications
that you can create for these platforms, including Windows Store apps for Windows 8.1; Windows
desktop apps for Windows 7, Windows 8, and Windows 8.1; Windows Phone 8 apps; web apps; con-
sole apps; and much more.

You'll also learn about the Windows Store, an exciting new distribution point for apps designed
especially for Windows 8.1. You'll review a checklist of planning tasks to consider before you begin
building a Windows Store application, and you'll learn the procedures for selling and distributing
apps through the Windows Store. After you have a clear list of the Windows Store requirements and
program features in mind, you'll be ready to build your own programs, including Windows Store apps
that you can distribute to millions of potential customers worldwide.

Before we begin, a word about terminology. This book has been designed and tested using the
Windows 8.1 operating system. The Windows Store apps that you create will run under Windows 8.1
and will target the .NET Framework version 4.5.1. You will also learn to create Visual Basic programs
using the Windows Forms and console app models, which run on what is now known as the “Windows
desktop.” These types of apps will run under Windows 8.1, Windows 8, Windows 7, and earlier versions
of Windows, provided that the Windows installation has the proper .NET Framework files installed.

Yet another type of application you will create in this book, using Visual Studio and a technol-
ogy called ASP.NET, are Web Forms apps. These apps run in a web browser, such as Internet Explorer.
Finally, you'll create mobile phone apps during the course of this book, using Visual Studio and the
Windows Phone SDK 8.0. These apps run on the Windows Phone 8 platform.



Visual Basic 2013 products and opportunities

I'm going to assume that you have purchased this book because you want to learn how to program
in Visual Basic. In fact, my underlying assumption is that you might already have some development
experience—perhaps even with an earlier version of Visual Basic—and that you are ready to learn
about the Visual Studio 2013 product in the context of the Windows Store, Windows Forms, Windows
Phone, and Web Forms platforms. Enhancing your Visual Basic development skills is an excellent
choice; there are over four million Visual Basic programmers in the world developing innovative solu-
tions, and Microsoft's newest operating system, Windows 8.1, presents many amazing opportunities
for Visual Basic programmers.

“Visual Basic” essentially has two meanings in the software development marketplace. In a nar-
rower engineering sense, Visual Basic is the name of a programming language with specific syntax
rules and logical procedures that must be followed when a developer creates code for a compiler with
the goal of making an executable program or application. However, Visual Basic is also used in a more
comprehensive product-related sense to describe the collection of tools and techniques that develop-
ers use to build Windows-based applications with a particular software suite. In the past, develop-
ers could purchase a stand-alone version of Visual Basic, such as Microsoft Visual Basic .NET 2003
Professional Edition, but these days Visual Basic is sold only as a component within the Visual Studio
software suite, which also includes Microsoft Visual C#, Microsoft Visual C++, and other development
tools.

The Visual Studio 2013 development suite is distributed in several different product configurations,
including Professional, Premium, and Ultimate, along with a subset of Visual Studio tools designed
for test engineers, known as Visual Studio 2013 Test Professional. In addition to these retail products,
you can experiment with the Visual Studio 2013 software by downloading free versions of the suite
designed for specific development platforms. These limited-feature or “Express” versions of Visual
Studio 2013 are called Express for Windows, Express for Windows Desktop, Express for Windows
Phone, and Express for Web.

The full retail versions of Visual Studio 2013 have different prices and feature sets, with Ultimate
being the most comprehensive (and expensive) development package. The Visual Studio website
(http.//www.microsoft.com/visualstudio) explains the differences among all of these versions. Typically,
the full retail versions of Visual Studio are also available for a 30-day free trial period that can be
extended to 90 days. These trial versions are more feature-rich than the Express products. In addi-
tion, the faculty, staff, and students of recognized academic institutions can download full editions
of Visual Studio 2013 through the Microsoft DreamSpark program, and these free downloads don’t
expire.

| wrote this book to highlight the features and development opportunities provided by Visual
Studio 2013 Professional and Visual Studio 2013 Premium. If you are using Visual Studio Ultimate,
you will also have what you need to complete the exercises in this book—and then some. The extra
features included in Visual Studio Ultimate primarily relate to larger team development projects and
enterprise-computing scenarios that go beyond the scope of this book.
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You can also complete most of the exercises in this book if you install all four of the Express edi-
tions of Visual Studio 2013, and then switch among them as directed. (That is, you can complete most
of the exercises in this book if you install Visual Studio 2013 Express for Windows, Visual Studio 2013
Express for Windows Desktop, Visual Studio 2013 Express for Web, and Visual Studio 2013 Express for
Windows Phone 8.) | will let you know which Express product is necessary for each chapter and when
the individual Express products have limitations that will restrict your ability to compete the exercises.
Occasionally, the instructions in this book will apply only to the full retail editions of Visual Studio
2013, such as Chapter 10, “Creating console applications.”

Collectively, the chapters in this volume are designed to open up an exciting new world of techni-
cal and business opportunities to Visual Basic 2013 programmers. The book'’s extensive collection of
step-by-step exercises has a broad focus, and they are written for technical people who understand
programming and are not simply hobbyists or absolute beginners. In short, the exercises in this
book will give you a taste of real-world programming practices and experiences. If you have no prior
knowledge of Visual Basic or Visual Studio, you might want to fill in some of the gaps with my com-
prehensive introduction to Visual Basic 2012 and Windows 8 development, Start Here! Learn Visual
Basic 2012 (Microsoft Press, 2012). From time to time, | will refer to the exercises in that book to give
you additional resources for your learning.

An impressive range of development opportunities
and platforms

How has Visual Basic programming evolved over time, and what opportunities are available now to
Visual Basic 2013 programmers? Before we start writing code, let's briefly examine some of the recent
trends in software development and Windows programming.

Microsoft released Visual Basic 1.0 in 1991. From its initial announcement at Windows World, the
product impressed software developers because it innovatively combined an advanced Visual Basic
language compiler with an Integrated Development Environment (IDE) that allowed programmers to
build Windows applications by visually arranging controls on a Windows form and then customizing
the controls with property settings and Visual Basic code. From these modest beginnings, Visual Basic
grew into a powerful development tool that was closely aligned with Windows programming, capable
of creating fast and efficient Windows-based applications that could run on a variety of hardware
platforms.

In the early 2000s, Visual Basic programmers were concerned primarily with creating applications
for Windows that helped businesses manage data effectively. Visual Basic's ability to graphically dis-
play information and provide access to it with powerful user interface controls gained many support-
ers for the product, and the installed base grew into the millions. Over the past decade, the leading
Visual Basic applications have been database front-ends, inventory management systems, web appli-
cations and utilities, purchasing tools, CAD programs, scientific applications, and games.

However, in the 2010s, the explosion of Internet connectivity and online commerce has dramati-
cally changed the landscape for software developers. In the past, most applications for Windows ran
on a server or a desktop PC. Today, laptops, tablet devices, and smartphones are everywhere, and
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often the same person owns three or four device types. Consumers need to move applications and
information seamlessly across these devices, and software developers need the tools that will allow
them to create applications that work on multiple platforms or that can be ported easily from one

device to the next.

The Visual Studio 2013 product team took the challenge of coding for diverse platforms seriously,
and they have created a software suite that allows developers to leverage their existing work while
also letting them target a variety of different application models. The following list highlights the
major development platforms and opportunities for Visual Basic programmers (some of which are
supported only by the full retail versions of Visual Studio 2013):

Windows 8.1 Visual Basic developers can create Windows Store apps for Windows 8.1 that
run on a wide range of devices, including desktop PCs, laptops, and Microsoft Surface tablets.
(Note: To create new Windows Store apps for Windows 8, you need to use Microsoft Visual
Studio 2012)

Windows 8, Windows 7, and Windows Server Visual Basic developers can create desktop
applications for earlier versions of Windows and distribute them in a variety of ways. You can
create desktop applications using the Windows Forms (“Win forms”) model or the Windows
Presentation Foundation (WPF) model.

Windows Phone 8 Using Visual Studio 2013, Visual Basic programmers can create appli-
cations that run on the Windows Phone 8 platform and take advantage of its unique fea-
tures. You will learn to write mobile phone apps for Windows Phone devices in Chapter
20, “Introduction to Windows Phone 8 development,” and Chapter 21, “Creating your first
Windows Phone 8 application.”

Web development Developers can use Visual Basic, HTML5, CSS3, or JavaScript to create appli-
cations that will run on the web and look great in a variety of browsers. A technology known as
ASP.NET allows Visual Basic programmers to build websites, web applications, and web services
quickly without knowing all the details about how the information will be stored on the web. The
full list of options is explored in Chapter 19, “Visual Studio web development with ASP.NET."

Console applications and device drivers Visual Basic programmers can write applications
that run in command-line mode, which is sometimes called the Windows text console or DOS
window. While console apps primarily handle “behind the scenes” calculations, they can also
use libraries in the .NET Framework. | describe console programming in Chapter 10.

Office applications Visual Basic programmers can still build macros and other tools that
enhance the functionality of Microsoft Office applications, such as Excel, Word, Access, and
PowerPoint.

Xbox 360 Visual Basic programmers can write games for the Xbox using Visual Studio and
Microsoft XNA Game Studio (version 4.0 and later).

Windows Azure applications for web servers and the cloud Visual Basic is powerful
enough to write applications that will be used on sophisticated web servers, distributed data
centers, and a version of Windows designed for cloud computing known as Windows Azure.
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This is an amazing list of application types! Although this list might seem daunting at first, the
good news is that the fundamental Visual Basic programming skills that you will explore here remain
the same from platform to platform, and there are numerous tools and techniques that help you to
port work easily between them. This book provides a solid introduction to many of the core skills that
you will use, and especially the new tools provided by Visual Studio 2013 to help you develop your
solution for Windows 8.1, the Windows desktop, and Windows Phone 8. However, after you master
the core Visual Basic programming skills, you can move on to specific platforms by acquiring materi-
als specifically related to those markets.

Taking a multiplatform approach to learning Visual Basic

As you have probably discovered by now, applications for Windows 8.1 are often called Windows
Store apps. Yes, the connection between Windows 8.1 and the Windows Store is that direct. However,
Microsoft understands that not all developers are prepared to write applications only for Windows 8.1
because developers still need to support earlier versions of Windows, and many developers are
designing apps for web browsers, which must be run on a variety of platforms. For this reason, | am
describing Visual Basic programming techniques for a wide range of programming platforms in this
book. You will learn how to create Windows Store apps, Windows desktop apps, console apps, Web
apps, and Windows Phone apps.

In some cases, | will discuss Visual Basic programming techniques related to a specific platform in
a chapter, such as Chapter 3, “Creating your first Windows Store application.” In other cases, | move
back and forth between the platforms, showing how the Visual Basic language, or Visual Studio
features related to different platforms, might be adapted to unique situations. An example of this
approach is Chapter 14, "Using arrays, collections, and generics to manage data,” in which | provide
data management instruction using examples from both the Windows Store and the Windows desk-
top (Windows Forms) platforms.

I have taken this comprehensive approach in Microsoft Visual Basic 2013 Step by Step because
Visual Studio 2013 Professional has been designed to support all of these application types. The
current reality is that Visual Basic programming is a multiplatform endeavor, and intermediate Visual
Basic programmers need exposure to many environments as they expand and enhance their develop-
ment skills. At the same time, Windows Store programming is quite new, so | spend a little more time
exploring this platform than the others.
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Evaluating the Windows Store

Because the Windows Store provides a new and potentially profitable way of selling and distributing apps
to a wide audience, | want to begin this book with a description of what the Windows Store is and how you
can use it to reach potential customers. In addition to providing a strong business incentive to developing
Windows Store apps, | want you to become familiar with the technical requirements of the Windows Store
before you begin this type of development so that you know what you will need to do before you get too
far along in a big Windows Store project. Microsoft recommends this “up-front education” too, because
teams that are creating apps for the Windows Store can be most productive when they know all the certi-
fication requirements in advance.

What is the Windows Store?

The Windows Store is an electronic marketplace that allows consumers to search for and acquire
applications for Windows. The Windows Store is designed to distribute apps for Windows 8 and
Windows 8.1, much like Apple’'s Mac App Store allows consumers to download Mac software, and the
Windows Phone Store allows consumers to download products for devices running Windows Phone 8.

Note The Windows Phone Store is described in detail in Chapter 20.

The Windows Store allows developers to reach a global marketplace in ways that have been dif-
ficult or impossible in the past. Through the Windows Store, Windows-based apps can be monetized,
either by charging for an application or by including advertising in the application. Programs down-
loaded from the Windows Store are certified and ready to run; after you meet the requirements for
preparing an app for the marketplace, the details about downloading and deploying the application
are handled by the Store.

Throughout this book, you will learn how to create apps to run on Windows 8.1 by using Visual
Basic and Visual Studio 2013. At this point, you just need to learn how products are bought and sold
in the Windows Store, and to review a Windows Store checklist that identifies which features are nec-
essary for certification and distribution to the global marketplace.
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Accessing the Windows Store

If you are running Windows 8.1 on your computer, you will see a Windows Store tile on the Windows
Start page, which is the gateway to accessing the Windows Store. If you are not currently running
Windows 8.1, you can learn about the Windows Store at http://www.windowsstore.com/, but you won't
be able to access the Windows Store itself, because it is designed for use only within Windows 8.1.

The following illustration shows what the Windows Store looks like when you first access it.
Because the list of featured products is always changing, your screen will look different.

v

Store

Microsoft Solitair
#1 Top Free Game
latest evolution of
Free Jcdedkco 40,

Avengers Initiative

New to the Store

Help the Hulk track down and

m s th

Level up and customi e Hulk with new costumes and
abilities to help with your mission.

Facebook
Keeping up with y:
Facebook app.
Free sk k 60
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If you right-click in the Windows Store, you'll see a navigation pane that allows you to browse for
the top paid and the top new Windows Store apps. In addition, you'll see useful product categories,
such as Games, Social, Entertainment, Photo, Music & Video, Sports, and Books & Reference. When
you select a category and an item, you'll see an app listing page similar to the following screen:

© Shazam 5
=n

Free %+ 1508

Shazam

Touch to Shazam recent tags >

When you install an app, you agree to the Terms of Use
and any additional terms.

This app has permission to use some features of your
PC that might affect your privacy.

Description

Shazam is the quickest and easiest way to
discover more about music, TV and ads. Hold
your phone up to the music or TV to identify a
track, buy it, share it, watch the video, get the
lyrics and more!

Features

Hub View
+ Buy tracks easily
= Watch music videos and concerts from
YouTube
+ Share tags on Windows Live, Facebook, Published by Shazam Entertsinment Ltd Category Music &
Twitter & more © Shazam Entertainment, Ltd 2002-2013 Approximate size
Age rating 12+
Show more
< >

The app listing page is the place where software vendors get a chance to promote their products
and describe app benefits. It is tremendously important to present your app in the best possible light
here. The application name, description, feature list, age rating, price, and screen shots are all signifi-
cant factors in making a good impression on your audience. As people purchase or download your
app. the rating system (based on five possible stars for the highest level of customer satisfaction) is
also an important factor in drawing people to your app.

Installing an app from the Windows Store is extremely simple; you just click the Install button, and
within moments, the app will be deployed on your Start page and available for use. A reliable Internet
connection is required to download the app and (often) to feed the app data as the program runs.

Sales information and price tiers

Windows-based apps can be distributed free via the Windows Store, or they can be sold for a price.
A setting called a price tier sets the fee for the app that you plan to sell. You can set the price tier
that you like; tiers start at 1.49 USD and move up in increments of 0.50 USD to 4.99 USD, with higher
product prices available.
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If you plan to sell apps via the Windows Store, it is important to understand a little about how that
process might work, even before you begin development. For the first 25,000 USD of an app's sales,
you will receive 70% of the revenues that Microsoft receives for the product. If and when an applica-
tion receives more than 25,000 USD in sales, you will receive 80% of the revenues over 25,000 USD.
Keep in mind that your product will be sold internationally, and in some countries, the amount that
Microsoft receives will be reduced to account for taxes required by local laws.

It is also required that you register to be a Windows Store developer before you can sell products
through Microsoft’s new electronic marketplace. The initial annual cost for a developer account in the
United States was 49 USD for an individual and 99 USD for a company. You will also need to complete
some registration paperwork containing contact information and other details.

Or your application could be free...

Of course, it is not necessary that you sell your application. You can also offer it as a free download to
users all over the world. This might be useful if you want to provide general information or a public
service or if you want to draw attention to your company or make its products or services more usable.
For example, you might want to create a Windows Store app that presents the menu and other services
provided by a restaurant, or publish news highlights and photos from an information service.

Within these free applications, you could then decide to use online advertising tools to generate
revenue, or you could simply distribute information and know that you had fostered communication
about your product throughout the world. The Windows Store has a special marketing category for
free apps, as shown in the following illustration:

@ TOp ﬂ’ee 1,000 apps Search for apps =

The

Weather @PiHeartRADIC

(o E

Microsoft Mahjong The Weather Channel iHeartRadio
Top 5 Free Game in the Wi iHeartRadio offers free music in an all-in-
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Free ok v 16,291 Games Free sjok 2,183 Mews & Weather Free sdodkok & 8496 Music & Video
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Wikipedia The Chess Lv.100
Offici ia The Chess has 100 adjustable playing level
Wi based on the engine "Crazy Bishop" with
Free #dkk i 2620 Books & Reference Free sk k 1794 Games
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Whether you sell or distribute your app for free is up to you and the needs of your business and
your customers!

Planning ahead for certification

Before you begin serious development on your project, Microsoft recommends that you review the
certification requirements carefully for Windows Store apps so that you aren't surprised by the neces-
sary steps. For the most part, these steps are simply good development practices that will make your
programs robust and high quality. Microsoft is enforcing high standards so that customers come to
trust the Windows Store and all of the software distributed through it. We all have a lot riding on the
success of the Windows Store.

The Visual Studio Professional IDE contains a Store submenu on the Project menu, with eight com-
mands pertaining to the Windows Store, as shown in the following illustration:

Open Developer Account...
Reserve App Name...

Acquire Developer License...
Edit App Manifest

Associate App with the Store...
Capture Screenshots..

Create App Packages...

Upload App Packages...

Before you begin serious development on a project that you intend to submit to the Windows
Store, you should run the first three commands on the Windows Store submenu. The Open Developer
Account command will get you signed up with Microsoft as an individual or a company. This enables
the submission process and allows you to get more information. The Reserve App Name command
lets you reserve a name for your application within the store. You want to do this before you get too
far along (and then learn that you need to change the name). The Acquire Developer License com-
mand lets you get a temporary developer license, which you might have already done during your
work in Visual Studio.

A helpful blog for developers preparing for the Windows Store is available at http://blogs.win-
dows.com/windows/b/appbuilder/. Here you'll find Microsoft employees and other industry experts
explaining key application concepts and answering pertinent questions. For example, in addition
to the Windows Store checklist shown in Table 1-1 in this chapter, you'll need to fill out a complete
package manifest for your project and practice other safe programming practices. You can also find
useful information in the MSDN article “Take your app to market” at http.//msdn.microsoft.com/en-us/
library/windows/apps/br230836.aspx.

Windows Store requirements checklist

The formal certification process begins when you upload your app to the Windows Store. Table 1-1
contains a checklist recommended by Microsoft for developers who are creating apps for the Store.
Most of these items are required for certification and will be evaluated when you register with
Microsoft and fill out the required submission pages online. The certification requirements can be
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updated periodically, but this checklist will help you get started. The point is that you need to do
some preparation before you get online and submit your app for certification. You should have the
necessary information ready, and be sure that it has been proofread carefully.

TABLE 1-1 Windows Store submission checklist

Submission page Field name Description

Name App Name Provide a name for your app that is 256
characters or less. Pick a name that will
capture your customers’ attention. It is best
to keep this name short.

Selling Details Price Tier Prepare to specify a selling price for your

app (or set the price to “free”).

Free Trial Period

Allow your customer to download the app
for a free trial period. If the customer does
not buy it in the set period of time, it will
stop working.

Countries/Regions

Identify the market for your product.

Release Date

Set the app’s release date.

Category

Assign a category for your app so that
customers can find it in the Windows Store.
There is a helpful list of predefined catego-
ries to choose from.

Accessible App

If your app has been designed to meet
Microsoft’s accessibility guidelines, indicate
that here.

Minimum DirectX Feature Level

Indicate the video and hardware require-
ments for your application.

Minimum System RAM

Indicate how much RAM your app requires.
You might want to double-check the basic
system requirements for the devices that
your app will run on.

Advanced Features

In-App Offers

Provide information about products that
users can purchase from within your app,
including what the customer must pay and
how long the purchased feature can be
used.

Ratings

Age Rating

Specify an appropriate age rating for your
app, using the levels provided.

Rating Certificates

If you are selling a game, you might need
to provide a rating certificate from a ratings
board, depending on where you plan to sell
your app.

Cryptography

Question 1

Indicate whether your app makes use of
cryptography or encryption.

Question 2

Verify that any use of cryptography is
within the allowable limits imposed by
the Bureau of Industry and Security in the
United States Department of Commerce.

Packages

Package Upload Control

Provide the path to your app’s completed
package.
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Submission page Field name

Description Description

Description

Provide clear and concise marketing copy
that describes your application, its features,
and its benefits. Review this information
carefully before posting. It must be 10,000
characters or less.

App Features

(Optional) Provide up to 20 features of your
app. (Each feature must be 200 characters
or fewer))

Keywords

(Optional) Provide up to seven concise key-
words describing your app.

Description of Update

Provide a description of how this new
version of your app updates the previous
version. (Leave blank for the first release of
your app.)

Copyright and Trademark Info

Provide a brief copyright notice, 200 char-
acters or fewer.

Additional License Items

(Optional) Provide 10,000 characters or
fewer.

Screenshots

Up to 8 quality screen shots of your app as
it is running. Each can have a description
of up to 200 words. The minimum size of
the image must be 1366 x 766 pixels. You
can capture these screens using the Store |
Capture Screenshots command in Visual
Studio.

Promotional Images

(Optional) Provide other promotional images
for your app (up to four).

Recommended Hardware

(Optional) Provide up to 11 notes about the
hardware requirements for your app.

App Website

Provide the website URL for your product.

Support Contact

Provide a contact URL for customers so
that they can get support or ask additional
questions. Prepare to be very responsive to
customer questions and feedback.

Privacy Policy

Prepare an appropriate statement about
your privacy policy regarding data col-
lected about users.

In-App Offer Description

Provide information about products that
users can purchase from within your app,
including what the customer must pay
and how long the purchased feature can
be used. (This field was indicated above as
well. Use the same information.)

Notes to Testers Notes

Give the evaluators at Microsoft additional
information about your app so that they
can test its functionality. For example,
describe hidden features or provide user
name and password information if needed.
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It's all in the details

The value of the preceding checklist becomes apparent when you look again at the content for
Windows Store apps within the Windows Store. The more you know about your customers and your
product’s central features before you get started, the easier it will be to make design and layout deci-
sions as you create your application. In the following screen illustration, notice how important the
ratings, description, and features categories are for the featured app, as well as the value of the screen
shot that visually describes the product.

The Details page (not shown, but accessible via the Details link) presents additional information,
including release notes, supported processors, supported languages, and application permissions. The
Reviews page (also not shown) contains comments from actual customers.

© Microsoft Mahjong ;
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Free s%x+ + 1629

# ® ag
‘|8 [EXR
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+1= oo o
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@ 15 b =
- if: E ; &
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" ’ s |5
Top 5 Free Game in the Windows Store! % ©
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1t
Content g e A
= 3
R
p gg
Features
+ Four different themes with unique scenery Published by Microsoft Studios Category Games » Puzzle
and tiles @ 2012 Microsoft Corparation Approximate size 129 MB

Show more

Now that you have reviewed the basic marketing and distribution mechanisms for apps in the
Windows Store, it is time to get started building Visual Basic apps in Visual Studio. Although many of
the apps that you will create in this book will be demonstration programs designed to teach discrete
elements of the Visual Basic programming language, you should always keep an eye on the end-goal
of your learning—creating software that other people can use.

Visual Basic 2013 development opportunities and the Windows Store 15
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Each chapter in this book concludes with a Summary section that offers a review of what the chapter
has presented. You can use these sections to quickly recap what you have learned in each chapter
before you move on to the one that follows.

This chapter has introduced development opportunities for Visual Basic programmers, including
the many opportunities available to users of Visual Studio 2013. You've learned about the applica-
tion types that you can create with Visual Studio 2013 and about the specific tools and platforms that
are described by this book. You've also learned about the Windows Store, an incredible distribution
point and marketing opportunity for software developers who want to sell or freely distribute their
products. You've learned how the Windows Store operates and about some of the requirements you'll
need to satisfy to distribute apps for Windows 8.1 via the Windows Store. Although the process will
require some up-front planning, as well as technical and marketing expertise, the upside is significant.
The Windows Store has the potential to reach millions of customers worldwide.

In Chapter 2, “The Visual Studio Integrated Development Environment,” you'll explore the Visual
Studio 2013 IDE, including how to run and test Visual Basic programs, how to use the development
tools in the IDE, and how to adjust important compiler settings.

Introduction to Visual Studio Development



The Visual Studio Integrated
Development Environment

After completing this chapter, you will be able to

m  Use the Visual Studio 2013 Integrated Development Environment.
®  Load and run Windows Store apps.

m Work with XAML markup in the Designer.

m  Use the Properties windows to change property settings.

m  Organize Visual Studio programming windows and tools.

= Configure the IDE for step-by-step exercises.

his chapter gives you the skills you need to get up and running with the Visual Studio 2013

Integrated Development Environment (IDE)—the place where you will write Microsoft Visual Basic
programs. My assumption is that you have written programs before in some earlier version of Visual
Basic and that you need only a refresher on how the main IDE tools work. However, | plan to cover
some essential IDE skills here, including a few things about how Visual Studio 2013 works in relation
to XAML markup and Windows Store programming.

This chapter begins with a review of essential Visual Studio menu commands and programming pro-
cedures. You'll open and run a simple Windows Store app named Music Trivia; you'll change a property
setting; and you'll practice moving, sizing, docking, and hiding tool windows. You'll also learn how to
configure the IDE to match this book's step-by-step instructions. This final exercise is especially impor-
tant, because the programming exercises that follow will rely on those specific settings.

Before you begin this chapter, you need to install Visual Studio 2013. For more information about
that process and the options available to you, see the Introduction and Chapter 1, “Visual Basic 2013
development opportunities and the Windows Store.”

Not enough beginning material here? Keep in mind that this is a book for programmers who have used
some version of Visual Basic or Visual Studio in the past. As a book in the Microsoft Press Developer
Step by Step series, this tutorial is designed to inform new-to-topic programmers and teach funda-
mental techniques and features. Although | do review essential techniques such as setting properties
and moving around tool windows, you'll find a lot more introductory tips, tricks, and techniques in my
companion book Start Here! Learn Microsoft Visual Basic 2012 (Microsoft Press, 2012).
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Getting started

To boot up Visual Studio and get working in the IDE, complete the following steps. Depending on the
edition of Visual Studio that you have, you will use slightly different commands and see slightly dif-
ferent things, but the differences will not be substantial. (In the screen shots that follow, you will see
Visual Studio 2013 Professional.)

Start Visual Studio 2013

1. Onthe Windows Start page, click Visual Studio 2013.

If this is the first time you are starting Visual Studio, the program will take a few moments to
configure the environment. You might be prompted to get a developer license for Windows,
which typically requires that you create a Windows Live account or enter existing account
information. At the time of this writing, developer licenses were free and valid for a month
before they needed to be renewed. You will likely encounter a similar registration scenario.

2. If you are prompted to identify your programming preferences, select Visual Basic
Development Settings, as shown in the following screen:

g Visual Studio

Befare you begin using the application far the first time, you need ta specify the type of development
activity vou engage in the maost, such as Yisual Basic ar Visual C=, This information is used to apply a
predefined collection of settings to the development environment that is designed for your
development activity.

You can choaose ta use a different collection of settings at any time, Fram the Toals menu, choase
Impart and Export Settings and then choose Reset all settings.

Choose your default environment settings:

General Development Settings Description:

JavaScript for Windows 8 Apps Optimizes the environment so you can focus on
LightSwitch Development Settings building world-class applications. This cellection of
SOL Server Development Settings settings contains customizations to the window
layout, command menus and keyboard shartcuts ta
Visual €= Development Settings make common Visual Basic commands more
Visual C++ Development Settings accessible.

Visual F= Development Settings
Web Development

Web Development (Cade Only)

Lacal Help Dacumentation:

Minimum © Downloads an(l.mstallsthemlmmum amount of
content (about 1 GB).

Start Visual Studio Exit Visual Studio

3. Click Start Visual Studio in the Choose Default Environment Settings dialog box.

When Visual Studio starts, you see the IDE on the screen with its familiar menus, tools, and
component windows. You also should see a Start page containing a set of tabs with links,
learning resources, news, and project options.

18 PART | Introduction to Visual Studio Development



04 Start Page - Microsoft Visual Studio
FILE EDIT  VIEW DEBUG TEAM  TOOLS

B-OE W

0 Y QuickLaunch (Ctrl+0)

TEST  ANALYZE  WINDOW  HELP

b Attach... - -

g
Professional 2013

Start

New Project...
Open Project...

Open from Source Control...

Recent

LuckySevenWF

Discover what's new in
Professional 2013

You can find information about new features and
enhancements in Professional 2013 by reviewing
the following sections.

Learn about new features in Professional 2013
See what's new in NET Framework 45,1
Explore what's new in Team Foundation Service

Relocate the What's New information

What's new on Microsoft Platforms

P - & x
Michael ). Halvorson -

Solution Explorer ~ax

&

Lucky Seven
Music Trivia - A
=a Windows Azure
Golf Caddy " ASP.NET vNext and Web
Music Trivia 58 Windows Phone

1 Wicrosoft Office
B sharePoint Development

Announcements
Download Visual Studio 2013

Thursday, October 17, 2013

Get the great new features in Visual Studie 2013, including
innovative editor enhancements such as Peek and Codelens,
diagnostics tools for Ul and energy consumptio...

w | Solution Explorer | Team Explorer

The screen shown here offers a typical Visual Studio Professional setup. | captured the screen at a
resolution of 1024 x 768, which might be smaller than you are using on your computer, but | wanted
you to see the content as clearly as possible. In the e-book versions of this text, you will see the
images in color.

You have a number of display options when you work in Visual Studio 2013. For visual clarity, |
chose the Light color theme for my work, primarily because it produces the clearest screen illustra-
tions in a printed book. However, when you first open Visual Studio, you might see the Dark color
theme, which displays white text on a dark background. Although the Dark color theme is restful and
emphasizes the code and user interface elements of your program, you might want to change it if
matching my screens is important to you.

If you see the Dark color theme and want to change it, do so now by choosing the Options com-
mand on the Tools menu, click General in the Environment category, select Light in the Color Theme
drop-down list box, and click OK. This first screen illustration depicts the Light theme.

The Visual Studio development environment

In the Visual Studio IDE, you can open a new or existing Visual Studio project or you can explore the

many online resources available to you for Visual Basic programming. In the 2013 product, one of the
first new features that you might see is your login name in the upper-right corner of the IDE. By sign-
ing in to Visual Studio each time that you start the IDE, you can save your Visual Studio settings to the
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cloud and have them move from machine to machine as you work on projects in different locations.
You'll see my sign-in name in screens throughout the book.

Right now, let’s open an existing Visual Studio project that | created for you, entitled Music Trivia,
which asks a trivia question about a musical instrument and then displays an answer to the question
along with a digital photo of the instrument. All of the Windows Store apps that | create in this book
target the Windows 8.1 operating system. (The Windows Forms and console apps will run on any ver-
sion of Windows 7, Windows 8, or Windows 8.1.)

Note The following steps ask you to open and run a Windows Store app in the IDE. If you
haven't downloaded this book's sample files yet, you should do so now, because you'll be
asked to open a specific program on your hard disk. The Introduction explains how to lo-
cate and download what you need.

Open an existing Visual Studio project

1.

On the Start page, on the left side of the screen, click the Open Project link.

You'll see the Open Project dialog box. (You can also display this dialog box by clicking the
Open Project command on the File menu or by pressing Ctrl+Shift+0O.) As you probably know
by now, the Open Project dialog box is straightforward because it resembles the familiar Open
dialog box in many other Windows applications.

Tip In the Open Project dialog box, you see a number of storage locations along
the left side of the window. The Projects folder under Microsoft Visual Studio 2013
is particularly useful. By default, Visual Studio saves your programming projects

in this Projects folder, giving each project its own subfolder. However, this book
uses a different Projects folder to organize your programming coursework, the My
Documents\Visual Basic 2013 SBS folder.

Browse to the My Documents\Visual Basic 2013 SBS folder on your hard disk.

This folder is the default location for the book’s extensive sample file collection, and you'll find
the files there if you followed the instructions in “Code samples” in the Introduction. Again, if
you didn’t copy the sample files, close this dialog box and copy them now.

If you click the Chapter 02 folder, your Open Project dialog box will look like this. The number
“12" in the Music Trivia icon indicates that the project was created with the 12th version of
Visual Basic, or Visual Basic 2013.
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3. Open the Chapter 02\Music Trivia folder, and then double-click the Music Trivia solution file.
(If your system shows file name extensions, this file will end with .sIn.)

4. Visual Studio loads the Music Trivia page, properties, and program code for the solution,

which is a Windows Store app designed for Windows 8.1. Solution Explorer, a tool window on
the right side of the screen, lists some of the files in the solution.

Visual Studio provides a special option named Always Show Solution to control several options
related to solutions within the IDE. The option’s check box is located on the Projects And Solutions
| General tab of the Options dialog box, which you open by clicking the Options command on the
Tools menu. If the check box is selected (the default position), a subfolder is created for each new

solution, placing the project and its files in a separate folder beneath the solution.

If you keep the default selection for Always Show Solution, a few options related to solutions
appear in the IDE, such as commands on the File menu and a solution entry in Solution Explorer. If

you like creating separate folders for solutions and seeing solution-related commands and settings, |
suggest that you keep the default (selected) option for this check box. You'll learn more about these
options at the end of the chapter.

CHAPTER 2 The Visual Studio Integrated Development Environment
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Project and solution terminology

In Visual Studio, programs under development are typically called projects or solutions because
they contain many individual components, not just one file. Visual Basic 2013 programs include
a project file (vbproj), a solution file (.sIn), and several supporting files organized into various
subfolders. A Windows Store app will also have one or more markup files (xaml) and an Assets
folder.

A project contains files and other information specific to a single programming undertaking.
A solution contains all the information for one or more projects. Solutions are therefore useful
mechanisms to manage multiple related projects. The samples included with this book typically
have a single project for each solution, so opening the project file (vbproj) has the same effect
as opening the solution file (.sIn). But for a multiproject solution, you will want to open the
solution file.

Important tools in the IDE

22

Take some time now to identify the programming tools and windows in the Visual Studio 2013 IDE.

If you've written Visual Basic programs before, you'll recognize most of these programming tools.
Collectively, these features are the components that you use to construct, organize, and test your
Visual Basic programs. A few of the programming tools also help you learn more about the resources
on your system, including the larger world of databases and website connections available to you.

My assumption is that you've used Visual Studio, Word, and other Windows-based applications
enough to know quite a bit about menus, toolbars, the Help system, and familiar commands such as
New Project, Close Project, Start Debugging, and Save All. You can see the full list of toolbars at any
time by right-clicking any toolbar in the IDE.

The Help menu is especially useful in Visual Studio, and you can also access an extensive collection
of Visual Studio and Visual Basic programming resources online at http://msdn.microsoft.com/. You'll
often be asked to reference online topics on the Microsoft Developer Network (MSDN) as you use this
book.

The following illustration shows some of the tools and windows in the Visual Studio Professional
IDE. Don't worry that this illustration looks different from your current development environment
view. You'll learn more about these elements (and how you adjust your views) as you work through
the chapter.
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The main tools visible in this Visual Studio IDE are the Designer, the Solution Explorer, the
Properties window, and the Extensible Application Markup Language (XAML) tab of the Code Editor.
You might also see more specialized tools such as the Toolbox, Document Outline window, Device
window, Data Sources window, Server Explorer, and Object Browser; alternatively, these tools might
appear as tabs within the IDE. Because no two developers’ preferences are exactly alike, it is difficult
to predict what you'll see if your Visual Studio software has already been used. (What | show is essen-
tially the fresh-download, or out-of-the-box, view with the Designer displaying a sample application

in development.)

Note Note that from time to time, the menus in the IDE change based on what you are do-

ing in Visual Studio.

A new feature in Visual Studio 2013 is the Feedback button, which appears as a "thought bubble"
or smile icon at the top of the screen, to the left of the Quick Launch text box. You can use the
Feedback button to let Microsoft know about the features in Visual Studio that you like or do not like.
You can also use the button to access MSDN Forums and report a bug in the software.

The Visual Studio Integrated Development Environment
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If a tool isn't visible and you want to see it, click the View menu and then select the tool. Because
the View menu has expanded steadily over the years, Microsoft has moved some of the less fre-
quently used View tools to a submenu called Other Windows. Check there if you don't see what you
need.

A few new Visual Studio 2013 features that you can see now include more colorful icons in the
toolbars and Solution Explorer (folder icons are now yellow), and the scroll bar in the Code Editor con-
tains a “caret position” indicator, which shows the relative position of the insertion point in the open
document.

Organizing tools in the IDE

Your IDE might not look exactly like the image I've shown because the exact size and shape of the
tools and windows in the IDE depend on how your particular development environment has been
configured. With Visual Studio, you can align and attach, or dock, windows to make visible only the
elements that you want see. You can also partially conceal tools as tabbed documents along the
edge of the development environment and then switch back and forth between documents quickly.
For example, if you click the Toolbox label on the left side of the screen, the Toolbox panel will fly
out, ready for use. If you click another tool or window in the IDE, the Toolbox panel will return to its
concealed position.

Your development environment will probably look best if you set your monitor and Windows
desktop settings so that they maximize your screen space, but even then, things can get a little
crowded. In fact, many professional Visual Studio programmers use two monitors to display different
views of the software.

The purpose of all this tool complexity is to add many new and useful features to the IDE while
providing clever mechanisms for managing the clutter. These mechanisms include features such as
docking, autohiding, floating, and a few other window states that I'll describe later. Visual Studio 2013
also hides rarely used IDE features until you begin to use them, which has also helped to clean up the
IDE workspace.

If you're just writing your first Windows Store app with Visual Studio, the best way to deal with
feature overload is to hide the tools that you don't plan to use often to make room for the impor-
tant ones. The crucial windows and tools for intermediate Visual Basic programming tasks—the ones
you'll start using right away in this book—are the Designer window, the Properties window, Solution
Explorer, and the Toolbox. You won't use the Document Outline, Server Explorer, Data Sources, Class
View, Object Browser, Device, or Debug windows until later in the book, so feel free to hide them by
clicking the Close button on the title bar of any window that you don't want to see.

In the following exercises, you'll review the behavior of the essential tools in the Visual Studio
IDE. You'll also learn about XAML markup, the design language used to define the user interface in
Windows Store apps.
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The Designer and XAML markup

If you completed the previous exercise ("Open an existing Visual Studio project”), the Music Trivia
project is loaded in the Visual Studio development environment. However, the user interface, or page,
for the project might not yet be visible in Visual Studio. (More sophisticated projects might contain
several pages, but this first example program needs only one.) To make the page of the Music Trivia
project visible in the IDE, you display it by using Solution Explorer.

Note If you don't currently have the Music Trivia project loaded, go back to and complete
the exercise in this chapter titled “Open an existing Visual Studio project.”

Display the Designer window

1. Locate the Solution Explorer window near the upper-right corner of the Visual Studio devel-
opment environment. If you don't see Solution Explorer, click the View menu and then select
Solution Explorer to display it.

Note From here on in this book, you'll sometimes see a shorter method for describ-
ing menu choices. For example, “Choose View | Solution Explorer” means “Click the
View menu and then select Solution Explorer.”

When the Music Trivia project is loaded, Solution Explorer looks like this:

Solution Explorer
@ e-2udnm &=
Search Solution Explorer (Ctrl+;) P~
Music Trivia (Windows 8.1)
K My Project
3 Assets
B L) Appxaml
B MainPagexaml
£ Music Trivia_TemporaryKey.pfx
Package.appxmanifest

Solution Explorer  Team Explorer
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Like most basic Windows Store applications, this Visual Basic solution contains an App.xaml
file that holds global project settings and resources; an Assets folder that contains an assort-
ment of logo files and a splash screen for the project; a certificate file containing temporaries
keys; a deployment package manifest, containing build and distribution settings for your file;
and one or more user interface windows, or pages, which you can identify because they have
the extension .xaml.

Near the top of Solution Explorer, the Music Trivia program is identified as a Windows 8.1
project. This means that it is designed for the Windows 8.1 platform and uses features within
the Windows 8.1 operating system.

In Visual Studio 2012, there was also a Common folder that was visible in Windows Store proj-
ects, containing common classes and XAML styles, but those items are now hidden from view.

Click the expansion arrow to the left of the MainPage.xaml file in the Solution Explorer window.

With the MainPage.xaml file expanded, Solution Explorer looks like this:

Solution Explorer
@ o-eudd &
Search Solution Explorer (Ctrl+;) P~

& My Project
3 Assets

b Appxaml

4 Y MainPagexaml
b T MainPagexamlvb
£ Music Trivia_TemporaryKey.pfx
Package.appxmanifest

Solution Explorer ' Team Explorer

In this Windows Store project, the main page of the Music Trivia program is defined by the
MainPage.xaml file.

You can open MainPage.xaml in Design view so that you can examine and modify the user
interface with graphical design tools, or you can open the file in the Code Editor, where you
can modify the user interface with XAML, the user interface definition language designed for
Windows Store apps and other computer programs.

Tip If you've created Windows Presentation Foundation (WPF) apps in an earlier ver-
sion of Visual Studio, this is the same XAML markup language (with some important
updates) that you might already have worked with to create the user interface for
Visual Basic applications. Essentially, Windows Store apps are a successor to WPF-
style apps.
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Below the MainPage.xaml file, you will see a second file, named MainPage.xaml.vb. This file is
also associated with the user interface of the Music Trivia project. MainPage.xaml.vb is called
a code-behind file because it contains a listing of the Visual Basic program code connected to
the user interface defined by MainPage.xaml. As you learn how to create Windows Store apps
using Visual Basic and Visual Studio, you'll become very adept at customizing this file.

Solution Explorer is the gateway to working with the various files in your project—it is an
essential tool. When you double-click a file in Solution Explorer, it opens the file in an appro-
priate editor, if direct editing of the file is allowed.

Double-click the MainPage.xaml file in Solution Explorer to display the project’s user interface
in the Designer window, if it is not already visible. If necessary, use the vertical scroll bar to
adjust your view of the user interface.

The Music Trivia page is displayed in the Designer, as shown here:

MainPagexaml.vh MainPagexaml + > [ERRelylRY] i

Trivia

What rock and roll

instrument is often
played with sharp,
slapping thumb
movements?

679 - mmm me[d-] 4 »

GDssign  t @Exam oE®
Notice that a tab with the file name MainPage.xaml is visible near the top of the Designer win-
dow, along with additional tab names. You can click a tab at any time to display the contents
of the various open files.

As noted earlier, the MainPage.xaml file is the visual representation of the program'’s user
interface. However, you can readily examine the XAML markup used to define the user
interface by double-clicking the XAML tab of the Code Editor at the bottom of the Designer
window.

Because you can't see the entire user interface now, you might want to resize the Designer so
that you can see more of the program.
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4. Move the pointer to the right edge of the Designer window (the outside edge of the scroll
bar) until the pointer changes to a double-headed arrow (the resizing pointer). Then drag the
window's edge to the right to enlarge the window.

The Designer window will get larger, and the Solution Explorer and Properties windows will
get smaller. Your screen will look something like this:
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Now you'll examine the XAML markup that defines the user interface elements that you are
looking at in the Designer.

5. Return the Designer to its original size, and then double-click the XAML tab to display the
XAML markup for the page in the Code Editor.
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6. Scroll to the top of the window to see the entire document.

You'll see the following:

Dd Music Trivia - Microsoft Visual Studio e
FILE EDIT VIEW PROJECT BUILD DEBUG TEAM SQL DESIGN TOOLS TEST ANALYZE WINDOW  HELP
‘o~ B-aEdE 2% 9 p Local Machine - G G Debug - - I
MainPagexaml.vb MainPagexaml + X [N EeaRT] -
Fl<Page 2=
x:Class="Music_Trivia.MainPage” -

wmlnz="http://schemas.microsoft. com/winfx/20@6/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2886/xaml"
xmlns:local="using:Music_Trivia”
wmlns:d="http://schemas.microsoft.com/expression/blend/2088"
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2086"
mc:Ignarahle="d">»

Y Quick Launch (Ctrl+Q) P o & x

Michael ). Halvorson ~ [l

Solution Explorer i x
e -endim
Search Solution Explorer (Ctrl+;) P~

fa] Solution ‘Music Trivia' (1 project)
4[] Music Trivia (Windows 8.1)
& My Project
b Assets

b I3 Appaaml

4 [ MainPagesaml
b %) MainPagexamivb
£ Music Trivie_TemporaryKey.pfx
R Package.appxmanifest

= <Grid Background="Green">
<TextBlock HorizontalAlignment="Left" Height="159" Margin="68,29,8,8" TextWrapping="Wrap"
<Image x:Name="GuitarImage" HorizontalAlignme eft” Height="396" Margin="68,188,0,0" V|
<TextBlock HorizontalAlignment="Left" Height="229" Margin="487,193,8,8" TextWrapping="Wraj

<TextBox x:Name="AnswerBox" HorizentalAlignment="Left" Height="61" Margin="487,427,8,8" T.
<Button x:Name="AnswerButton" Content="Answer!" HorizontalAlignment="Left" Height="69" Mal

S2UN0S ER]  FUIPNQ) JUBWND0Q AR Xag|oa]

</Grid> Solution Explorer  Team Explorer

Properties s w I
Mame <Mo Names »| 5
Type TextBlack

Search Properties P

</Page>

Arrange by: Category ~ o

b Brush

b Appearance

4 Common
Text Music Trivia

ToolTipServic..

DataContext Ner

b Layout
b Text

I\ T

100 % MR} »
EXAML  GDesign @

The XAML contents of MainPage.xaml appear in the Code Editor, and it is this structured
information that controls how Visual Studio and Windows will display the application’s user
interface and graphics. If you know some WPF or HTML, this should look somewhat familiar.
XAML contains markup—instructions whose primary purpose is to tell a program how to
display things on the screen. The XAML markup shown here is displayed between <Page> and
</Page> tags and is further indented to make the information readable. (Windows Phone
apps also use XAML markup to define the user interface.)

The first seven lines below <Page> define the resources used to create the user interface.
Below these lines, the <Grid> ... </Grid> section defines the objects in the user interface.
This XAML content defines two TextBlock controls, one Image control, one TextBlock control,
and one Button control. If you look at the screen illustration of the Designer again, you can
see how many of these elements appear visually. (Two of them are currently hidden, so those
are not visible.) You can even see specific property settings for the objects being assigned
through individual property names (like HorizontalAlignment) and values (like Left).
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You'll learn a lot more about XAML markup in later chapters. For now, you should know that
the Designer window allows you to see both a preview of the user interface and the XAML
markup that defines the specific characteristics of objects that appear on the preview page.
Visual Studio programmers often want to see both panes of information side by side as they
work on a program. In fact, if you've built an HTML application in the past for the web, this
whole concept might seem a little familiar, because a number of web design tools also display
page layout at the top of the screen while showing HTML code at the bottom.

Q Tip There are some handy buttons along the bottom of the Designer window and
Code Editor that allow you significant control over the split-screen behavior of these

elements. At the lower left of the Designer window are XAML and Design tabs, as
well as a handy Document Outline button that opens a separate window to display
the objects within the user interface organized by type. At the lower right of the
Designer window are Vertical Split, Horizontal Split, and Expand Pane/Collapse Pane
buttons, which control how the Designer window and Code Editor are arranged.
Expand Pane/Collapse Pane is especially useful; it is a toggle that allows you to view
the windows one at a time or side by side.

7. Click the Design tab to display the project’s main page in the Designer window again.

8. Click the Expand Pane button to display the XAML markup that renders the page in a window
below the Designer window.

Now you'll try running this simple program within Visual Studio.

Running and testing Windows Store apps

Music Trivia is a simple Windows Store app written in Visual Basic 2013. | created it to familiarize you
with the programming tools in Visual Studio. The page you see now has been customized with five
objects, and I've added three lines of program code to a code-behind file to make the program ask
a simple question and display the appropriate answer. You'll learn more about creating objects like
these and adding Visual Basic code to a code-behind file in Chapter 3, “Creating your first Windows
Store application.” For now, try running the program in the Visual Studio IDE.

Run the Music Trivia program

1. Click the Start button (the right-facing arrow next to the words Local Machine) on the
Standard toolbar to run the Music Trivia program in Visual Studio.

Q Tip You can also press F5 or click the Start Debugging command on the Debug
menu to run a program in the Visual Studio IDE.
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Visual Studio loads and compiles the project into an assembly, an EXE file that contains data
and code in a form that can be used by the computer. This particular assembly also contains
information that is useful for testing, or debugging, which is a fundamental part of the soft-
ware development process. If the compilation is successful, Visual Studio runs the program in
the IDE. (This is known as running the program on a local machine, as opposed to running on
a remote computer somewhere on the web or in a software simulator of some kind.)

While the program is running, an icon for the program appears on the Windows taskbar. After
a moment, you will see the Music Trivia user interface running as any application would under
Windows 8.1. (You might also see some numbers along the top edge of the screen that are
used for debugging purposes; I've removed these from the book'’s screen shots for clarity.)

Otherwise, the program looks just like the preview version did within the Visual Studio
Designer:

Music Trivia

What rock and roll
instrument is often
played with sharp,
slapping thumb
movements?

Answer!

Music Trivia now asks you a question: What Rock And Roll Instrument Is Often Played With
Sharp, Slapping Thumb Movements?

Click the Answer! button to reveal the solution to the question, and the program displays the
answer (The Bass Guitar) below the question. A photo of a bass player also appears on the
page.
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3.

Music Trivia

What rock and roll
instrument is often
played with sharp,
slapping thumb

movements?

The Bass Guitar

Close the app by dragging the title bar (or top portion of the screen) to the bottom of the
screen (or however you normally terminate an app).

When you move the mouse cursor to the top edge of the screen, it changes to a hand, which
provides some visual feedback as you drag the title bar to the bottom of the screen to ter-
minate the program. After the application closes, you can press the Windows key or click the
Visual Studio program icon on the desktop to activate the IDE again.

The Music Trivia application might continue to run for a moment or two as the Visual Studio
IDE catches up with the terminate-program request that you just issued. (For example, you
might see the phrase Running in the Visual Studio title bar, which indicates that a program in
the IDE is still executing.) You can force an immediate stop to any running application in the
Visual Studio IDE by clicking the Stop Debugging button on the toolbar.

After the program has stopped running, you will notice a few changes in the IDE. For example,
you will likely see an Output window at the bottom of the IDE with information about how
the assemblies in the application were compiled and executed. This is the expected behavior
within Visual Studio after a program has been compiled and run. The Output window provides
a fairly detailed listing of what happened during compilation, a process that involves several
stages and the loading of a number of files and resources called libraries. This record of the
process is especially valuable when the compilation fails due to an unforeseen programming
mistake or error.
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4. After you've reviewed the content of the Output window, click its Close button to hide it.

You won't read much more about the Output window in the early chapters of this book, but if
you encounter an inadvertent error as you write your own programs, you'll find this tool use-
ful. Most of the time, you can simply close the window to allow more room for examining your
code.

Working with the Properties window

Like earlier versions of Visual Studio, Visual Studio 2013 has a Properties window in the IDE to allow
you to change the characteristics, or property settings, of one or more user interface elements on a
page. A property setting is a quality of one of the objects in your program, such as its position on the
screen, its size, the text displayed on it, and so on. For example, you can modify the text block object
that asks the question about musical instruments by specifying a different font or font size using
property settings.

The Properties window contains a list of the properties for the object that is currently selected in
the Designer window. For example, if a button object is selected in the Designer, the properties for
the object will be visible in the Properties window. The first property listed at the top of the Properties
window is the Name property, and you will use this property to name your objects if you plan to
customize them using Visual Basic code. (By default, all new XAML objects are unnamed.) Although
there are a lot of properties for each object on a page, Visual Studio assigns default values for most
of them, and you can quickly find the properties that you want to set by arranging them using the
Arrange By drop-down box at the top of the Properties window.

You can change property settings from the Properties window while you are working on a page,
you can modify a property setting by editing the XAML markup for a page, and you can add Visual
Basic code to a page’s code-behind file to instruct Windows to change one or more property settings
while a program is running.

As you'll learn later, you can also customize the event handlers for objects on a page by using the
Event Handlers button (which looks like a lightning bolt) near the top of the Properties window. Event
handlers are custom Visual Basic routines that run when the user interacts with the objects on a page
by clicking, tapping, dragging, and other actions.

Use the following exercise to review how to set properties. You'll modify the text in the button
object and change the font weight and style of the first text block object. (If you don't need a prop-
erty setting review, skip ahead to the section “Organizing the programming tools.”)

Change properties

1. Click the Answer button on the page that is currently loaded in the Designer window.

To work with an object on a page, you must first select the object. When you select an object,
the property settings for the object are displayed in the Properties window.
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2.

Press F4 to display the Properties window, if it is not currently visible.

The Properties window might or might not be visible in Visual Studio, depending on how it
has been configured and used on your system. It usually appears below Solution Explorer on
the right side of the IDE.

You'll see a window similar to the following:

@ Name | AnswerButton ¥
Type Button

Search Properties P

Arrange by: Category ~

P Brush

b Appearance

4 Common
ClickMode Release -0
Content Answer! [ ]
ContentTransiticns (Collection) EID
ToolTipService.To... [u]
DataContext u}

v

b Layout

P Text

b Transform

P Interactions

P Miscellaneous

The Properties window lists all the property settings for the selected button object, which |
named AnswerButton while creating the program. Properties are listed in nested groups, and
the default view displays the properties alphabetically by category. (Brush is first, Appearance
is second, Common is third, and so on.) When you expand the property groups, the property
names are generally listed on the left side, and the property values are listed on the right.
Some property settings, like Brush, are updated by selecting color values with a design tool, so
there are a variety of ways to set properties—not just entering text via the keyboard.

In the Common property group (containing the most typical properties for a button object),
see that the Content property is set to Answer!

Answerl is the text that currently appears on the page’s main button, and you can change it to
whatever you would like using the Properties window. Remove the exclamation point now to
practice changing a property.

Click after Answer! in the Content text box, remove the exclamation mark (!), and then press
Enter.

The Content property setting is changed to Answer in three places: within the Properties win-
dow, on the page in the Designer window, and within the XAML markup in the Code Editor.
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Tip Instead of pressing the Enter key to change a property setting, you can simply
click another location in the Properties window. (For example, click in another text
box.) Just be careful not to inadvertently adjust another property setting by clicking

around.

Now you'll change the font style of the text block object to remove the bold and italic. The

text block object currently contains the text Music Trivia.

Click the Music Trivia text block object on the page. A text block object is an excellent way to

display descriptive text on a page.

In the Properties window, click the Text property group (not the Text property in the Common

group that is currently visible).
Click the Bold button to remove the bold formatting.

Click the Italic button to remove the italic formatting.

Visual Studio records your changes and adjusts the property settings accordingly. Your screen

should look like this:
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You've just updated three properties, and the process is very similar to earlier versions of Visual
Studio, although in this case you are adjusting XAML properties related to a Windows Store app. Keep
this fundamental skill in mind—you'll have numerous font, color, and style options to choose from as
you complete this book.

Objects and properties: A terminology review

Here are some things to keep in mind as you work with objects and properties in a Visual Basic
program. First, remember that each user interface element in a program (including the page
itself) has a set of definable properties. You can set properties at design time by using the
Properties window or by editing properties in the XAML markup for the page that defines one
part the program'’s user interface.

Properties can also be set or referenced in Visual Basic code to make changes to program
elements while the application runs. (User interface elements that receive input often use
properties to receive information into the program.) Property settings are easy to grasp if you
view them in terms of something from everyday life. Consider the following bicycle analogy I've
used for several years to describe object and property terminology.

A bicycle is an object that you might use to ride from one place to another. Because a
bicycle is a physical object, it has several inherent characteristics. It has a brand name, a color,
gears, brakes, and wheels, and it's built in a particular style. (It might be a road bike, a moun-
tain bike, or a tandem bike.) In Visual Basic terminology, these characteristics are properties of
the bicycle object.

Most of the bicycle’s properties were defined when the bicycle was built. But others (tires,
travel speed, and options such as reflectors and mirrors) are properties that change while
the bicycle is used. The bike might even have intangible (that is, invisible) properties, such as
manufacture date, current owner, value, or rental status. And to add a little more complexity, a
company or shop might own one bicycle or (the more likely scenario) an entire fleet of bicycles,
all with different properties. As you work with Visual Basic, you'll set the properties of a variety
of objects, and you'll organize them in very useful ways. Working with properties is a funda-
mental task in object-oriented programming and Visual Studio 2013.

Organizing the programming tools

To give you complete control over the shape and size of the elements in the IDE, Visual Studio lets
you move, resize, dock, and automatically hide when not needed (a feature called autohide) most of
the interface elements that you use to build programs. These skills are essential, because they will
be used over and over in this book. If you want to review how the tools are used, read the follow-
ing sections and practice the techniques. If you already feel up to speed, skip ahead to the section
“Configuring the IDE for step-by-step exercises.”
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Moving and docking tools

To move one of the tool windows in Visual Studio, simply click its title bar and drag the window to a
new location. If you position the window somewhere in the middle of the IDE and let go, it will float
over the surface of Visual Studio, unattached to other tool windows. If you drag a window along the
edge of another window, it attaches to that window, or docks itself.

Dockable windows are advantageous because they always remain visible. (They don't become
hidden behind other windows.) If you want to see more of a docked window, simply drag one of its
borders to view more content.

If you want to completely close a window, click the Close button in the upper-right corner of the
window. You can always open the window again later by clicking the appropriate command on the
View menu.

Autohide

If you want an option somewhere between docking and closing a window, you might try autohiding a
tool window at the side, top, or bottom of the Visual Studio IDE by clicking the tiny Auto Hide push-
pin button on the right side of the tool’s title bar. This action removes the window from the docked
position and places the title of the tool at the edge of the development environment on an unob-
trusive tab. When you autohide a window, you'll notice that the tool window remains visible as long
as you keep the mouse pointer in the area of the window. When you click another part of the IDE (or
move the mouse away), the window slides out of view.

To restore a window that you have autohidden, click the tool tab at the edge of the development
environment. (You can recognize a window that is autohidden because the pushpin in its title bar is
pointing sideways.) By clicking the tool tab repeatedly at the edge of the IDE, you can use the tools
in what | call peekaboo mode—that is, to quickly display an autohidden window, click its tab, check or
set the information you need, and then click its tab again to make it disappear. If you ever need the
tool displayed permanently, click the Auto Hide pushpin button again so that the point of the pushpin
faces down, and the window then remains visible.

Tabbed documents, manual docking, and docking guides

Another useful capability of Visual Studio is the ability to dock the Code Editor or the Designer win-
dows as tabbed documents. A tabbed document is a window with a tab handle that partially hides
behind other windows. This is the default way that document windows are displayed.

You can also manually dock programming tools such as the Properties window where you would
like by dragging the tool and using the docking guides that appear as tiny squares on the perimeter
of the IDE. A centrally located guide diamond will also help you manually dock tool windows by giv-
ing you a preview of where the tool will go.
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The docking guides are changeable icons that appear on the surface of the IDE when you move
a window or tool from a docked position to a new location. Because the docking guides are associ-
ated with shaded, rectangular areas of the IDE, you can preview the results of your docking maneu-
ver before you actually make it. Your window orientation changes will not stick until you release the
mouse button.

Mastering the docking and autohiding techniques might take some practice when you are first
using them, so you might want to experiment a little.

Hiding tool windows

To hide a tool window, click the Auto Hide pushpin button on the right side of the title bar to conceal
the window beneath a tool tab on the edge of the IDE, and click it again to restore the window to its
docked position. You can also use the Auto Hide command on the Window menu (or right-click a title
bar and select Auto Hide) to autohide a tool window. Use the following procedure when you need to
use autohide.

Use the Auto Hide feature

1. Locate the Auto Hide pushpin button on the title bar of the Properties window.

The pushpin is currently in the down, or pushed-in, position, meaning that the Properties
window is “pinned” open and autohide is disabled.
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2. Click the Auto Hide button on the Properties window title bar, and the Properties window
slides off the screen and is replaced by a small tab named Properties.

Note The benefit of enabling autohide is that the process frees up additional work
area in Visual Studio. But the hidden window is also quickly accessible.

3. Click the Properties tab, and the Properties window should immediately reappear.
4. Click the mouse elsewhere within the IDE, and the window disappears again.

5. Finally, display the Properties window again, and then click the pushpin button on the
Properties window title bar. The Properties window returns to its familiar docked position, and
you can use it without worrying about it sliding away.

Spend some time moving, resizing, docking, and autohiding tool windows in Visual Studio now to
create your version of the perfect work environment. As you work through this book, you'll want to
adjust your window settings periodically to adapt your work area to the new tools you're using.

Configuring the IDE for step-by-step exercises

Like the tool windows and other environment settings within the IDE, the compiler and personal
settings within Visual Studio 2013 are highly customizable. It is important to review a few of these
settings now so that your version of Visual Studio is configured in a way that is compatible with the
step-by-step programming exercises that follow. You will also learn how to customize Visual Studio
generally so that as you gain programming experience, you can set up Visual Studio in the way that is
most productive for you.

If you just installed Visual Studio, you are ready to start this book’s programming exercises. But if
your installation of Visual Studio has been on your machine for a while or if your computer is a shared
resource used by other programmers who might have modified the default settings (perhaps in a
college computer lab), complete the following steps to verify that your settings related to projects,
solutions, and the compiler match those that | use in the book.

Adjust project and compiler settings

1. Click the Options command on the Tools menu to display the Options dialog box.

The Options dialog box is your window to many of the customizable settings within Visual
Studio. To assist you in finding the settings that you want to change, Visual Studio organizes
the settings by category.

2. Expand the Projects And Solutions category, and then click the General item within it.

This group of check boxes and options configures the Visual Studio project and solution settings.
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So that your software matches the settings used in this book, adjust your settings to match
those shown in the following dialog box:

Praojects location:
Cilsers'\Michael\Dacuments'\Visual Basic 2013 5BS

Search Options (Ctrl+E)

a Prajects and Solutions
General User project templates location:

Build and Run Chllsers'\Michael\Dacuments'\Visual Studie 2013\ Templates'ProjectTemplat
VB Defaults
WVC++ Directaries User itern templates lacation:

VC++ Project Settings Cillsers\Michael\Documents' Visual Studio 2013\ Templates' temTemplates

Web Prajects i - i
Source Control Always show Errar List if build finishes with errars

Text Editor [ Track Active Item in Solution Explorer

Debugging Show advanced build canfigurations

Performance Tools
Database Tools [[] Save new projects when created
F= Taals

HTML Designer
Office Tools
Package Manager
S0L Server Toals

[#] Warn user when the project location is not trusted
[ show Output window when build starts

[ Prompt for symbalic renaming when renaming files

In particular, | recommend that you clear the check marks (if you see them) from the Always
Show Solution and Save New Projects When Created check boxes. The first option, when
selected, shows additional solution commands in the IDE, which is not necessary for solutions
that contain only one project (the situation for most programs in this book).

Clearing the second option causes Visual Studio to postpone saving your project until you
click the Save All command on the File menu and provide a location for saving the file. This
delayed-save feature allows you to create a test program, compile and debug the program,
and even run it without actually saving the project on disk—a useful feature when you want to
create a quick test program that you might want to discard instead of saving. (An equivalent
situation in word-processing terms is when you open a new Word document, enter an address
for a mailing label, print the address, and then exit Word without saving the file.) With this
setting cleared, the exercises in this book prompt you to save your projects after you create
them, although you can also save your projects in advance by selecting the Save New Projects
When Created check box.

You'll also notice that | have browsed to the location of the book’s sample files (Visual Basic
2013 SBS) in the top text box on the form to indicate the default location for this book’s sam-
ple files. Most of the projects that you create will be stored in this folder, and they will have a
"My" prefix to distinguish them from the completed project | provide for you to examine. (Be
sure to change this path to the location of the book’s sample files on your computer.)

After you have adjusted these settings, you're ready to check the Visual Basic compiler settings.
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4.

Click the VB Defaults item in the expanded Projects And Solutions section.

Visual Studio displays a list of four compiler settings: Option Explicit, Option Strict, Option
Compare, and Option Infer. Your screen likely looks like this:

Search Options (Ctri+E) Default project settings:

a4 Prajects and Solutions Option Explicit:
General
EBuild and Run Option Strict:
Option Compare:
WC++ Directories
WC++ Project Settings Option [nfer:
Web Prajects
1> Source Contral
[» Text Editar
Debugging
Perfarmance Toals
Database Toals
F=Taols
HTML Designer
Office Toals
Package Manager
S0L Server Toals

Although a detailed description of these settings is beyond the scope of this chapter, you'll
want to verify that Option Explicit is set to On and Option Strict is set to Off—the default
settings for Visual Basic programming within Visual Studio. Option Explicit On is a setting that
requires you to declare a variable before using it in a program—a very good programming
practice that | want to encourage. Option Strict Off allows variables and objects of different
types to be combined under certain circumstances without generating a compiler error. (For
example, a number can be assigned to a text box object without error.) Although this is a
potentially worrisome programming practice, Option Strict Off is a useful setting for certain
types of demonstration programs.

Option Compare determines the comparison method when different text strings are com-
pared and sorted. For more information about comparing strings and sorting text, see
Chapter 14, “Using arrays, collections, and generics to manage data,” and Chapter 15,
“Innovative data management with LINQ."

Option Infer was a new setting in Visual Basic 2008. When you set Option Strict to Off and
Option Infer to On, you can declare variables without explicitly stating a data type. Or rather, if
you make such a declaration, the Visual Basic compiler will infer (or take an educated guess
about) the data type based on the initial assignment you made for the variable. You'll learn
more about the feature in Chapter 11, "“Mastering data types, operators, and string processing.”

As a general rule, | recommend that you set Option Infer to Off to avoid unexpected results in
how variables are used in your programs. | have set Option Infer to Off in most of the sample
projects included in the sample files.
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5. Feel free to examine additional settings in the Options dialog box related to your program-
ming environment and Visual Studio. When you're finished, click OK to close the Options
dialog box.

You're ready to exit Visual Studio and start programming.

Exiting Visual Studio

When you're finished using Visual Studio for the day, save any projects that are open and close the
development environment.

Exit Visual Studio

1. Save any changes you've made to your program by clicking the Save All button on the
Standard toolbar.

You've made a few changes to your project, so you should save your changes now.
2. On the File menu, click the Exit command.

The Visual Studio program closes. You are now ready to create a program from scratch in
Chapter 3.

Summary
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This chapter introduced you to Visual Studio 2013 and the IDE that you use to open and run Visual
Basic programs. You can create applications for the various Windows platforms by opening new or
existing projects in Visual Studio and then adding to the project with the assorted programming
tools. In this chapter, you learned how to display the user interface of a Windows Store app, how to
examine XAML objects on the page, and how to change property settings.

As you toured the Visual Studio IDE, you reviewed how to open and run an application, how to
examine XAML markup in the Code Editor, and how to manipulate tool windows in the IDE. You
also learned how to customize settings in Visual Studio by using the Options command on the Tools
menu.

The Visual Studio IDE is a busy place, and | have reviewed a few essential IDE techniques so that
you will be able to complete the step-by-step programming exercises that follow. However, there is
much more to learn. If you would like more information, consult my companion tutorial for Visual
Basic programming entitled Start Here! Learn to Program in Visual Basic 2012 (Microsoft Press, 2012).

In the next chapter, you'll create your first Windows Store application from scratch, a lucky number
slot machine game.
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Creating your first Windows Store
application

After completing this chapter, you will be able to
m  Design the user interface for a Windows Store app.
m  Use XAML controls in the Toolbox.
m  Work with random numbers, digital photos, and sound effects.
m  Write Visual Basic program code for an event handler.
m  Create a splash screen for your Windows Store app.
m  Save, test, and build a Windows Store app.

s you learned in Chapter 2, "The Visual Studio Integrated Development Environment," the

Microsoft Visual Studio 2013 IDE is ready to help you build your Visual Basic applications. In this
chapter, you'll dive right in and create a Visual Basic program for the Windows Store. As a complete
walkthrough exercise, this chapter describes the essential steps that you will complete each time that
you create a Visual Basic application in the Visual Studio 2013 IDE. In future chapters, you'll learn
more about the diversity of application types that you can create with Visual Studio, including apps
for the Windows Store, the Windows desktop, the console, the web, and Windows Phone. After you
learn the core Visual Basic programming skills, you'll find that all of these application types have much
in common.

In this chapter, you'll learn how to create a Las Vegas-style slot machine for the Windows Store.
You'll design the user interface for the program with XAML controls in the Toolbox, and you'll adjust
property settings and resize objects on the page with tools in the IDE. As part of the process, you'll
use the TextBlock control to display random numbers, the Image control to insert a digital photo-
graph, and the MediaElement control to play a sound effect when the user spins the number 7. To
create the core functionality of the Windows Store app, you'll write Visual Basic program code for an
event handler. Finally, you'll create a splash screen for the app, save and test the app in the IDE, and
build an executable file that can be launched from the Windows Start page.
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Lucky Seven: A Visual Basic app for the Windows Store

The Windows Store app that you're going to construct is Lucky Seven, a game program that simulates
a lucky number slot machine. Lucky Seven has a simple user interface and can be created and com-

piled in just a few minutes by using Visual Studio 2013. Here's what your program will look like when
it's finished:

Programming step by step
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The Lucky Seven user interface contains one button, three text block objects to display lucky num-
bers, a digital photo depicting cash winnings, and a text block containing the title "Lucky Seven." |
produced these elements by creating five visible objects on the Lucky Seven page and then changing
several properties for each object. | also added a MediaElement control to the page, which is not vis-
ible at runtime, to play a special sound effect when the user wins the game.

After | designed the basic user interface, | added program code for the Spin button to process the
user's button clicks and to display random numbers on the page. Finally, | created a splash screen for
the app and prepared it for distribution by using tools in the Visual Studio IDE.

To re-create Lucky Seven, you'll follow five essential programming steps that will be the same for
most of the projects that you create with Visual Studio. You'll design the user interface with Toolbox
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controls, adjust important property settings, write Visual Basic code, prepare a splash screen and
other required elements, test the program, and build an executable file.

Designing the user interface

In this exercise, you'll start building Lucky Seven by first creating a new project and then using XAML
controls for Windows Store apps to construct the user interface.

Create a new project

1. Start Visual Studio 2013.
2. On the Visual Studio File menu, click New Project.

The New Project dialog box opens, as shown here:

MNew Project e
I Recent NET Framework 45.1 = Sort by: Default - i Search Installed Templ 2 =
4 |nstalled VB 3
All|  Blank App (xaML) Visual Basic s viEEl e
4 Templates A single-page project for a Windows Store
VB F
4 Visual Basic :J Grid App (KAML) Visual Basic Iapp t:at (o= o st e (eenifel= 20
Windows Store - =
= VB
Windows :J Hub App (XAML) Visual Basic
b Web =
. VB
b Office/SharePoint _|-_J Split App (XAML) Visual Basic
Cloud ==
- VB
LightSwitch "nr:i! Class Library (Windows Store apps) Visual Basic
Reporting -
P VB
Silverlight ‘nlsi! Windows Runtime Component  Visual Basic
Test -
VB
pEcs 'nlsi! Portable Class Library Visual Basic
Worldflow d
VB
[Eipescrit ni! Unit Test Library (Windows Store... Visual Basic
I Other Languages o3
b Other Project Types
Samples
b Online
Click here to go online and find ternplates.
Mame: Appl

The New Project dialog box provides access to the major template types available for creating
applications with Visual Studio. On the left side of the dialog box is a list of the many template
types available. Because the most recent language selection | made in this dialog box was
Visual Basic, the Visual Basic templates are currently visible, but other programming templates
and resources are also offered, including those for Visual C#, Visual C++, and JavaScript.
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3.

In the Visual Basic template group, click the Blank App (XAML) project if it is not already
selected.

When you use the Blank App template, Visual Studio will create a basic Windows Store app
project with default tiles, splash screen, manifest, and startup code, but no predefined con-
trols or layout. Note that other app types are available (which we'll get to later), including
Windows (that is, Windows desktop), Web, and Windows Phone.

In the Name text box, type My Lucky Seven.

Visual Studio assigns the name My Lucky Seven to your project. (You'll specify a folder loca-
tion for the project later.)

Important I'm recommending the "My" prefix here so that you don't confuse your
new app with the Lucky Seven project I've created for you on disk. However, you'll
see that | don't use the "My" prefix myself in the instructions, sample projects, or
screen shots in the book—I am leaving that for your use.

If the New Project dialog box contains Location and Solution Name text boxes, you need to
specify a folder location and solution name for your new programming project now. Refer
to Chapter 2, in the section "Configuring the IDE for step-by-step exercises," to learn how to
adjust when these text boxes appear. As | noted in Chapter 2, | will be asking you to specify
a location when you first save your project—a step that is typically near the end of each
exercise.

Click OK to create the new project in Visual Studio.

Visual Studio prepares the IDE for a new programming project and displays Visual Basic code
associated with the blank application template. Your screen will look like this:
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** Invoked when the application is launched normally by the end user. Other entry points
"' will be used when the application is launched to open a specific file, to display
** search results, and so forth.
"</ summary>
** cparam name="e">Details about the launch request and process.c</param>
5 Protected Overrides Sub OnLaunched(e As Windows.ApplicationModel.Activation.launchActivatedEv:
4If DEBUG Then
" Show graphics profiling information while debugging.
If System.Diagnostics.Debugger.IsAttached Then
" Display the current frame rate counters
Me.DebugSettings.EnableFrameRateCounter = True
End If
#End If

Solution Explorer  Team Explorer

Properties

Dim rootFrame As Frame = TryCast(Window.Current.Content, Frame)

' Do not repeat app initialization when the Window already has content,
" just ensure that the window is active

If rootFrame Is Nothing Then
" Create a Frame to act as the navigation context and navigate to the first page
rootFrame = New Frame()
If e.PrevicusExecutionState = ApplicationExecutionState.Terminated Then
' TODO: Load state from previously suspended application
End If
" Place the frame in the current Window
Window.Current.Content = rootFrame
End If

00% - 4

What you see here is standard startup code for a Windows Store app created in Visual Studio
2013, and the code is stored in the file App.xaml.vb within the project. Although each project

contains an App.xaml file, your work in this chapter will begin with the app's user interface,
which is stored in the MainPage.xaml file.

Note The section beginning #/f DEBUG Then near the center of this illustration dis-
plays debugging information on the screen when the Windows Store app is executed
in debugging mode, and it is designed for testing purposes. This code was present
in the final Visual Studio 2013 software release and displays information about how
long various tasks are taking during the execution of the Visual Studio app, including
the frame rate for the user interface thread and how long it took (in milliseconds) to
load the user interface. If you want to suppress the debugging information, remove
the code between the #/f DEBUG and #End If statements. For more information
about the meaning of the debugging counters that appear at the top of the screen
during testing, see EnableFrameRateCounter on http.//msdn.microsoft.com.

You'll display that user interface now in the Designer and enhance it with Toolbox controls.

Creating your first Windows Store application
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Navigate the Designer

1.

Open Solution Explorer if it is not currently visible, and then double-click the file MainPage.xaml.

Visual Studio opens MainPage.xaml in a Designer window and shows the upper-left corner of
the app's main page. Below this page, you'll see the Code Editor with several lines of XAML
markup associated with the user interface page in the Designer. As you add controls to the
app page in the Designer, the Code Editor reflects the changes by displaying the XAML state-
ments that will create the user interface. Your screen should look like this:
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Each time that you create a Windows Store app with Visual Basic and Visual Studio, you'll
use Toolbox controls and XAML markup to design the user interface. This technique will be
new to Visual Basic programmers who have primarily created Windows applications by using
the technology known as Windows Forms. (You will have used the Toolbox but not XAML
markup.) However, XAML will be somewhat familiar to programmers who have created
Windows applications using Windows Presentation Foundation (WPF) or Windows Phone.

Now let's review how the Designer works.
Click the scroll box in the Designer's vertical scroll bar, and drag it down.

When you drag a scroll box in the Designer window, you can see more of the user interface
you are working on.
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Click the scroll box in the Designer's horizontal scroll bar, and drag it right. (Likewise, when
you drag a horizontal scroll box, you can see hidden parts of the user interface.)

Near the lower-left corner of the Designer, you'll see a Zoom tool, which allows you to zoom
in on the current application page (to see more detail) or zoom out (to see more of the page).
The current value of the Zoom tool is 67%. You can select a different value by clicking the
Zoom tool's drop-down button.

Click the Zoom drop-down button, and then click Fit All.

The entire application page now fits within the Designer. Depending on your screen resolu-
tion and the amount of screen space you have designated for the other IDE tools, you'll see a
somewhat smaller version of the page.

Tip If your mouse has a mouse wheel, you can move quickly from one zoom setting
to the next by holding down the Ctrl key and rotating the mouse wheel. This feature
works whenever the Designer is active.

It is important to be able to quickly view different parts of the application page in different
sizes while you build it. Sometimes you want to see the entire page to consider the layout of
controls or other elements, and sometimes you need to view portions of the page up close.
It's up to you to adjust the Designer window so that you can see the user interface clearly as
you work with it.

Now set the Designer to its full-size setting.
Click the Zoom drop-down button, and then click 100%.

Adjust the Designer's vertical and horizontal scroll bars so that you can see the upper-left
edge of the page.

Seeing the edge of the page will help you orient yourself to the application window that the
user sees.

Now you'll add a Toolbox control to the page.

Open the Toolbox and use the TextBlock control

1.

If the Toolbox is not currently visible, click the Toolbox tab or click the Toolbox command on
the View menu.

The Toolbox window contains a large collection of user interface controls that you can add to
your application. Because you are building a Windows Store app for Windows 8.1, the types
of controls that are displayed in the Toolbox are so-called XAML controls—that is, structured
elements that control the look and feel of an application and can be successfully organized on
a page by the XAML parser within Visual Studio.
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There are also other collections of Toolbox controls for other types of applications (Windows
Forms controls, HTML controls for web applications, Windows Phone controls, and so on),
but you don't have to worry about that now—Visual Studio automatically loads the proper
controls into the Toolbox when you open a new solution.

Your screen should look like this:

BQ Lucky Seven - Microsoft Visual Studio & Y QuickLaunch (Ctrl+0) P - & x
FILE EDIT WVIEW PROJECT BULD DEBUG TEAM SQL DESIGN FORMAT TOOLS TEST AMNALYZE WINDOW  HELP Michael ). Halvorson = n
Q- -2 P Local Machine ~ G. G Debug - -
~  Solution Explorer > x
Search Toolbox P~ - @ e-endi@
b Advertising - Search Solution Explorer (Ctrl+:) P~

P Comman XAML Cantrols

4 All XAML Cantrals [ Lucky Seven (Windows 8.1)

o
3
S
T
g
2
o
2
o My Project
E &k Pointer b Assets
3 &l AppRar > [ Appaaml
?5 G} AppBarButtan £ Lucky Seven_TemporaryKey.pfx
S < AppBarSeparator b L) MainPagesxaml
i O AppBaToggleButton K5 Package.apprmanifest
2 H Border
w O Buttan
S
£ Canvas
% & CaptureElement
CheckBox
B ComboBox Solution Explorer  Team Explorer
= CommandBar Properties T ax
&l ContentControl Search Properties p
T ContentPresenter
DatePicker
O Ellipse
‘B FlipView =
[ Flyout +
-
‘_ﬁ Ff“”‘* -om/winfx/2806/xaml/presentation” =
g Ond t. comfwinfx/2806/xaml"
GridView
Hub t.com/expression/blend/20@8

formats.org/markup-compatibility/2606"
HubSectian

HyperlinkButtan

Image : ApplicationPageBackgroundThemeBrush}">
-

temsCantral . b

For convenience, the Toolbox controls have been organized into several groups: Advertising,
Common XAML Controls (those controls that appear in many applications), and All XAML
Controls (a list of all the XAML controls for Windows Store apps that are configured for use
with Visual Studio).

Remember that the Toolbox window is like any other tool window in the Visual Studio IDE. You
can move it, resize it, or pin it as needed. You can choose to keep the Toolbox open while you
add controls to a new page (pinning it to the side of the IDE), or you can choose to use the
Toolbox window's autohide feature so that the Toolbox collapses after each control has been
selected.

Click the TextBlock control in the Toolbox, and move the mouse pointer to the Designer window.

The mouse pointer changes to crosshairs. The crosshairs are designed to help you draw the
rectangular shape of the TextBlock control on the page. You can also create a TextBlock with
the default size by double-clicking the control in the Toolbox.
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Click and drag to create a large rectangle-sized text block object that fills the top-left corner
of the page.

When you release the mouse button, Visual Studio creates a XAML text block object. TextBlock
is designed to display text on your page and, in this case, can create a welcoming banner for
your Windows Store app. You can update the text stored in the TextBlock object on your page
by setting the Text property, either with the Properties window, XAML markup, or program
code.

In the Properties window, change the Text property of the text block object to Lucky Seven
and press Enter.

Visual Studio displays "Lucky Seven" in the Properties window and in the Designer window.
Now you'll increase the point size of the title and apply other formatting effects.

In the Properties window, in the Text category, click the Font Size text box, type 98, and press
Enter.

The Font Size text box offers a variety of font sizes up to 72, but in this case, you're typing a
larger number to create a big impact on the screen.

Tip At any time, you can delete an object and start over again by selecting the ob-
ject on the page and then pressing Delete. Feel free to create and delete objects to
practice creating your user interface.

In the Properties window, in the Brush category, click the Foreground property, if it is not
already selected.

The Foreground property controls the color of the text in the text block.
Click the Solid Color Brush button.

The Solid Color Brush button is the second tile from the left near the top of the dialog box.
(This button might also be the default selection, but it will cause no harm if you click it again.)

When the Solid Color Brush button is selected, you'll see the Color Resources editor.

If you'd like more room to see the content of the Properties window, enlarge the window or
configure the tool as a floating window so that you can see the Color Resources editor clearly.

Near the bottom of the editor, select the number containing the pound (#) sign.

This eight-digit number is known as a hexadecimal color value—that is, a number expressed
in base-16 arithmetic that specifies color by using RGBA values. When you specify a new color
for text, you can specify individual values for red, green, and blue (R, G, and B), or you can use
a standardized name, such as Red, DarkRed, White, Black, Purple, Lime, or Aquamarine.
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10. Type DarkRed and press Enter.

Note that after you press Enter in the Color Resources editor, Visual Studio converts "DarkRed"

to the hexadecimal value #FF8B0000, as shown in the following screen:
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11. Return the Properties window to its docked position if you moved or enlarged it.

Now you'll add three TextBlock controls below the Lucky Seven banner to display the randomly
chosen numbers in the game. Each time that the user clicks Lucky Seven's Spin button, three new
numbers will appear in these text blocks. If one of the numbers is a 7, the user wins and a sound is

played.

Add text blocks for the random numbers

1.

Double-click the TextBlock control in the Toolbox.

Visual Studio creates a text block object on the page. In this case, the text block object is quite

small, but you can resize it.

In the Properties window, click the Text category, click the FontSize box, type 72, and then
press Enter.

Visual Studio expands the text block object to accommodate text in 72-point font.
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3.

7.

In the Properties window, click the Common category, click the Text box, type 0, and press

Enter.

0 will be an initial value for the first lucky number in the program.

At the top of the Properties window, change the Name property of the text block object to

FirstNum.

It is not required that all objects be named in your user interface, but it is important to name
objects that will be referenced in program code. Because you'll be controlling the value of this
lucky number in a Visual Basic event handler, you'll give it the name FirstNum here.

Drag the FirstNum text block object below the "u" in Lucky Seven.

Your page should look something like this:
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Double-click the TextBlock control in the Toolbox to create another text block object.

This object will hold the second lucky number on the page.

Using the Properties window, set the Name property of the object to SecondNum, set the

FontSize property to 72, and set the Text property to 0.
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8. Move the new SecondNum object to the right of the FirstNum object, directly below the "y" in
Lucky Seven.

Now you'll create the third lucky number for the page.
9. Double-click the TextBlock control in the Toolbox to create the last text block object.

10. Using the Properties window, set the Name property of the object to ThirdNum, set FontSize
to 72, and set Text to 0.

11. Move the ThirdNum object to the right of the SecondNum object, directly below the first "e" in
Lucky Seven.

When you've finished, your four text block objects should look like those in this screen shot.
(You can move your objects if they don't look quite right.)
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Now you'll add a button control to the page.

Add a button control

1. Click the Button control in the Toolbox, and then move the mouse pointer over the application
page.

2. Drag the pointer down and to the right. Release the mouse button to complete the button.
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3. Inthe Properties window, in the Common category, change the Content property to Spin and
press Enter.
Note that a button object's contents are set via the Content property, rather than Text (like a
text block object), because buttons can contain artwork and other data.

4. In the Properties window, change the button object's Name property to SpinButton.

5. In the Properties window, in the Text category, change the FontSize property to 24.

6. Resize the SpinButton object so that it is 81 pixels high and 95 pixels wide.

7. Move the button object so that it is to the right of the third lucky number on the page. Snap

lines will appear again as you move the object, and the top edge of the button will snap to the

top edge of the three numbers when aligned.

Your screen should look like this:
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Now you'll add an image to the page to graphically display the payout you'll receive when you

draw a 7 and hit the jackpot. An Image control is designed to display bitmaps, icons, digital photos,
and other artwork—a major design feature of most Windows Store apps. One of the most common

uses for an Image control is to display a PNG or JPEG file.
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Add an image

7.

Click the Image control in the Toolbox.

Using the control's drawing pointer, create a large rectangular box below the lucky numbers
and the Spin button on the page.

If necessary, adjust the Zoom setting in the Designer window so that you can see more of the
page in the Designer. For example, a Zoom setting of 50% might be useful.

It would be good if the image object covered most of the remaining area of the page below
the numbers and the Spin button. Sometimes it is useful to reduce the size of a page in the
Designer with the Zoom control to make these types of operations easier.

Now you'll add a suitable photo to the project by using Solution Explorer and the Assets
folder, a special container for resource files in your project.

If Solution Explorer is not visible now, open it by clicking Solution Explorer on the View menu.

As you've already learned, Solution Explorer provides access to most of the files in your
project, and prominently listed in Solution Explorer is the Assets folder, a container for your
project's logo, splash screen, and other files. You'll add a digital photo to the Assets folder in
the following step, which will make it available to your program.

Right-click the Assets folder in Solution Explorer to display a shortcut menu of useful Visual
Studio commands.

Point to the Add command, and then click Existing Item.

In the Add Existing Item dialog box, browse to the My Documents\Visual Basic 2013 SBS\
Chapter 03 folder and click Coins.jpg, a JPEG file containing coins from around the world—a
visual representation of winnings in the Lucky Seven app.
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10.

Click Add to add the photo to your project in the Assets folder.

Visual Studio inserts the file, and it appears now in Solution Explorer under Assets, as shown in
the following illustration:
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When a file has been added to the Assets folder, it becomes part of the project you are work-
ing on, and it can be referenced via the Properties window. Most importantly, it becomes part
of the project when the project is compiled for distribution—there is no need to remember
where the file was originally located on your hard disk, because a copy will now travel with the
project.

Select the image object (if it is not already selected) so that its properties are visible in the
Properties windows.

In the Properties window, in the Common category, click the Source text box, and then click
Coins.jpg.

You might need to expand the Properties window a little to see the drop-down list box arrow
in the Source text box.

After the file has been selected, a photo of coins from around the world fills the image object
in the Designer.
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11. Adjust the spacing of the image so that it takes up much of the left side of the page in the
Designer.

When you've finished, your page should look like this:
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12. In the Properties window, change the Name property of the image object to Coinlmage.

Naming the image object is an important step, because you'll be referring to this object in
Visual Basic code. Often you'll see me include the name of the control at the end of an object
name so that its object type is clear.

Now you'll add a sound effect to the program so that the game plays a sound when the user spins
a 7. You'll add this sound effect with the MediaElement control, which plays audio and video files in a
Windows Store app. The sound you'll play is stored in a short WAV file named ArcadeRiff, created by
Henry Halvorson.
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Play audio media with the MediaElement control

1.

In the Toolbox, expand the All XAML Controls category and double-click the
MediaElement control.

Visual Studio places a new media player object in the upper-left corner of the page. Like other
new objects in the Designer, you can now move the object to a new location and customize it
with property settings. However, the MediaElement control is essentially a behind-the-scenes
tool; it is not visible to the user unless the control is displaying a video clip. For now, you can
leave the media element object where it is.

The Source property of the MediaElement control specifies the name of the media file that will
be loaded into the control for playback. Before you can assign this property, you need to add
a valid media file to the Assets folder, just as you did for the image control.

Right-click the Assets folder in Solution Explorer to display the shortcut menu.
Point to the Add command, and then click Existing Item.

In the Add Existing Item dialog box, browse to the My Documents\Visual Basic 2013 SBS\
Chapter 03 folder and click ArcadeRiff.wav.

Click Add to add the music file to your project in the Assets folder.
Visual Studio inserts the file, and it appears now in Solution Explorer under Assets.

Now you're ready to name the media element object and assign it a music asset by using the
Source property.

Click the media element object in the Designer window. (Zoom in on the Designer if neces-
sary—remember that the object is invisible but it can be selected. You can always find it by
clicking the MediaElement entry in the XAML tab of the Code Editor.)

In the Properties window, change the Name property to CoinSound.

Expand the Media category, scroll down to the Source property, and click the Source list box.
Your new media file (ArcadeRiff.wav) appears in the list.

Click the ArcadeRiff.wav file to link it to the CoinSound object.

Your screen will look like this (notice the entries in Solution Explorer and the Properties
window):
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The Properties window exposes a few other important media element properties that you can
examine and adjust if desired.

For example, the AutoPlay check box is enabled by default, which directs the media control to
automatically play the specified media file when the page loads. Because you don't want the
sound to play until it is needed, disable that now.

Remove the check mark from the AutoPlay check box.

There are some other options you might notice now (but not adjust). The Position property
specifies the location within the media file where playback will begin; this option is very useful
if there is a specific place in the song or video where you want to start.

The IsLooping property is a Boolean value that allows you to run the media file over and over
again if you like. Finally, Volume allows you to set an initial volume level for the media play-
back, which you can adjust with property settings in an event handler while the program is
running.
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Final property settings and adjustments

Your Lucky Seven page is almost complete. You just need to make a few final property settings, write
the Visual Basic code, and design a splash screen that runs when your project starts.

Before you begin these tasks, let's think a little more specifically about how the program will oper-
ate when it runs. The game starts when the user opens the program and clicks the Spin button. When
the Spin button is clicked, the app generates three random numbers and displays them in text block
objects on the page. If and when the player hits the jackpot (that is, when at least one 7 appears in
the text block objects), the object containing the photo of coins appears, and then the media element
control plays a "celebration" sound.

Although the flow of events is pretty straightforward, the program needs to continue operating
after the first "win." So, when the user clicks the Spin button, the coins image needs to disappear and
remain hidden until another 7 appears, at which point the image is displayed again and the sound
effect also run.

To get this behavior to work correctly, you need to find a mechanism to make the image object
visible and invisible when you want. That can be accomplished by setting the image object's Visibility
property, which is assigned Visible or Collapsed (invisible) values as needed. In fact, most objects in
a Windows Store app can be made visible or invisible if you set this property—it is a built-in tool to
control what appears on the screen. Give it a try here.

Set the Visibility property

1. Click the image object on the page.
2. Inthe Properties window, click the Appearance category, and then click the Visibility property.
3. Inthe drop-down list box that appears, click the Collapsed property.

The image object on the page disappears. Don't worry—this is the desired effect. The object
is not gone, it is just currently invisible. You'll make it reappear by using program code in an
event handler.

Now you'll adjust the background color for the page. The default color value for Windows Store
apps is Black, but a more colorful value can make the game more appealing. You can adjust this color
by selecting the Grid object on the page and adjusting values in the Brush category by using the
Properties window.
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Set the page's background color

1.

Select the Grid object by clicking the background page in the Designer (not one of the objects
that you've just added).

You can tell when you've selected the Grid object because its properties will fill the Properties
window.

As you'll learn in Chapter 7, "XAML markup step by step,” each of the objects in a Windows
Store app is defined by XAML markup codes and data that can be entered or adjusted in the
Code Editor. The Grid object is the base layout element for a page, and all of the elements
on a page are nested within this Grid object. In addition to serving as a useful container for
objects, the Grid object also has settings that you can adjust, such as the background color
that appears for your app. You'll set this now.

Click the Brush category, click the Background property, and then click the Solid Color Brush
button.

Near the bottom of the Color Resources editor, select the number containing the pound (#)
sign, replace the contents with Green, and press Enter.

The alphanumeric value for green (#FFO080000) appears in the text box, and the background
color of the Grid object changes to green. Feel free to experiment with other color values if
you like.

OK—that's it for the user interface design walkthrough. Save your work now, before you write
the program code.

Save changes

1.

Click the Save All command on the File menu to save all your additions to the Lucky Seven
project.

The Save All command saves everything in your project—the project file, the pages, the code-
behind files, the assets, the package manifest, and other related components in your applica-
tion. Because this is the first time that you have saved your project, the Save Project dialog

box opens, prompting you for the name and location of the project. (If your copy of Visual
Studio is configured to prompt you for a location when you first create your project, you won't
see the Save Project dialog box now—YVisual Studio just saves your changes.)

Browse and select a location for your files. | recommend that you use the My Documents\
Visual Basic 2013 SBS\Chapter 03 folder (the location of the book's sample files), but the loca-
tion is up to you. Because you used the "My" prefix when you originally opened your project,
this version won't overwrite the practice file that | built for you on disk.
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3. Clear the Create Directory For Solution check box.

When this check box is selected, it creates a second folder for your program'’s solution files,
which is not necessary for solutions that contain only one project (the situation for most pro-
grams in this book).

4. Click Save to save your files.

Q Tip If you want to save just the item you are currently working on (the page, the
code module, or something else), you can use the Save command on the File menu.
If you want to save the current item with a different name, you can use the Save As
command.

Writing the code

Now you're ready to write the code for the Lucky Seven program. Because most of the objects you've
created already "know" how to work when the program runs, they're ready to receive input from the
user and process it. The inherent functionality of objects is one of the great strengths of Visual Studio
and Visual Basic—after objects are placed on a page and their properties are set, they're ready to run
without any additional programming.

However, the "meat” of the Lucky Seven game—the code that actually calculates random numbers,
displays them in boxes, and detects a jackpot—is still missing from the program. This computing logic
can be built into this Windows Store app only by using program statements—code that clearly spells
out what the program should do at each step of the way. Because the Spin button drives the program,
you'll associate the code for the game with an event handler designed for that button.

In the following steps, you'll enter the Visual Basic code for Lucky Seven in the Code Editor.

Use the Code Editor

1. In the Visual Studio Designer, click the SpinButton object.
2. Open the Properties window, and close the Brush category.

3. Near the top of the Properties window and to the right of the Name property and the
Properties button, click the Event Handler button (a square button displaying a lightning bolt
icon).

A collection of actions or events that a button object can respond to fills the Properties win-
dow. Typical events that a button might recognize include Click (a mouse click), DragOver (an
object being dragged over a button), Tapped (a button being touched by a finger), and Drop
(an object being dragged over and dropped on a button).
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Because Visual Basic is, at its core, an event-driven programming language, much of what you
do as a software developer is create user interfaces that respond to various types of input
from the user, and then you write event handlers that manage the input. Most of the time,
you will need to write event handlers only for a few events associated with the objects in your
programs. (However, the list of events is quite comprehensive to give you many options.)

To create an event handler for a particular event, you double-click the text box next to the
event in the Properties window. Because you want to generate three random numbers each
time that the user clicks the Spin button in your program, you'll write an event handler for the
button's Click event.

Double-click the text box next to the Click event in the Properties window.

Visual Studio inserts an event handler named SpinButton_Click in the Click text box, and opens
the MainPage.xaml.vb code-behind file in the Code Editor. Your screen should look like this:
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Inside the Code Editor are program statements associated with the MainPage template that
you opened when you started this project. This is Visual Basic program code, and you might
notice right away that some of the code is organized into concise units, known as procedures.
Near the bottom of the file is a new event handler procedure that you just created, called
SpinButton_Click.
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The Sub and End Sub keywords designate a procedure, and the keywords Protected and
Private indicate how the procedure will be used. You'll learn more about these keywords later.

When you double-clicked the Click text box in the Properties window, Visual Studio automati-
cally added the first and last lines of the SpinButton_Click event procedure, as the following
code shows. (Your event procedure will not wrap as this one does. In print, | need to respect
the book's margins.)

Private Sub SpinButton_Click(sender As Object, e As RoutedEventArgs) Handles SpinButton_
Click

End Sub

The body of a procedure fits between these lines and is executed whenever a user activates
the interface element associated with the procedure. In this case, the event is a mouse click,
but as you'll see later in the book, it could also be a different type of event. Programmers refer
to this sequence as "triggering" or "firing" an event.

Tip You might also notice lines of text with green type in the Code Editor. In the
default settings, green type indicates that the text is a comment, or an explanatory
note written by the creator of the program, so that it might be better understood
or used by others. The Visual Basic compiler does not execute, or evaluate, program
comments.

Type the following program code, and press the Enter key after the last line:

Dim generator As New Random
CoinImage.Visibility = Windows.UI.Xaml.Visibility.Collapsed

FirstNum.Text = generator.Next(0, 9)
SecondNum.Text = generator.Next(0, 9)
ThirdNum.Text = generator.Next(0, 9)

If (FirstNum.Text = "7") Or (SecondNum.Text = "7") Or
(ThirdNum.Text = "7") Then
CoinImage.Visibility = Windows.UI.Xaml.Visibility.Visible
CoinSound.Play(Q

End If

As you enter the program code, Visual Studio formats the text and displays different parts of
the code in color to help you identify the various elements. When you begin to type the name
of an object property, Visual Basic also displays the available properties for the object that
you're using in a list box, so you can click the property or keep typing to enter it yourself.
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Your screen should now look like this:
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Col 15

Note If Visual Basic displays an additional error message, you might have misspelled
a program statement. Check the offending line against the text in this book, make
the necessary correction, and continue typing. (You can also delete a line and type it
again from scratch.)

In Visual Studio, program statements can be composed of keywords, properties, object
names, variables, numbers, special symbols, and other values. As you enter these items in the
Code Editor, Visual Studio uses a feature known as IntelliSense to help you write the code.
With IntelliSense, as Visual Studio recognizes language elements, it will automatically com-
plete many expressions.

Click the Save All button to save your changes.
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A look at the SpinButton_Click event handler

The SpinButton_Click event handler is executed when the user clicks the Spin button on the page.
Essentially, the event handler performs four main tasks:

1. It declares a random number generator named generator in the program.
2. It hides the digital photo.
3. It creates three random numbers and displays them in text block objects.
4. It displays the Coins.jpg photo and plays a sound when the number 7 appears.
Let's look at each of these steps individually.
The random number generator is declared by this line of code:
Dim generator As New Random

You've probably declared and used variables before in programs. But notice the variable type
here—the generator is declared using the type Random, which has been specifically designed to
support the creation of so-called "pseudo-random” numbers—that is, numbers that don't follow a
particular pattern and appear in a specific range. You'll use random numbers often in this book, and
you'll learn much more about data types and conversion in Chapter 11, "Mastering data types, opera-
tors, and string processing."

Hiding the photo is accomplished by the following line:
CoinImage.Visibility = Windows.UI.Xaml.Visibility.Collapsed

As you learned earlier, the Visibility property determines whether or not an object on a page is vis-
ible. This specific syntax uses the objects in the .NET Framework to collapse (or hide) the photo of the
coins. (This line is designed to restore the program to a neutral state if a previous spin had displayed
the coins.)

The next three lines handle the random number computations. Does this concept sound strange?
You can actually make Visual Basic generate unpredictable numbers within specific guidelines—that
is, you can create random numbers for lottery contests, dice games, or other statistical patterns. The
generator instance's Next method in each line creates a random number between 0 and 9—just what
you need for this particular slot machine application.

FirstNum.Text = generator.Next(0, 9)
SecondNum.Text = generator.Next(0, 9)
ThirdNum.Text = generator.Next(0, 9)

The last group of statements in the program checks whether any of the random numbers is 7. If
one or more of them is, the program displays the graphical depiction of a payout and plays the sound
effect to announce the winnings.
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If (FirstNum.Text = "7") Or (SecondNum.Text = "7") Or
(ThirdNum.Text = "7") Then
CoinImage.Visibility = Windows.UI.Xaml1.Visibility.Visible
CoinSound.PTay()

End If

Each time the user clicks the Spin button, the SpinButton_Click event handler is executed, or called,
and the program statements in the handler are run again. However, if you click the Spin button many
times in rapid succession, you might miss one or more of the sound effects, because the media ele-
ment object can play only one sound effect at a time.

Running Windows Store apps

Congratulations! You're ready to run your first Windows Store app. To run a Visual Basic program
from the IDE, you can do any of the following:

= Click Start Debugging on the Debug menu.

m  Click the Start Debugging button on the Standard toolbar. (You'll typically see "Local Machine"
next to this button, because you debug on the local computer by default.)

m  Press F5.

Try running your Lucky Seven program now. If Visual Basic displays an error message, you might
have a typing mistake or two in your program code. Try to fix it by comparing the printed version in
this book with the one you typed, or load Lucky Seven from your hard disk and run it.

Note | assume that you have named your project My Lucky Seven, but the instructions and
screen shots below will show Lucky Seven because you might be running the sample proj-
ect that | created.

Run the Lucky Seven program

1. Click the Start Debugging button on the Standard toolbar.

The Lucky Seven program compiles and runs. After a few seconds, the user interface appears,
just as you designed it.

2. Click the Spin button.

The program picks three random numbers and displays them in the labels on the page. When
a 7 appears, your screen will look like this:
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The presence of a 7 also triggers the sound effect, which lasts a few seconds and sounds a bit
like an electronic slot machine. You win!

Click the Spin button 15 or 16 more times, watching the results of the spins in the number text
blocks.

About half the time you spin, you hit the jackpot—pretty easy odds. (The actual odds are
about 2.8 times out of 10; you're just lucky at first.) Later on, you might want to make the
game tougher by displaying the photo only when two or three 7s appear, or by creating a run-
ning total of winnings.

When you've finished experimenting with your new creation, close the Windows Store app.

The program stops, and the IDE reappears on your screen. Click the Stop Debugging button
on the toolbar to end the program. Now you'll add a splash screen to the project.
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Creating a splash screen for your app

70

A splash screen is a transitional image that appears when your app first launches. Every Windows
Store app must have a splash screen, which consists of an image (or text) and a surrounding back-
ground color. The splash screen is stored in the Assets folder within Solution Explorer, and every new
Windows Store app has a basic splash screen that is created by default. You'll also see tile images in
the Assets folder, which you'll learn to customize in Chapter 9, "Exploring Windows 8.1 design features:
Command bar, flyout, tiles, and touch."

Although you can create a splash screen with Microsoft Paint or another third-party graphics
program, you can also create a simple splash screen within Visual Studio. Just remember that a splash
screen appears very briefly when you first launch your app. Accordingly, this is not the place to put
elaborate program instructions or copyright information. You'll want to avoid placing advertisements
or version information on a splash screen.

Instead, use the splash screen to offer a preview of the functionality of your app in some unique
way. Consider an image or photo that will be easily adapted to other countries and cultures (that is,
easily localizable) and that can be displayed effectively in different screen resolutions. Notice that
Portable Network Graphics (.png) format is used because this file type is capable of displaying alpha
transparency and 24-bit color images. When part of an image is formatted as transparent, the back-
ground color will be displayed behind it. (You'll see this in most splash screens and tiles in Windows
Store and Windows Phone apps.)

Create a Lucky Seven splash screen

1. In Solution Explorer, open the Assets folder, and then double-click the file SplashScreen.scale-
100.png.

2. This action opens the Image Editor Designer in Visual Studio, and loads the SplashScreen.
scale-100.png file into the editor. Your screen looks like this:
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The Solution Explorer and Properties windows are still visible. However, the Image Editor is
active, and the design canvas is surrounded by graphics editing tools. The "X" shape in the
center of the canvas is simply the default image for the SplashScreen.scale-100.png file. This is
the image that you want to replace now.

Click the Selection tool in the upper-left corner of the Image Editor, select the entire "X"
shape, and press Delete.

You now have a blank canvas on which to create your splash screen image. The alpha checker-
board pattern that you see is a color scheme that allows you to more easily see the transpar-
ent portions of your image—that is, what you see displayed as the checkerboard now will be
replaced by the background when your splash screen is actually displayed on the screen.

Click the Ellipse tool on the left side of the Designer, and then create a circle shape in the
middle of the splash screen.

You can use the X- and Y-axis indicators in the lower-right corner of the screen to create your
circle if you like. You can also use the Selection tool to move your shape to the center of the
screen if you like.
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Your Image Editor will look like this:
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Use the Ellipse tool to add four or five smaller circles around the edge of the circle that you
have created.

Typical splash screens show simple geometric shapes like this. Consider using a simplified ver-

sion of your company logo.

Your simple splash screen now looks like this:
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You could add additional effects to this splash screen, embellishing it with colors, images, text,
or animation. However, for this first walkthrough, you have something that will work just fine.

6. Click the Save All command on the File menu to save your changes.
7. Press F5 to run the project, and examine your splash screen.

Notice that the splash screen comes and goes in just a few moments. Did you notice the
ellipse shapes and the black background color?

8. Close the program, and then close the Image Editor Designer.

Now your project is complete—it is time to test and deploy the app by adding it to the Windows
Start page on your local computer. However, note that if this were a commercial Windows Store app
being prepared for distribution to other users via the Windows Store, you would now add additional
items to your app as described in Table 1-1. For more information, see Chapter 1, "Visual Basic 2013
development opportunities and the Windows Store."
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Sample projects on disk

If you didn't build the My Lucky Seven project from scratch (or if you did build the project and
want to compare what you created to what | built for you as | wrote the chapter), take a mo-
ment to open and run the completed Lucky Seven project, which is located in the Visual Basic
2013 SBS\Chapter 03 folder on your hard disk (the default location for the practice files for this
chapter). If you need a refresher course on opening projects, see the detailed instructions in
Chapter 2.

This book is a step-by-step tutorial, so you will benefit most from building the projects on
your own and experimenting with them. But after you have completed the projects, it is often a
good idea to compare what you have with the practice file "solution” that | provide, especially if
you have unexpected results. To make this easy, | will give you the name of the solution files on
disk before you run the completed program in most of the step-by-step exercises.

After you have compared the My Lucky Seven project to the Lucky Seven solution files on
disk, reopen My Lucky Seven and prepare to compile it as an executable file. If you didn't cre-
ate My Lucky Seven, use my solution file to complete the exercise.

Building an executable file

74

Your last task in this chapter is to complete the development process and create an application for
Windows, or an executable file. Windows applications created with Visual Studio have the file name
extension .exe and can be run on any system that contains Windows and the necessary support files.
If you end up distributing your application via the Windows Store, the complete deployment pack-
age will be posted securely in the Store and made available to customers who would like to download
it. However, you can also deploy your application to individual computers running Windows directly
from within Visual Studio.

Because you just created a Windows Store app that targets the Windows 8.1 operating system, you
need to be running Windows 8.1 to run this particular program. You won't post the sample app to the
Windows Store yet, because it has not been registered or thoroughly tested. But you can deploy the
app on your own computer, which does not have as many registration requirements as the Windows
Store interface.

To assist in the testing and compilation process, Visual Studio allows you to create two types of
executable files for your Windows application project: a debug build and a release build.
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Debug builds are created automatically by Visual Studio when you create and test your program.
They are stored in a folder called bin\Debug within your project folder. The debug executable file
contains debugging information that makes the program run slightly slower.

Release builds are optimized executable files stored in the bin\Release folder within your project.
To customize the settings for your release build, you click the ProjectName Properties command on
the Project menu, and then click the Compile tab, where you'll see a list of compilation options that
looks like the following screen. The Solution Configurations drop-down list box on the Standard
Visual Studio toolbar indicates whether the executable is a debug build or a release build.

B Lucky Seven - Microsoft Visual Studio & ¥ QuickLaunch (Ctrl-0) £ 8 x
FLE EDIT  VIEW PROJECT BULD DEBUG TEAM SOL TOOLS TEST ANALYZE WINDOW  HELP Michael ). Halvorson ~ [l
‘o~ [l " p Local Machine - G G Debug - .
5 | Lucky Seven = > [FRRRRNRY MainPage xam MainPagexamlyvb Appxamlvb ~ Solution Explorer ~1x
o -,
2 Application @D e-endm &
Configuration: | Active [Debug) v Platform: | Active (Any CPU) v
Search Solution Explorer (Ctrls) p-
Lucky Seven (Windows 8.1 -
Debug Build output path: - , ;’ = b
y Projec
References bin\Debug Brawse... 4 @l Assets
Signing F——— #: ArcadeRiftwa
F Coins.jpg

My Extensions

Cade Analysis

[5] Logo.scale-100.,png

Optian explicit: Option strict:
& Bl . 9 smallLogascale-100.png
4 SplashScreen scale-100.png
Option compare: Optien infer: [ StoreLogo scale-100.png
Binary | lon v b D1 Appoaml
£ Lucky Seven_TemporaryKey.pfx
Target CPU: b D) MainPagesxaml
L S T -
D v Solution Explorer | Team Explorer
Prefer 32-bit P & -1
Warming configurations: -
Candition Notification ~ =i
Implicit conversion None v
Late binding: call cauld fail at run time Mone v
Implicit type: object assumed None v
Use of variable prior to assignment Waring v

[] Disable all warnings
[] Treat all warnings as errars
Generate XML documentation file

Register for COM interop

Build Events..

<

v
>

The process of preparing an executable file for a specific computer is called deploying the application.
As noted, when you deploy an application with Visual Studio, the IDE handles the process of copying
all the executable and support files that you will need to register the program with the operating sys-
tem and run it. Visual Studio allows you to deploy applications /ocally (on the computer you are using)
or remotely (on a computer attached to the network or Internet).

In the following steps, you'll deploy a release build for the My Lucky Seven application locally and
create an application icon for the program on the Windows Start page.
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Deploy a release build for the Lucky Seven app

1.

Click the Solution Configurations drop-down list box on the Standard toolbar, and then click
the Release option. Visual Studio will prepare your project for a release build, with the debug-
ging information removed. The build output path is set to bin\Release\.

On the Build menu, click the Deploy Lucky Seven command.
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The Build command creates a bin\Release folder in which to store your project (if the folder
doesn't already exist) and compiles the source code in your project. The Output window
appears to show you milestones in the assembly and deployment process. The result is an
executable file named Lucky Seven.exe, which Visual Studio registers with the operating sys-
tem on your computer.

Visual Studio deploys the application locally because Local Machine is currently selected on
the toolbar next to the Start button. This is the desired behavior here, but you can also deploy
applications on a remote machine (that is, a computer attached to yours via a network or the
Internet) by selecting the Remote Machine option. If you select this option, you'll be presented
with a dialog box asking for more information about the remote connection. Remember that
remote deploying is mostly designed for testing purposes. The best way to install completed
applications via the Internet is through the Windows Store.

When you deploy an application built for the Windows 8.1 user interface, Windows automati-
cally creates a new program icon for the application on the Start page. You can use this icon
to launch the program whenever you want to run it. Try running My Lucky Seven now from
the Start page on your computer.

Open the Windows Start page, and browse to the list of applications that are currently
installed.

There are two possible locations for your new app: the main Start page, or the secondary Start
page containing a longer list of app tiles. (This is where my Windows 8.1 system put the new
Lucky Seven program.)
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Because you didn't create a colorful Start page tile for your app, the default (gray) tile is
shown. Your screen will look similar to this (note the Lucky Seven app in the second column):
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5. Click the Lucky Seven application icon, and the Lucky Seven program will load and run in
Windows.

6. Test the application again, clicking Spin several times and building up a few wins. When you
are finished, close the app.

7. Return to Visual Studio, and close the Output window and the Lucky Seven properties page.
Note that you can view and change compilation options whenever you want—the properties
page is always available.

8. On the File menu, click Exit to close Visual Studio and the My Lucky Seven project.
9. Click Save if you are prompted to, and the Visual Studio IDE will close.

Congratulations on completing your first Windows Store app!
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This chapter described how to create a Windows Store app named Lucky Seven by using Visual Studio
2013. The development process has much in common with earlier versions of Visual Basic and Visual
Studio. You add Toolbox controls to a page, set properties, write program code, test the application,
and prepare it for deployment. However, the XAML Toolbox for Windows Store apps is significantly
different than the Toolbox used to create Windows Forms apps for the Windows desktop. In this
chapter, we reviewed how to use XAML controls step by step. In the next chapter, you'll review how
to use the Windows Forms Toolbox to create a desktop application for Windows 8.1, Windows 8, or
Windows 7.

While creating the Lucky Seven slot machine game, you practiced using the TextBlock control, the
Button control, the Image control, the MediaElement control, and setting the Grid control's back-
ground color. You also learned how to create a splash screen with the Visual Studio Image Editor.
Finally, you tested and deployed your application to the Windows Start page. With a little more work,
you'll also be able to deploy applications like Lucky Seven to the Windows Store.
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Windows desktop apps:
A walkthrough using
Windows Forms

After completing this chapter, you will be able to
m  Create a Windows desktop app using Windows Forms.
m  Build a user interface using the Windows Forms Designer.
m  Use controls in the Windows Forms Toolbox.
= Write Visual Basic code for event handlers.
®m  Run, test, and deploy a Windows desktop app.

hapter 3, “Creating your first Windows Store application,” offered step-by-step instructions for

building a Windows Store app using Visual Basic and the Visual Studio 2013 IDE. Windows Store
apps represent a major new business opportunity for software developers, and as the platform grows,
you will be well positioned to benefit from the improved functionality of Windows as well as the
impressive reach of the Windows Store’s global distribution system.

However, there are additional factors to consider as you choose development platforms for your
Visual Basic applications. For example, you might work in an organization that continues to support
earlier versions of Windows while also transitioning into Windows Store app development. Or you
might work in a shop that has significant source code investments in earlier versions of Visual Basic,
such as user interfaces designed for Windows Forms or Windows Presentation Foundation (WPF).
That is, although the Windows Store might represent the future of application programming, current
software platforms and technologies are equally important. This chapter introduces the support for
earlier versions of Windows and Visual Basic that is built into Visual Studio 2013.

First, you'll learn how to create Windows desktop apps for Windows 8.1, Windows 8, and Windows 7
using an efficient Visual Studio technology known as Windows Forms. The term "Windows desktop
app” is simply a new term for what Windows programmers have long described as “Windows-based
applications"—that is, fully functional programs that run in a frame on the Windows desktop and
that contain title bars, menus, dialog boxes, buttons, and other controls. In this chapter, you'll revisit
the Lucky Seven slot machine that you built in Chapter 3, but this time you'll build the project as a
Windows desktop app in Visual Studio 2013.
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You'll construct the user interface for the slot machine game using controls in the Windows Forms
Toolbox, and you'll build the application window or form by using the Windows Forms designer in the
IDE. Next, you'll customize the form and its controls by using property settings, and you'll generate
the random numbers and special effects by adding Visual Basic code to two event handlers. You'll
also play music using the My.Computer.Audio object in the .NET Framework. As you create this appli-
cation, I'll point out the similarities and differences between Windows desktop apps and Windows
Store apps and how to switch back and forth between the two platforms as you need to. In Part Il
“Designing the user interface,” you'll see plenty of coding examples for both platforms.

This chapter will be especially helpful to programmers who have had previous experience with
Visual Basic. Fundamentally, you'll learn that you can quickly translate your existing development skills
to the Visual Studio 2013 IDE. If you have been using Windows Forms, you'll see that you can main-
tain your existing programs rather easily, while benefiting from the new improvements to the Visual
Studio 2013 product. And throughout the book, you'll learn what is new and improved about the
Visual Basic language.

Inside Windows desktop apps
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What is a Windows desktop app, actually? As noted in the preceding section, a Windows desktop app
is essentially a Windows application designed to run under Windows 8.1, Windows 8, or Windows 7.
These "traditional” apps present their features using chrome, or visible and persistent user interface
elements, including a title bar, menu bar, toolbars, menu commands, buttons, dialog boxes, scroll
bars, status bars, and other user interface elements. Although the design guidelines for Windows
Store apps require developers to minimize or eliminate many of these traditional user interface ele-
ments (screen space is at a premium in tablets and mobile devices), Microsoft recognizes that thou-
sands of popular Windows-based apps use these features and that customers want to run these apps
now and in the future.

Windows desktop apps are also structured in different ways than Windows Store apps; they use
different controls and components, make use of different features in the Windows Runtime, and
have different installation and security requirements. To integrate Windows desktop apps into the
Windows 8.1 operating system, Windows 8.1 provides a separate operating environment for the
programs to run in and a distinctive Desktop tile on the Windows Start page to open the environment
and allow for easy interaction between Windows 8.1 and the Windows desktop.

The following illustration shows the Windows version 8.1 Start page with the Desktop tile visible
near the upper-left corner of the screen. (The Desktop tile contains the image of clouds and a moun-
tain top.) Windows desktop apps run in this environment under Windows 8.1, Windows 8, or on the
traditional Windows desktop in Windows 7.
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Visual Basic and Windows desktop apps

Within Visual Studio 2013 Professional, Premium, and Ultimate, the Windows Forms project type
provides a proven model upon which to build Windows desktop apps. Because this program type is
essentially the original user interface model for Visual Basic applications, the Visual Studio IDE is well-
suited to creating Windows Forms apps and offers a Windows Forms Designer and Windows Forms
Toolbox that are mature, feature-rich, and easy to use.

From a technical point of view, Windows Forms is the smart-client component of the .NET
Framework, a set of managed libraries that enable common application tasks such as reading
and writing to the file system. In Visual Studio, a Windows Forms app is built on classes from the
System.Windows.Forms namespace.

When you create a Windows desktop app with Windows Forms technology, you are using controls,
objects, properties, and events that have been available since Visual Studio 2005 and earlier. However,
because you are using the most recent version of Visual Studio, you receive the feature updates and
improvements related to Windows 8.1, the .NET Framework version 4.5.1, and the extended Visual
Basic programming language, which continues to evolve with each new version. As a result, you can
use your existing Windows Forms programming skills to create or maintain a Windows desktop app
in Visual Studio 2013, and as you support your code and add new features, you'll receive additional
benefits simply by using newer technology.
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You can also use Windows Presentation Foundation (WPF) for the user interface and features of
your Windows desktop app in Visual Studio 2013. This mature technology (first introduced in Visual
Studio 2008) allows you to create the user interface for your program by using XAML markup and
efficient WPF controls. However, because using Visual Basic and WPF is similar to creating Windows
Store apps with Visual Basic 2013 (especially in relation to using XAML and WPF-style controls), | will
be emphasizing Windows Store app development in this book and, as an alternative, Windows Forms
app development for the Windows desktop.

Note To create a Windows desktop app in this chapter, you'll need Visual Studio 2013
Professional, Premium, or Ultimate, which includes templates for Windows desktop apps.
The Microsoft Visual Studio Express 2013 for Windows application does not include
support for Windows desktop apps. However, if you don't have Visual Studio 2013
Professional or Ultimate, you can download the Microsoft Visual Studio Express 2013

for Windows Desktop application for free via the Microsoft Visual Studio website
(http://www.microsoft.com/visualstudio/). Use it to complete the exercises in this chapter
and elsewhere when Windows Forms programming is discussed.

In the following sections, you'll create the Lucky Seven Windows desktop app shown in the follow-
ing illustration. Although the user interface looks somewhat different in this version of the program
than it did under Windows 8.1, the Visual Basic program code that drives each application is very
similar. This correspondence is a fundamental emphasis of this chapter—although user interface
technologies vary from platform to platform, the underlying application logic often looks very similar
because it draws on the same Visual Basic language structures and vocabulary.
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Creating a Windows desktop app

In this exercise, you'll start building Lucky Seven by first creating a new Windows desktop app project
and then using controls in the Windows Forms Toolbox to construct the user interface.
Create a new project

1. Start Visual Studio 2013.

2. On the Visual Studio File menu, click New Project.

@ Tip You can also start a new programming project by clicking the blue New Project
link on the Start page.

The New Project dialog box opens, with project templates listed by category on the left side
of the dialog box. As discussed in Chapter 3, the Visual Basic templates are listed by type,
along with the templates for other languages, such as Visual C#, Visual C++, and JavaScript.
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3.

PART I

Near the top of the New Project dialog box, you'll also notice a drop-down list box. This
feature allows you to specify the version of the Microsoft .NET Framework that your applica-
tion will target. This feature is sometimes called multitargeting, meaning that through it you
can select the target environment that your program will run on. For example, if you retain
the default selection of .NET Framework 4.5.1, any computer that your application will run on
must have .NET Framework 4.5.1 installed. (It would typically be a computer running Windows
8.1)) Unless you have a specific need, you can usually leave this setting the way it is. However,
if you want to support earlier versions of Windows (and therefore an earlier version of the
Framework), you can specify a different version.

Note Visual Studio Express 2013 for Windows Desktop does not include the multitar-
geting list box, and the product offers a smaller selection of available templates. But
you'll be just fine completing the steps in this chapter.
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Click here to go online and find templates.
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4.

Click the Windows Forms Application item in the central Templates area of the dialog box, if it
is not already selected.

Visual Studio prepares the development environment for your Visual Basic Windows desktop
app.

In the Name text box, type MyLuckySevenWF.

Visual Studio assigns the name MyLuckySevenWF to your project. (You'll specify a folder loca-
tion for the project later.) As noted in Chapter 3, I'm recommending the "My" prefix here so

that you don't confuse your new application with the LuckySevenWF project I've created for
you on disk.

I've added the "WF" suffix to the project name to indicate "Windows Forms” for clarity.
(However, Windows Forms apps don't need any special naming scheme.)

Click OK to create the new project in Visual Studio.

Visual Studio cleans the slate for a new programming project and displays a blank Windows
form in the Designer that you can use to build your user interface.

Now you'll enlarge the form and create two buttons in the interface.

Create the user interface

1.

Point to the lower-right corner of the form in the Designer until the mouse pointer changes to
a resizing pointer, and then drag to increase the size of the form to make room for the objects
in your program.

As you resize the form, scroll bars might appear in the Designer to give you access to the
entire form you're creating. Depending on your screen resolution and the Visual Studio tools
you have open, you might not be able to see the entire form at once.

Size your form so that it is about the size of the form shown in the following illustration. If you
want to match my example exactly, you can use the width and height dimensions (560 pixels x
375 pixels) shown in the lower-right corner of the screen.

To see the entire form without obstruction, you can resize or close the other programming
tools, as you learned in Chapter 2, “The Visual Studio Integrated Development Environment.”
(Return to Chapter 2 if you have questions about resizing windows or tools.)
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Now you'll add a button object to the form.

Click the Toolbox tab to display the Windows Forms Toolbox window in the IDE.

This Toolbox contains different controls than the ones that you used in Chapter 3. Rather

than controls for Windows Store apps, this Toolbox contains controls for Windows Forms
apps. Not only are the items named differently, they have different underlying properties and
events. The Windows Forms controls are organized by category, and there are several controls
visible—a testament to how long this style of programming has been around.

In the All Windows Forms category, double-click the Button control in the Toolbox, and then
move the mouse pointer away from the Toolbox.

Visual Studio creates a default-sized button object on the form and hides the Toolbox, as
shown here:
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The button is named Buttonl because it is the first button in the program. The new button

is selected and enclosed by resize handles. When Visual Basic is in design mode (that is, when
you are creating a program and not executing it), you can move objects on the form by drag-
ging them with the mouse, and you can resize them by using the resize handles. However,
while a program is running, the user can't move user interface elements unless you've
changed a property in the program to allow this.

Using the Properties window, change the Name property of the button object to SpinButton.

The Name property is listed near the top of the Properties window. Giving each object a name
in your user interface will make the objects more recognizable in program code. As noted in
Chapter 3, | recommend including the name of the control in the object name if you have the
space for it.

Now you'll add a second button to the form, below the first button.

Add a second button

Click the Toolbox tab to display the Toolbox.

Click the Button control in the Toolbox (single-click this time), and then move the mouse
pointer over the form.

The mouse pointer changes to crosshairs and a button icon. The crosshairs are designed to
help you draw the rectangular shape of the button on the form, and you can use this method
as an alternative to double-clicking to create a control of the default size.

Click and drag the pointer down and to the right. Release the mouse button to complete the
button.

Resize the button object so that it is the same size as the first button.
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5. Move the two buttons down and to the right a little so that they are not right on the edge of
the form. (Use the snapline feature to help you.)

6. Use the Properties window to change the Name property of the button to EndButton.

Q Tip At any time, you can delete an object and start over again by selecting the object on
the form and then pressing Delete. Feel free to create and delete objects to practice creat-

ing your user interface.

Now you'll add the labels used to display the random numbers in the program. A label is a special
user interface element in a Windows Forms app designed to display text, numbers, or symbols when
the program runs. When the user clicks the Lucky Seven program’s Spin button, three random num-
bers appear in the label boxes. If one of the numbers is a 7, the user wins.

Add the number labels

1. Double-click the Label control in the Toolbox.

Visual Studio creates a label object on the form. The label object is just large enough to hold
the text contained in the object (it is rather small now), but it can be resized.

2. Drag the Labell object to the right of the two button objects.

Your form looks something like this (note also the position of the two buttons):

g Form1 El@

Button

Eutton

3. Double-click the Label control in the Toolbox to create a second label object.
This label object will be named Label2 in the program.

4. Double-click the Label control again to create a third label object.
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Move the second and third label objects to the right of the first one on the form.

Allow plenty of space between the three labels because you will use them to display large
numbers when the program runs.

Now you'll use the Label control to add a descriptive label to your form. This will be the fourth
and final label in the program.

Double-click the Label control in the Toolbox.
Drag the Label4 object below the two command buttons.

When you've finished, your four labels should look like those in the following screen shot. (You
can move your label objects if they don't look quite right.)

adl Form1 El@

Button] Label Label2 Label2

Eutton

Now you'll add a picture box to the form to graphically display the payout you'll receive when you
draw a 7 and hit the jackpot. A picture box is designed to display bitmaps, icons, digital photos, and
other artwork in a Windows Forms program. One of the best uses for a picture box is to display a
JPEG image file. You'll use the same image that you used in Chapter 3—a photo of coins from around
the world on a dark background.

Add a picture

1.

Click the PictureBox control in the Toolbox.

The PictureBox control has been a part of the Windows Forms Toolbox since Visual Basic ver-
sion 1. However, recall that when you created the Windows Store app in Chapter 3, you used
the Image control to display the photo on the page. As you switch back and forth between
the two toolboxes, keep in mind that you'll be using different controls and that these controls
contain different property settings and respond to different events.
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With the PictureBox control selected, use the pointer to create a large rectangular box below
the second and third labels on the form.

Leave a little space below the labels for their size to grow. When you've finished, your picture
box object looks similar to this:

s Form1 El @
Buttan] Label Labelz Label3
Euttani
[t ]
Labeld
o u)

Currently, the object is named PictureBox1 in your program. (You'll change it to CoinImage
later.)

Now you'll add the Coins.jpg photo to the project by creating a Resources folder.

Add a photo to the Resources folder

1.

If Solution Explorer is not visible now, open it by clicking Solution Explorer on the View menu.

As you've already learned, Solution Explorer provides access to most of the files in your proj-
ect. In Chapter 3, you practiced using the Assets folder in a Windows Store project to custom-
ize your project’s logo, splash screen, and other files. However, the Assets folder is something
unique to Windows Store apps; it is not supplied by default in a Windows desktop app.
Instead, you can create a Resources folder in Solution Explorer, which lets you access impor-
tant files and store them with the project.

The easiest way to create a Resources folder now is to use the smart tag provided by the pic-
ture box object.

Select the picture box object on the form if it is not selected already.

If you look carefully at the picture box’s border now, you'll notice a tiny shortcut arrow called
a smart tag near its upper-right corner. A smart tag is a context-sensitive button that you can
use to quickly change common settings.
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Click the smart tag in the picture box object to display the shortcut menu of commands.
Click Choose Image to display the Select Resource dialog box.

Click Project Resource File, and then click the Import button to create a new Resources folder
and place a file in the folder.

Double-click Coins.jpg in the My Documents\Visual Basic 2013 SBS\Chapter 04 folder.

Visual Studio inserts the file, and it appears in the Select Resource dialog box, as shown in the
following illustration:

Resaurce context

() Local resource:
Impart Clear
(®) Project resource file:

My Project\Resources.resx v

{none)

After an image or file has been added to a project, it becomes part of the application that you
are working on, and it can be referenced via the Solution Explorer and Properties window. It is
also gathered in as part of the application when the final project is compiled for distribution—
obviating the need to track the file or recall where the file was originally located on your hard

disk.

Click OK.
In Solution Explorer a Resources folder now appears with the file Coins.jpg in it.
In the Picture Box Tasks menu, click Stretch Image in the Size Mode list box.

A photo of coins from around the world fills the picture box object in the Designer.
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9. Adjust the spacing of the image so that it takes up much of the right side of the form in the
Designer.

Your screen should look like this (notice especially the Resources folder in Solution Explorer).

B LuckySevenWF - Microsoft Visual Studio © Y QuickLaunch (Cirl+0) L= 8 x
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Backgroundimage [ (none)
Backgroundimagel: Tile -
{Hame)

Indicates the name used in code ta identify the
abject,

1184, 105

Now you'll add a sound file to the Resources folder so that it can be played when the user wins the
game. This time, you'll add the resource by using the Visual Studio Project Properties Designer.

Add a .wav file to the Resources folder

1. Click the LuckySevenWF Properties command on the Project menu.
The Project Properties Designer appears in the IDE with project settings for twelve categories.
2. Click the Resources category.

The Coins.jpg file appears in the Designer. In the upper-left corner of the Designer is a drop-
down list box containing six resource categories, and currently Images is specified. Rather than
list all of the project resources together, the six categories give you a chance to organize your
project assets.

3. Click the Audio category in the drop-down list box.

The list is currently empty. Now you'll add the ArcadeRiff.wav file to the project. This is the same
electronic music file that you used in Chapter 3 to play an electronic arcade sound effect.
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Click the drop-down arrow next to the Add Resource command, and then click Add Existing
File.

Browse to the My Documents\Visual Basic 2013 SBS\Chapter 04 folder, click the ArcadeRiff.wav
file, and then click Open.

The ArcadeRiff.wav file appears in the Resources window and is now ready for use in the pro-
gram. You'll reference this resource later when you write your event handler code.

Click the Save All button on the Standard toolbar.
Specify My Documents\Visual Basic 2013 SBS\Chapter 04 for the location, and then click Save.

Click Yes To All if you are prompted to save or reload the project after the inclusion of the new
resources.

Close the Project Properties Designer.

Now you're ready to further customize the program'’s user interface by setting some more
properties.

Setting properties

As you reviewed in Chapters 2 and 3, you can change an object’s properties by selecting the object
on the page (or the form) and then setting properties in the Properties window. You'll do this now in
your Windows desktop app by changing settings for the two buttons on the form.

Set the button properties

1.

Click the first button (SpinButton) on the form.
The button is selected and is surrounded by resize handles.
At the top of the Properties window, click the Categorized button.

Resize the Properties window (if necessary) so that there is plenty of room to see the property
names and their current settings.

These properties include settings for the background color, text, font height, and width of the
button. Your Properties window should look something like this:
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Text
The text associated with the cantrol.

If it is not already visible, scroll in the Properties window until you see the Text property
located in the Appearance category.

Double-click the Text property in the first column of the Properties window.
The current Text setting (“Buttonl”) is highlighted in the Properties window.
Type Spin, and then press Enter.

The Text property changes to "Spin” in the Properties window and on the button on the form.
Now you'll change the Text property of the second button to “End.”

Open the Object list at the top of the Properties window.
A list of the interface objects in your program appears in a drop-down list box.
Click EndButton (the second button) in the list box.

The property settings for the second button appear in the Properties window, and Visual
Studio highlights the button on the form.

Delete the contents of the Text property, type End, and press Enter.

The text of the second button changes to "End.”

Tip Using the Object list is a handy way to switch between objects in your program. You
can also switch between objects on the form by clicking each object.

Now you'll set the properties for the labels in the program. The first three labels will hold the ran-

dom numbers generated by the program and will have identical property settings. (You'll set most of
them as a group.) The descriptive label settings will be slightly different.
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Set the number label properties

1.

Click the first number label (Labell), hold down the Shift key, click the second and third num-
ber labels, and then release the Shift key. (If the Properties window is in the way, move it to a
new place.)

A selection rectangle and resize handles appear around each label you click. You'll change

the TextAlign, BorderStyle, and Font properties now so that the numbers that will appear in
the labels will be centered, boxed, and identical in font and font size. (All these properties are
located in the Appearance category of the Properties window.) You'll also set the AutoSize
property to False so that you can change the size of the labels according to your precise speci-
fications. (The AutoSize property is located in the Layout category.)

Note When more than one object is selected, only those properties that can be
changed for the group are displayed in the Properties window.

Click the AutoSize property in the Properties window, and then click the arrow that appears in
the second column.

Set the AutoSize property to False so that you can size the labels manually.
Click the TextAlign property, and then click the arrow that appears in the second column.

A graphical assortment of alignment options appears in the list box; you can use these set-
tings to align text anywhere within the borders of the label object.

Click the center option (MiddleCenter).

The TextAlign property for each of the selected labels changes to MiddleCenter.

Click the BorderStyle property, and then click the arrow that appears in the second column.
The valid property settings (None, FixedSingle, and Fixed3D) appear in the list box.

Click FixedSingle in the list box to add a thin border around each label.

Click the Font property, and then click the ellipsis button (the button with three dots that’s
located next to the current font setting).

The Font dialog box opens.

Change the font to Segue Ul, the font style to SemiBold, and the font size to 24, and then click
OK.

The label text appears in the font, style, and size you specified.

Now you'll set the text for the three labels to the number 0—a good “placeholder” for the
numbers that will eventually fill these boxes in your game. (Because the program produces
the actual numbers, you could also delete the text, but putting a placeholder here gives you
something to base the size of the labels on.)
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10.

11.

12.

13.

14.

Click a blank area on the form to remove the selection from the three labels, and then click
the first label.

Double-click the Text property, type 0, and then press Enter.

The text of the Labell object is set to 0. You'll use program code to set this property to a ran-
dom “slot machine” number later in this chapter.

Change the text in the second and third labels on the form to 0 also.
Resize the three labels so that you can see the number 0 in each label.
Move and adjust the final spacing among the labels so that they look proportional.

Your form should now look something like this:

agl Form 1

Spin

End

Label4

Now you'll change the Text, Font, and ForeColor properties of the fourth label.

Set the descriptive label properties

Click the fourth label object (Label4) on the form.
Change the Text property in the Properties window to Lucky Seven.
Click the Font property, and then click the ellipsis button.

Use the Font dialog box to change the font to Segoe Ul, the font style to SemiBold, and the
font size to 18. Then click OK.

The font in the Label4 object is updated, and the label is resized automatically to hold the
larger font size because the object's AutoSize property is set to True.

Click the ForeColor property in the Properties window.
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6. Type DarkRed in the ForeColor property, and then press Enter.

Visual Studio changes the color of the Lucky Seven label (Label4) to DarkRed (139,0,0), which
is the same color you used in the Lucky Seven Windows Store app in Chapter 3.

Now you'll change the Text property for the form so that “Lucky Seven” appears on the app’s title
bar.

Set the form'’s title bar text

1. Click the form in the Designer (not any specific object on the form).
2. Inthe Properties window, change the Text property to Lucky Seven and press Enter.

Your form now looks like this:

o Lucky Seven El@

Spin

0 0 0

End

Lucky Seven

ul

Now you're ready to set the properties for PictureBox1, the last object on the form.

The picture box properties

When the person playing your game hits the jackpot (that is, when at least one 7 appears in the
number labels on the form), the picture box object will display an image (in jpg format) of coins from
around the world. | have supplied you with this digitized image in the book's sample files, but you can
substitute your own image if you like.

Earlier in this chapter, you set the SizeMode property of the PictureBox1 object to accurately posi-
tion the picture in the frame, and you set the Image property to indicate the name of the JPEG file
that you are displaying on the form. Now you need to set the Visible property, which specifies the pic-
ture state when the app starts running. (You don't always need to make objects visible on the form; as

this app runs, you will toggle the image between visible and invisible settings, based on the numbers
displayed.)
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Set the Visible picture box property

1. Click the picture box object on the form.

2. Click the Visible property in the Behavior category of the Properties window, and then click
the arrow in the second column.

The valid settings for the Visible property appear in a list box.
3. Click False to make the coins image invisible when the program starts.

Setting the Visible property to False affects the picture box when the program runs but not
now, while you're designing it.

Tip You can also double-click property names that have True and False settings (so-called
Boolean properties), to toggle back and forth between True and False. Default Boolean
properties are shown in regular type, and changed settings appear in bold.

Naming objects for clarity

Earlier in this chapter, you named the button objects on the form as a good programming practice.

I recommend that you name all of the objects that you will be using in program code to avoid any
confusion. You can name objects by setting the Name property for each object with the Properties
window. In the following exercise, you'll add a few more object names for the labels containing lucky
numbers. You'll also name the picture box object that contains the Coins photo.

Set the Name property

1. Click the Labell object on the form (the first lucky number window), and then change the
object’'s Name property to FirstNum.

You might want to list the property settings alphabetically so that the Name property appears
near the top of the list.

2. Click the Label2 object on the form (the second lucky number window), and then change the
object’'s Name property to SecondNum.

3. Click the Label3 object on the form, and then change the object’s Name property to
ThirdNum.

4. Click the PictureBox1 object on the form, and then change the picture box's Name property to
Coinlmage.

5. You are finished setting properties for now, so if your Properties window is floating, hold
down the Ctrl key and double-click its title bar to return it to the docked position.
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Writing the code

Now you're ready to write the code for the Lucky Seven Windows desktop app. As you learned in
Chapter 3, you enter and edit Visual Basic code by using the Code Editor. Although the controls used
to create the user interface for this Windows Form app are different than the ones you used to create
a Windows Store app, the program code is much the same. This is because the underlying Visual Basic
programming language is identical between the two platforms. The only differences you'll encounter
will be the names of objects and properties and, occasionally, the classes that you use in the .NET
Framework. The core Visual Basic language elements are essentially the same.

Complete the following steps to enter the Lucky Seven Windows desktop app code using the Code
Editor.
Use the Code Editor

1. Double-click the End button on the form.

The Code Editor appears as a tabbed document window in the center of the Visual Studio IDE,
as shown here:
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Inside the Code Editor are program statements associated with the current form. Program

statements in a Windows Forms app are always grouped in one or more procedures. There
are three types of procedures that you'll see in Visual Basic code: Sub procedures, Function
procedures, and Property procedures.

EndButton_Click is a Sub procedure that is being declared to handle the event that occurs
when the user clicks the End button in the program. This Sub procedure begins with the Sub
keyword and concludes with the End Sub keywords.

In the Windows Forms paradigm, such a procedure is also called an event handler. This par-
ticular handler is executed when the Click event takes place (or fires), but no value is returned
to the calling routine by the procedure. (Function and Property procedures often do return
values, as you'll see later in the book.)
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When you double-clicked the End button in the IDE, Visual Studio automatically added the
first and last lines of the EndButton_Click event handler and associated those lines with the
button’s Click event, as the following code shows. You might notice other bits of code in the
Code Editor (words like Public and Class), which Visual Studio has added to define important
characteristics of the form. | will describe them more fully later.

Private Sub EndButton_Click(sender As Object, e As EventArgs) Handles Button2.Click

End Sub

The body of a procedure fits between the preceding lines and is executed whenever a user
triggers the action associated with the event handler. In this case, the event is a mouse click,
but it could also be a different type of event.

Type End, and then press the Enter key.

Visual Studio recognizes End as a unique reserved word or keyword and displays it in a list
box with Common and All tabs. Microsoft calls this interactive assistance feature IntelliSense
because it tries to intelligently help you write code, and you can browse through various
Visual Basic keywords and objects alphabetically. (In this way, the language is partially discov-
erable through the IDE itself)

After you press the Enter key, the letters in End turn blue and are indented, indicating that
Visual Basic recognizes End as one of several hundred unique keywords within the Visual Basic
language. You use the End keyword to stop your program and remove it from the screen. In this
case, End is also a complete program statement, a self-contained instruction recognized by the
Visual Basic compiler, the part of Visual Studio that processes, or parses, each line of Visual Basic
source code, combining the result with other resources to create an executable file.

Now that you've written the code associated with the End button, you'll write code for the Spin
button. These program statements will be a little more extensive.

Write code for the Spin button

1.

Click the Form1.vb [Design] tab near the top of the Code Editor to display the form again.

When the Code Editor is visible, you won't be able to see the form you're working on.
However, it is easy to switch back and forth between the Windows Forms designer and the
Code Editor by clicking the tabs near the top of each window.

Double-click the Spin button on the form.
The Code Editor appears, and an event handler associated with the Spin button appears.

Although you changed the text of this button to “Spin,” recall that its name in the program
is SpinButton. The SpinButton_Click event handler executes each time that the user clicks the
Spin button.
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3. Type the following program lines between the Private Sub and End Sub statements. Press
Enter after each line, and press Tab to indent. As you enter the program code, the IDE formats
the text and displays different parts of the program in color to help you identify the various

elements.

Dim generator As New Random
CoinImage.Visible = False

FirstNum.Text = generator.Next(0, 9)
SecondNum.Text = generator.Next(0, 9)
ThirdNum.Text = generator.Next(0, 9)

If (FirstNum.Text = “7”) Or (SecondNum.Text =
(ThirdNum.Text = “7”) Then
CoinImage.Visible = True

“77) or

My .Computer.Audio.Play(My.Resources.ArcadeRiff, AudioPlayMode.Background)

End If

When you've finished, the Code Editor looks as shown in the following screen shot:
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= Private Sub SpinButton Click(sender As Object, e As EventArgs) Handles SpinButton.Click

Dim generator As New Random
CoinImage.visible = False

Firstum.Text = generator.Next(d, 9)
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4. Click the Save All command on the File menu to save your additions to the program.

Behind the scenes in the SpinButton_Click event handler

The SpinButton_Click event handler is executed when the user clicks the Spin button on the form. The
Handles keyword in the first line of the Sub procedure is the statement that links the button on the

form to the event handler.
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The work this routine does is very similar to the Visual Basic code you used in Chapter 3 to drive
the Lucky Seven game designed for the Windows Store. Essentially, the event handler performs four
main tasks:

1. It declares a random number generator named Random in the program.

2. It hides the digital photo of coins.

3. It creates three random numbers and displays them in text block objects.

4. |t displays the Coins photo and plays music when the number 7 appears.

As you've learned, the random number generator is initialized by the following statement:
Dim generator As New Random

This line declares a random number generator that can be used to calculate single digits that fol-
low no particular numeric pattern. The generator identifier is used later in the procedure.

Hiding the photo is accomplished by the following line:
CoinImage.Visible = False

Although the photo is not visible when the program starts (you changed the image's Visible prop-
erty in an earlier exercise to accomplish this), this line of code handles the situation when the user has
won the game and needs to have the image hidden again.

The next three lines handle the random number computations. The generator object in each line
is used to create a random number between 0 and 9—just what you need for this particular slot
machine application. These lines are identical to the code in Chapter 3.

FirstNum.Text = generator.Next(0, 9)
SecondNum.Text = generator.Next(0, 9)
ThirdNum.Text = generator.Next(0, 9)

The last group of statements in the program checks whether any of the random numbers is 7. If
one or more of them is, the program displays the graphical depiction of a payout and plays an elec-
tronic arcade sound to announce the winnings.

If (FirstNum.Text = "7") Or (SecondNum.Text = "7") Or

(ThirdNum.Text = "7") Then

CoinImage.Visible = True

My .Computer.Audio.Play(My.Resources.ArcadeRiff, AudioPlayMode.Background)
End If

The sound is created by the same .wav audio file that you used in Chapter 3. However,
because there is no MediaElement control in the Windows Forms Toolbox, I've played the sound
using the My.Computer.Audio object provided by the .NET Framework. This object offers the
Play method, which I've used to play a sound resource in the project’s Resources folder. The
AudioPlayMode.Background property used in the call to the Play method rings the sound in the back-
ground while the program does its work.
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Each time that the user clicks the Spin button, the SpinButton_Click event handler is executed, or
called, and the program statements in the procedure are run again.

Running the Lucky Seven desktop app

Perfect—you're ready to run your new Windows desktop app. As you learned in Chapter 2, you can
run an application by clicking the Start button on the Standard toolbar.

Follow these steps to run—and more importantly, test—the MyLuckySevenWF program.

Note If you didn't build the MyLuckySevenWF project from scratch or if you want to com-
pare what you created to what | built for you, take a moment now to open and run the
completed LuckySevenWF project, which is located in the My Documents\Visual Basic 2013
SBS\Chapter 04 folder on your hard disk (the default location for the practice files for this

chapter).

Run the LuckySevenWF program

1. Click the Start button on the Standard toolbar.

The Lucky Seven program compiles and runs. After a few seconds, the user interface appears,
just as you designed it.

2. Click the Spin button several times until you draw one or more 7s.

Each time that you click Spin, the program picks three random numbers and displays them in
labels on the form. When you win, your screen will look something like this:

Lucky Seven
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Because a 7 appears in the first label box, the digital photo depicting the payoff appears, and
the computer plays an arcade sound. You win!

Click the Spin button a dozen or more times, watching the results of the spins in the number
boxes.

This is the time to give the program some careful attention. Is the program working cor-
rectly? Does the sound effect work correctly every time? Does the coin image always go away
when you spin again? Do the numbers always look right—and does the spinning pattern look
random—in the spinner windows?

It seems like about half of the time that you spin, you will hit the jackpot. However, in math-
ematical terms, the odds are not actually that good. The actual probability of a win is about
2.8 times out of 10.

When you've finished experimenting with your new creation, click the End button.

The Windows desktop app stops, and the IDE reappears on your screen.

Building an executable file
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Your last task in this chapter is to complete the development process and create a final Windows
desktop app for your computer. Windows desktop apps created with Visual Studio 2013 have the file
name extension .exe and can be run on any system that contains Windows and the necessary support
files. One of the crucial system libraries that Visual Studio programs need is the .NET Framework.
However, this is present on virtually all Windows 8.1, Windows 8, and Windows 7 installations.

As you learned in Chapter 3, you can create two types of executable files for your project at
this point: a debug build or a release build. The Solution Configurations drop-down list box on the
Standard Visual Studio toolbar indicates whether the executable is a debug build or a release build.

Try creating a release build named LuckySevenWF.exe now.

Create an executable file

1.

On the Standard toolbar, click Release in the Solution Configurations drop-down list box.

This will prepare Visual Studio to create a release build of your Windows desktop app that
does not contain debugging information. The build will be stored in the Bin\Release folder for
your project.

On the Build menu, click the Build LuckySevenWF command. (Your project might have the
“My" prefix in front of the project name.)

The Build command compiles the source code in your project. The result is an executable file
of the Windows desktop app type named LuckySevenWF.exe.
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Now try running this program outside the Visual Studio IDE within the Windows desktop. (The
next command depends on the version of Windows you're using.)

3. If you have Windows 8 or Windows 8.1, click the Search charm, type run in the Search (apps)
text box, and Press Enter to open the Run dialog box.

If you have Windows 7 or Windows Vista, type run in the Search text box and press Enter to
open the Run dialog box.

4. Click Browse, and then navigate to the My Documents\Visual Basic 2013 SBS\Chapter 04\
MyLuckySevenWF\Bin\Release folder.

5. Click the MyLuckySevenWF.exe application icon, click Open, and then click OK.
The LuckySevenWF program loads and runs in the Windows desktop area.

Because this is a simple test application and it does not possess a formal publisher certificate
that emphasizes its reliability or authenticity, you might see the following message: “The pub-
lisher could not be verified. Are you sure you want to run this software?”

If this happens, click Yes to run the program anyway. (Creating such certificates is beyond
the scope of this chapter, but this program is quite safe—unless you spend a lot of time
gambling!)

6. Click Spin a few times to verify the operation of the game, and then click End.

Q Tip You can also run Windows-based applications, including compiled Visual Basic pro-
grams, by opening Windows Explorer and double-clicking the executable file.

Publishing a Windows desktop app

As you learned in Chapter 3, a Windows Store app is designed to be sold and distributed online via
the Windows Store. Although Windows desktop apps cannot currently be distributed in this manner,
it is simple to distribute or publish a Windows desktop app using ClickOnce Security and Deployment.
ClickOnce assembles your project files into a package that can be located on a web server, a file share,
the local computer (your PC or laptop), or removable media such as a CD-ROM or DVD-ROM.

Complete the following steps to publish a Windows desktop app. (Publish the MyLuckySevenWF
project now, or keep these steps handy for future reference.)

Publish with ClickOnce deployment

1. Click the ProjectName Properties command (LuckySevenWF or other) on the Project menu.

The Project Properties Designer opens, with its many tabs and options related to the applica-
tion and its features.
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2.

Click the Publish tab, where you'll see a list of deployment options like those shown on the
following screen:

B LuckySevenWF - Microsoft Visual Studio & Y QuickLaunch (Ctrl+0) Pl - & x
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g Application _ @& e-2a@m &
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& Campile Search Selution Explorer (Ctrl+;) P
3 Debug ublish Location o
T K My Project
8 References Publishing Folder Location (web site, ftp server, or file path): b o Resources

Resources publish\| 1 App.config

3 Form b

Services Installation Falder URL {if different than above):
Settings
Signing
1stall Made and Settings
My Extensions
() The application is available online anly Applicatic
Security
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Cade Analysis Updat | Selution Explorer | Team Explorer
T Properties i rax
ublish Version
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In the Publishing Folder Location text box, specify the name of a web server, file server, or
path name to a location on your local computer where you would like to place the setup
package that Visual Studio will create for you.

Note This is not the location for the final, installed application; it is the location for
the setup files that your user will use to install the new Windows desktop app. That
is, you are specifying here a location for users to get the setup package that they
need. (For this reason, a web server makes a lot of sense.)

Optionally, click the ellipses box next to the Publishing Folder Location text box if you want to
browse to the deployment location.

If you click this helpful tool, the Open Web Site dialog box appears, which lets you browse to
a folder in your computer’s file system, an Internet Information Services (lIS) location, an FTP
site, or another web location.

Alternatively, you can click the Publish Wizard button, and a wizard will step you through a
series of questions about what you want to deploy and where you want to deploy it.

When you're finished, click the Publish Now button at the bottom of the properties page.
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6. Visual Studio will copy a convenient setup package for the application to the location you
specified. The user can then install the application on their system.

@ Tip To learn more about security considerations and deploying Windows desktop
applications, click the Security tab on the Project Properties Designer. You can learn
about security issues and adjust security settings as appropriate for your application.

Congratulations! You've created a Windows desktop app from scratch by using Windows
Forms and Visual Basic. Save your changes now, and exit Visual Studio.

7. Click the Save All button on the Standard toolbar to save your changes.
8. Close the project properties page by clicking the X on the page’s tab.
9. On the File menu, click Exit to close Visual Studio and the LuckySevenWF project.

The Visual Studio development environment closes.

Summary

This chapter describes how to build a Windows desktop app named LuckySevenWF, using Visual
Basic and the Windows Forms programming model. The development process is similar to what you
accomplished in Chapter 3 with the Windows Store programming model, and the same program (a
lucky number arcade game) was deliberately chosen so that you could compare and contrast the two
methods of creating a Visual Basic 2013 application.

Windows Forms continues to be an important technology for writing Windows-based applications
with Visual Basic. There is a substantial code base in the marketplace that was created using Windows
Forms, and in addition to the practical necessities of maintaining this code, the Windows Forms
Designer and Toolbox are easy to use and mature in ways that the Windows Presentation Foundation
and Windows Store App tools currently are not.

In this chapter, you worked with the Button, Label, and PictureBox controls and customized them
on a form using original artwork and property settings. You learned how to write program code
in the Code Editor and how to publish an application using ClickOnce Security and Deployment.
In Chapter 6, “Working with Windows Forms controls,” you will learn more about Windows Forms
Toolbox controls and many essential features for Windows desktop apps, including menus and
toolbars.

The major limitation of Windows Forms is that its graphics routines are somewhat slower than
equivalent WPF and Windows Store apps, and Windows Forms does not fully support the redesigned
Windows 8 and Windows 8.1 operating systems. The advantage of these platforms consists in secu-
rity, reliability, broader support for touch-based devices, and, of course, a new user interface. We are
simply in an era of transition, and professional Visual Basic programmers will need to acquire skills
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worthy of the terrain we currently find ourselves in. This means learning more than one development
platform and finding creative ways to migrate code from model to model.

Fortunately, Visual Studio makes this dynamic interchange more than possible. In fact, as Chapter
3 and this chapter have demonstrated, you can build two user interfaces with different tools and still
maintain the same application logic in Visual Basic code. | will continue to emphasize this similarity
throughout the book, extending the Visual Basic language parallels to web-based (HTML) apps and
Windows Phone 8 apps.

In the next chapter, you'll return to Windows Store development and some of the essential controls
in the Windows Store Toolbox.
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Working with Windows Store app
controls

After completing this chapter, you will be able to

m  Use the TextBox control to manage text input tasks.

m  Use the FlipView control to display a series of images or photos.
m  Use the MediaElement control to play entertainment media.

m  Use the WebView control to display live web content.

ou create the user interface for your Windows Store app by using Toolbox controls such as Image,

ListBox, WebView, and DatePicker. In Chapter 3, “Creating your First Windows Store application,”
you learned the basics of using the Button, TextBlock, and Image controls, and you reviewed how to
adjust property settings and build event handlers. In this chapter, you'll learn to use four additional
Windows Store app controls. The process will deepen your understanding of the Windows 8.1 user
interface and help you establish a foundation for your own programs.

First, you'll learn how to use the TextBox control to gather lines and paragraphs of textual input
from the user, store them in variables, check spelling, and process the text in interesting ways. Next,
you'll use the FlipView control to display a collection of graphical images on the screen, which you
can easily navigate through by using touch input or mouse clicks. Because audio and video content
make Windows Store apps fun to use, you'll learn more about using the MediaElement control to play
entertainment media. Finally, you'll learn to use the WebView control to display content from one or
more webpages on the surface of your app.

@ Tip In addition to this chapter and the exercises in later chapters, you can learn
much more about essential Windows Store app controls in my companion book
Start Here! Learn Microsoft Visual Basic 2012 (Microsoft Press, 2012). For example, in that
book, in Chapter 3, "Using Controls,” | describe how to use the Ellipse, TextBlock, CheckBox,
and RadioButton controls. In Chapter 4, “Designing Windows 8 Applications with Blend for
Visual Studio,” | demonstrate how to use Blend to add controls to a page and customize
them with animation effects.
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Windows Store app controls are interactive elements that a developer can place on the surface of a
Windows 8.1 app to communicate with the user or manage essential tasks, such as displaying text
or images, launching a video, or browsing a website. Like other programmable controls, Windows
Store app controls typically have the ability to be selected or to receive the focus while a program is
running, and they are manipulated by the familiar input mechanisms of the Windows 8.1 operating
system, such as mouse, keyboard, stylus, touch, and gestures.

All Windows Store app controls come from the Windows.Ul.Xaml.Controls namespace, a hierar-
chical library of classes that provides a unique definition and list of programmable features for each
control. Many of the Windows Store app controls share common attributes and capabilities, and in
this way, they work together to enable the rich user experience that is at the heart of Windows 8.1.

When you create a new Windows Store app in Visual Studio 2013, the IDE automatically loads a
collection of Windows Store app controls (also called XAML controls) into the Toolbox, and organizes
them by category. When you use one of these controls to create an object in your application, you are
creating a specific instance of the control definition on the page within your program. Each instance
of the control is unique, so it maintains its own name, content, size, shape, event handlers, and other
defining characteristics.

For example, if you use the Button control in the Toolbox to create three button objects on
a page in your Windows Store app, each button object will have its own name, dimensions, and
programmable functionality. Although these buttons inherit their default characteristics from the
Windows.Ul.Xaml.Controls.Button class, you can customize each object individually in the program.
This is one of the core features and advantages of object-oriented programming with Visual Studio
and Visual Basic. Another useful feature is that you can share event handlers among controls.

Roots in Windows Presentation Foundation and XAML

Windows Store app controls have their roots in Windows Presentation Foundation (WPF) controls and
Extensible Application Markup Language (XAML), an XML-based language used to define and link
various elements in the user interface of a Windows-based application. WPF was added to the Visual
Studio 2008 product as an option for rendering user interfaces, and since 2008 it has supplied a pop-
ular alternative to the Windows Forms programming model. At that time, Microsoft also introduced a
rudimentary WPF Designer and a Toolbox with XAML controls into the Visual Studio IDE.

Although the original WPF Designer and Toolbox were somewhat limited, over time the Visual
Studio components related to WPF have improved. A number of Visual Basic programmers who have
wanted to add cutting-edge graphics, video, and animation features to their applications have used
WPF to prepare applications for the .NET platform. (In fact, WPF was especially designed to support
DirectX, a hardware-accelerated graphics API that is often used in cutting-edge computer games.)

Microsoft also used a subset of WPF to create Microsoft Silverlight, an application framework for
creating Internet applications that is similar in some ways to Adobe Flash. The Silverlight framework is
also associated with Windows Phone development, although in Windows Phone 8 the term Silverlight
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is no longer used. However, when you write Windows Phone applications, you still use an optimized
version of XAML controls for the Phone user interface. Windows Phone programming is covered more
fully in Chapter 20, “Introduction to Windows Phone 8 development,” and Chapter 21, “Creating your
first Windows Phone 8 application.”

Designing for Windows 8.1

When Microsoft planned the release of Windows 8, an ambitious new operating system designed

to operate on a very broad spectrum of devices, they chose to base user interface development on
XAML-style controls, including the controls used in WPF and Windows Phone applications. Accordingly,
many of the Windows Store app controls have the same names as WPF controls, and controls in the two
platforms also share many of the same properties and events. In addition, there are some controls (such
as ProgressRing) that support the unique features of the Windows 8 and Windows 8.1 user interface.

Windows Store app controls continue to support high-performance graphics cards and animation
features, and they also use XAML markup to build the user interface so that it can be customized for
different platforms and devices. In this way, Windows 8.1 and Visual Studio 2013 have carried forward
earlier technologies (WPF, Silverlight, and Windows Forms) and combined them in new ways to sup-
port advancements in user interface design, connectivity, and security. On the Windows 8.1 platform,
Visual Studio 2013 adds support for the CommandBar and Flyout controls in Windows Store apps,
which are discussed in Chapter 9, "Exploring Windows 8.1 design features: Command bar, flyout, tiles,
and touch.”

If you have previous experience using WPF or Silverlight controls, this chapter will show you how
some of the essential controls have changed. You'll also see how the features of Windows 8.1 have
been integrated into the controls and how they have been modified for applications that will be sold
in the Windows Store.

If you have previous experience with Windows Forms, many of these controls will be new to you,
but the essential software development techniques will not be that different from what you have
learned in the past. You'll still build your applications by adding Toolbox controls to a page, setting
essential properties, writing event handlers, and then compiling and testing your work.

Let’s begin with the TextBox control.

Using the TextBox control to receive input

The TextBox control makes it easy to gather basic, textual input from the user and to put it to work in
your Windows Store app. In addition, TextBox controls can be used to display information quickly on
a page, such as the results of a calculation or the content returned from a database query. Although
most TextBox controls are designed to be just one line long, you can also create multiline TextBox
controls following the same basic procedure and then use them to gather input or display a para-
graph or more of text.
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In the following exercises, you'll learn how to receive input using a TextBox control, assign the
information to a variable, create a multiline TextBox control, and check the spelling in a TextBox. Later
in this chapter, you'll learn how to transfer data from a TextBox control to a ListBox control.

Use a TextBox control for basic input

Start Visual Studio 2013.

On the Visual Studio File menu, click New Project.

The New Project dialog box opens.

In the Visual Basic template group, click Windows Store and then the Blank App (XAML) project.
Visual Studio prepares the IDE for a basic Windows Store app with no predefined layout.

In the Name text box, type My Text Input.

Visual Studio assigns the name My Text Input to your project. As noted in Chapter 3, I'm rec-
ommending the "My" prefix here so that you don't confuse your new application with the Text
Input project I've created for you in the book’s sample files.

Click OK to create the new project in Visual Studio.

Visual Studio opens a new programming project and displays the Visual Basic code associated
with the blank application template.

Open Solution Explorer in the IDE if it is not currently visible, and then double-click the file
MainPage.xaml.

Visual Studio opens MainPage.xaml in the Designer window.

If the Toolbox is not currently visible, click the Toolbox tab or click the Toolbox command on
the View menu.

This Toolbox contains Windows Store app (XAML) controls.

Click the TextBox control in the Toolbox, move the mouse pointer to the Designer window,
and then drag right and down to create a small, rectangular box on the page.

You'll find the TextBox control in both the Common XAML Controls and the All XAML Controls
categories. When you release the mouse button, Visual Studio creates a text box object on the
page.

In the XAML tab of the Code Editor, notice that XAML markup for the text box object now

appears, with several properties already assigned, based on the size and shape of the text box.
The Properties window also displays several of these properties.
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10.

11.

12.

13.

15. Change the Name property of the first text box to InputString, and delete contents of the

Click the TextBox control in the Toolbox again, and then create a second text box object below

the first one.

Resize the text box so that it is the same size and shape as the first one.

Now you'll create a button object on the form as well.

Click the Button control in the Toolbox, and then create a small button object below the two

text boxes.

Click the Zoom control in the Designer, and then select 100% zoom to see a bit more of the

application page.

Your IDE will now look something like this:
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14. Enlarge the Properties window so that you have plenty of room to make some adjustments to

the new objects’ properties.

object’s Text property.

16. Change the Name property of the second text box to Output, and delete contents of the

object’s Text property.
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17. Change the Name property of the button object to TestButton, and change the Content

property of the button to Click To Test.

Your screen should look like this:

Click to Test

Now you'll create an event handler for the button on the page.

18. Double-click the button object.

The TestButton_Click event handler opens in the Code Editor, and the insertion point blinks
between the Sub and End Sub statements.

19. Type the following line of program code:

Output.Text = InputString.Text.Length

This program statement examines the Text property of the first text box on the page
(InputString) and uses the Length property to determine how many characters have been
entered into the text box. It assigns this number to the second text box (Output). The point
of the demonstration program is simply to show how text boxes can be used to gather and
display textual information in a program.

The Length property is one of several methods and properties that can be used with textual
(or String) data. You'll learn more about the String data type in Chapter 11, "Mastering data
types, operators, and string processing.”

Now run the program to see how the sample project and its text boxes operate.

20. Click the Start Debugging button on the Standard toolbar.

The Text Input program runs, and the Windows Store app you created appears on the screen.
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21. Type You can do this! in the first text box, and then click the Click To Test button.

Visual Basic counts 16 characters in the user input you entered and then displays the following
results:

You can do this!

Click to Test

22. Notice that the Length property counted blank spaces and punctuation, as well as the letters
that you typed. Give it another try.

Q Tip Does the top line of your output screen contain debugging information? Recall
from Chapter 3 that you might see a few sets of numbers at the top of your screen

when your app runs in Debugging mode. These numbers summarize how long vari-
ous tasks take during the execution of your Visual Studio app, including the frame
rate for the user interface thread and how long it took to load the user interface.
These numbers will not appear in the Release build for your application, and you can
suppress them in Debugging mode by removing the code between the #/f DEBUG
and #End If statements in the App.xaml.vb file. To avoid distraction, | will not show
the debugging numbers in the screen shots in this book.

23. Remove You Can Do This! from the first text box, and then type Microsoft Visual Basic 2013
programming.

24. Click the Click To Test button.

25. Visual Basic counts all the characters that you typed and displays the number 39 in the second
text box. Your screen looks like this:
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Microsoft Visual Basic 2013 pregramming

You've demonstrated how to use the TextBox control to manage basic input and output tasks.
26. Experiment further if you like, and when you're finished, close the application.

27. Click the Save All command on the File menu to save your project, and specify the My
Documents\Visual Basic 2013 SBS\Chapter 05 folder.

Now you'll store the contents of a TextBox control in a string variable.

Assigning TextBox contents to a variable

A variable is a temporary store location for data in a program. As you probably already know, you can
use one or more variables in your code to store words, numbers, dates, and other values. I'll spend
much more time talking about the advanced uses of variables and operators in Chapter 11, but while
we are looking at the TextBox control, it is worth noting that you can assign the contents of the Text
property to a variable when you are using TextBox for input.

Traditionally, programmers will use the TextBox control's Text property to manage string input—
that is, textual information such as words, letters, symbols, and so on. You can also use implicit vari-
able declaration to create variables of other types as well. You'll be using the Dim keyword to declare
the variable in code, which reserves room in memory for the variable when the program runs. Give it
a try now.

Use a string variable to hold TextBox input

1. Open the TestButton_Click event handler in the Code Editor.

You'll modify the event handler for the button object so that it stores the data entered in the
first text box in a variable named SampleText. Then you'll use the ToUpper property to change
the letters in the text string to uppercase, and you'll display the contents of the variable in the
second text box.
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5.

6.

Replace the line Output.Text = InputString.Text.Length with the following code:
Dim sampleText As String

sampleText = InputString.Text

Output.Text = sampleText.ToUpper

Run the revised program.

In the first text box, type happy new year.

Your screen looks like this:

happy new yead

Click the Click To Test button.

Visual Basic changes the text from lowercase to uppercase. You'll see the following screen:

happy new year
HAPPY NEW YEAR

You've demonstrated one of the most fundamental tasks of processing user input—receiving
information in a TextBox control and assigning it to a variable. With a variable in memory, you
can perform any number of tasks with the information.
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7. When you're finished, close the application.
8. Click the Save All command on the File menu to save your changes.

Now you'll practice managing multiline input with a TextBox control.

Multiline TextBox controls

A multiline TextBox control is simply a TextBox control that has been sized so that it is capable of
displaying more than one line of information. You can also provide access to information beyond

the edges of your TextBox control if you enable vertical and horizontal scroll bars, which are con-
trolled by an instance of the ScrollViewer class that is exposed to container controls like TextBox. The
ScrollViewer class and properties such as VerticalScrollBarVisibility and HorizontalScrollBarVisibility are
easiest to set by adding XAML markup to the page.

When you're using a multiline TextBox control, a single variable of type String can also be used to
handle an entire paragraph of text. Give it a try in the following exercise.

Manage a paragraph of text with a TextBox control

1. Display the user interface for your Windows Store app (MainPage.xaml) in the Designer.
The text box object that you'll enlarge is the top one on the page.

2. Hold the mouse over the top border of the text box object until the pointer becomes a resiz-
ing tool.

3. Expand the text box object so that it is four or five lines high (but the same width).

Your screen should look like this:

Click to Test

Now you'll add a vertical scroll bar to the text box object by setting the VerticalScrollBarVisibility
property using XAML markup. As you learned in Chapter 2, “The Visual Studio Integrated
Development Environment,” and in Chapter 3, “Creating your first Windows Store application,”

120 Designing the user interface



the XAML tab of the Code Editor shows the XAML markup that is associated with each object
in the user interface as you create a page for your Windows Store application.

When you add a new control to a page, a new line of XAML is added to the Code Editor, and
you can edit this markup directly as an alternative to manipulating objects on the page or
setting properties in the Properties window. In this case, you'll edit the XAML markup for the
InputString text box directly.

In the XAML tab of the Code Editor, below the Designer, locate the XAML markup for the
InputString text box control. (The first text box on the page.)

After the markup x:Name="InputString”, enter the following property setting:
Scrol1Viewer.VerticalScrollBarVisibility="Visible”

Press the Spacebar after you finish typing, to create a blank space between the property set-
ting you just added and the HorizontalAlignment property setting on the same line.

You're using the VerticalScrollBarVisibility property of the ScrollViewer class to add a vertical
scroll bar to the text box object when the user moves the mouse pointer over the text box. Note
that the scroll bar will be visible only when the application is running and the user hovers the
mouse pointer over it. The Windows 8.1 design guidelines seek to minimize unused “chrome” (or
user interface features) on the screen and displays them only when they are needed.

Your screen should look like this:

B Text Input - Microsoft Visual Studio © Y QuickLaunch (Ctrl+0) Pl - 8 x
FILE EDIT  VIEW PROJECT BUILD DEBUG TEAM SOL DESIGN TOOLS TEST ~ ANALYZE WINDOW  HELP Michael ). Halvorson ~ [l
Q- B-2EWE 26 9- P Local Machine - G G Debug - .
g [UETERTSET I [MainPage.xaml.vb Appaml.yvb ~  Solution Explorer > 1x
g .
3 - @ e-20dil o
z
= Search Solution Explorer (Ctrl+;) P~
5
= [7E] Text Input (Windows 8.1)
" 5 My Project
g 3 Assets
) b Appaxaml
£ b [ MainPagexaml
o P Package.appxmanifest
<l 2 Text Input_TemporaryKey.pfx
@
-
3
g
T
g
2
Solution Explorer | Team Explorer
Properties > I x
Name | InputStrin K| F
P 9
Ty
Searc! Pl
100%  ~| EEE O 4 4 Arrange by: Category ™ -
G Design 1+ KAML DEE b Brush
umlns:local="using:Text_Input” +
xnlns: ttp://schemas.microsoft.com/expression/blend/2008" . P Appearance
wmlns :me="http://schemas.openxmlformats. org/markup-compatibility/2606" A @eTaTEn
mc:Ignorable="d"> N
axt
©  <Grid Background="{StaticResource ApplicationPageBackgroundThemeBrush}"> || AcceptsRetum []
<TextBox x:Name="InputString” ScrollViewer.VerticalScrollBarVisibility="visible” Horizi .
<TextBox x:Name="Qutput” Horizontalalignment="Left" Height="46" Margin="215,174,8,8" T/ RpRaseope
<Button x:Mame="TestButton” Content="Click to Test” Horizontalalignment="Left” Height= IsReadOnly [
</Grids - PlacenolderText
100% - 4 4 oolTipServic... &
Ready Ln11 Col 90 Ch90 INS

Working with Windows Store app controls 121



122

7.

Now you'll add some Visual Basic code to assign a new paragraph of text to a variable and
check it for keywords.

Click the MainPage.xaml.vb tab in the IDE to display the Visual Basic code-behind file in the
Code Editor.

You'll see the following three lines of program code in the TestButton_Click event handler:

Dim sampleText As String
sampleText = InputString.Text
Output.Text = sampleText.ToUpper

Keep the first two lines, but replace the last program statement with the following code block:

If sampleText.Contains("River") Then

Output.Text = "The string 'River' was found"
Else

Output.Text = "The string 'River' was not found"
End If

Your Code Editor should look like this:

= Private Sub TestButton_Click(sender As Object, e As RoutedEventirgs) Handles TestButton.Click I
Dim sampleText As String
sampleText = InputString.Text
If sampleText.Contains("River") Then
Output.Text = "The string 'River' was found"
Else
Output.Text = "The string 'River' was not found”
End If
End Sub
The four new lines of code comprise an If..Then...Else decision structure that determines
whether the word “River” is located in the first text box on the page. The first text box is
considered a multiline text box because it has been resized to hold more than one line. (The
change was automatic; in Windows Forms programming, you had to specify multiline with a
property setting.) With the larger text box, there is now plenty of room for the user to enter
a long paragraph of text, and scroll bars will permit content to go well beyond the physical

dimensions of the object.

The key method here is Contains, which determines whether the specified string ("River")
occurs in the current string (sampleText, a variable that holds a copy of the text in the first text
box). If the string "River" is found in SampleText, the message “The string ‘River’ was found”

is copied into the second text box. If the string "River" is not found (and note that this would
include any capitalization variation, such as "river"), the message “The string ‘River’ was not
found” is copied into the second text box.

You'll learn more about useful /f..Then...Else code blocks in Chapter 12, “Creative decision
structures and loops.”

10. Now run the revised Windows Store app.
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11. In the first text box on the page, type the following sample paragraph:

| hope to travel one day to a land with a beautiful, shimmering lake, or perhaps a
famous body of water—Ilike Loch Ness. Or, perhaps travel on a wine-dark sea and
sail for adventure and discovery. If not, | would be happy to fish for trout in the
Yellowstone River.

As you type, notice that the vertical scroll bars appear on the text box and allow you to scroll
if necessary. These scroll bars are visible now because you set the VerticalScrollBarVisibility
property to True. When the first text box has the focus or when you hover the mouse pointer
over the text box, the scroll bars will appear.

12. Click the Click To Test button.

Your screen will look like this:

| hope to travel one day to a land with a beautiful, A
shimmering lake, or perhaps a famous body of water-—-
like Loch Ness. Or, perhaps travel on a wine-dark sea
and sail for adventure and discovery. In not, | would be
happy to fish for trout in the Yellowstone River. v

The string 'River’ was found

Everything is working correctly. The word “River” was in the last sentence you typed, so the
appropriate message has appeared in the second text box.

13. Now remove the last sentence from the first text box. The last words visible there should be
“adventure and discovery.”

14. Click the Click To Test button.

Because the word “River” is no longer present, the other message is displayed in the second
text box. Your screen looks like this:
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| hope to travel one day to a land with a beautiful,
shimmering lake, or perhaps a famous body of water--
like Loch Ness. Or, perhaps travel on a wine-dark sea
and sail for adventure and discovery.

The string 'River’ was not found

Click to Test

You have successfully tested both cases in the If...Then...Else code block.
15. Close the application.
16. Click the Save All button to save your changes.

Well done! But before we move on, let's experiment with one final feature of the TextBox control.

Check spelling in a TextBox control

One of the most helpful features of Microsoft Office applications is that they can check your spelling
as you type. Although | have written dozens of books about computer software and historical sub-
jects, a day does not go by when | fail to spell check some text that | have written or edited.

A similar capability is available in Windows Store applications, and you can add it to many
container-type Visual Studio controls that are designed to manage text. In this section, you'll learn
how to enable the spell checker in the TextBox control. If you use the TextBox control in a commercial
application, your users will appreciate the convenience.

Use the IsSpellCheckEnabled property

1. Click the MainPage.xaml tab to display the Designer window in the IDE.

2. Select the first text box on the page (InputString) so that its properties are visible in the
Properties window.

3. Open the Properties windows, expand the second half of the Common category, and add a
check mark to the IsSpellCheckEnabled check box.

When set to True, the IsSpellCheckEnabled property activates a spell checker in the TextBox
control so that unidentified words are flagged with an underline feature. As with Microsoft
Office and other Windows programs, if you right-click a misspelled word, a list of potential
fixes will appear and you can select a correction.
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Add a check mark to the AcceptsReturn check box in the Common category.

Enabling this property will allow the user to enter a carriage return in the check box, which
can help format text.

Your Properties window should look like this:

Name | InputStrin F 5

P
Type TextBox

Search Properties P

»

Arrange by: Category ~

4 Common

Text u}
AcceptsReturn -
InputScope hd (=]
IsReadCnly O u}
PlaceholderText u}
ToolTipService.ToolTip u}
DataContext u}
~
AllowDrop O u}
Header u}
IsEnabled o
IsHitTestVisible o
IsSpellCheckEnablad n
IsTabStop u}
IsTextPredictionEnabled u}

Now try running the program again.

Click Start Debugging on the Standard toolbar.

In the first text box, type the following text:

Whan that aprill with his shoures soote

The droghte of march hath perced to the roote,

Weary students of medieval English literature might recognize these as the opening lines of
the Prologue of Geoffrey Chaucer’s Canterbury Tales. However, the Visual Studio 2013 spell
checker is not fully acquainted with this text and identifies several words for a closer look, as
noted in the following screen shot:
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Whan than aprill with his shoures socte
The droghte of march hath perced to the roote,

Click to Test

6. Right-click the third word in the text box (“aprill”), and see what sort of correction is suggested
by the spell checker.

The pop-up box on my system looked like this:

Whan than @Et” with his shoures sogte.
T perged to the roote,
April

aril

Aprils

Add to dictionary

Ignore

"o

For "aprill,” the spelling checker suggests that we consider “April,” “aril,” or "Aprils.” Alternatively,
we can ignore the correction (to preserve Chaucer's medieval English) or add the word to the

dictionary so that future spell checks recognize the word.

7. Click "April” to make a change and to see how spelling corrections are made in a TextBox
control.

Visual Studio deletes the old word and inserts a new one, as shown in the following screen
shot:
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Whan than April|with his shoures soote
The droghte of march hath perced to the rogte,

Click to Test

Spelling corrections work essentially as they do in Microsoft Office and most mainstream
applications for Windows. You've added a useful, professional grade feature to your list of
TextBox skills and techniques. You'll learn how to add a pop-up box to your user interface with
the Flyout control in Chapter 9.

8. Close the Text Input program.
9. Click Save All to save your final changes.
10. Click Close Project on the File menu to close the Text Input application.

It's time to move on to another Windows Store app control.

Using the FlipView control to display a series of images

Applications for Windows 8.1 are designed to be content-rich and visually interesting, with graphic
elements, photographs, video clips, and other special effects that engage the user and help them to
quickly focus on the task at hand. The FlipView control is one such design tool. It allows you to present
a collection of images to the user that is stunningly beautiful and easy to navigate through.

In this section, you'll learn how to use the use FlipView control in a Windows Store app to display
a series of photographs that fill up the entire screen. To prepare images for the control, you'll add six
test images that I've created for you to the Assets folder in a Visual Studio project, and then you'll cre-
ate a large FlipView control on the page to display the photos.
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Add images to the Assets folder

1.

On the Visual Studio File menu, click New Project.
The New Project dialog box opens.

In the Visual Basic template group, click Windows Store, and then click the Blank App (XAML)
project.

Visual Studio prepares the IDE for a basic Windows Store app.
In the Name text box, type My Image Gallery.

Visual Studio assigns the name My Image Gallery to the project.
Click OK to create the new project in Visual Studio.

Visual Studio opens a new project and displays the code associated with the blank application
template.

Open Solution Explorer in the IDE if it is not currently visible.

In Solution Explorer, right-click the Assets folder, select Add | Existing Item, and browse to the
My Documents\Visual Basic 2013 SBS\Chapter 05 folder.

You'll see the following Add Existing Item dialog box:

@ = 1 L« Visual Basic 2013 SBS » Chapter 05 » v | & Search Chapter 05

Organize New folder

4 | Visual Basic 2013 SBS A

. Chapter 02 i | B i

b0 Chapter 03 N \
b0 Chapter 4

4 | Chapter 03 | 2 - . 2 2 -

Lo AV Jukebox AV Jukebox Image Gallery Text Input Web Browser

1 Image Gallery

LY
B0 Text Input 3
[+ Web Browser N A 3
Chapter 06 0 \
&) il

Chapter 07 Carrats Electra Sample Merry-ga-raundd Manument
Chapter 08

&
»

»

L0 Chapter 09 . s

10 Chapter 10 e

1. Chapter 11 .

&

Chapter 12 " Sand

File name: | v | |ANFiles 0

As you learned in Chapter 3, the Assets folder in Solution Explorer allows you to include
resources in a project so that they can be referenced easily in XAML markup and Visual Basic
code. An additional benefit is that the asset files will be added to the project automatically
when it is distributed.
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9.

Hold down the Ctrl key, and then click the six files entitled Carrots, Monument, Mountain,
Ocean, Sand, and Tree.

Tip You can select contiguous or noncontiguous files by holding down the Ctrl key
and clicking the desired files.

These are images of natural objects and an architectural detail, which | have taken over the
past few years—the type of full screen images that look really good in a FlipView control.

Click Add to add the selected items to the Assets folder.

Visual Studio adds the selected images. Now you'll create a FlipView control on the page to display
the images.

Add a FlipView control to the page

1.

Double-click the MainPage.xaml file in Solution Explorer to open the main application page in
the Designer window.

Click the Zoom tool in the Designer, and then click the Fit All option so that you can see the
entire page in the Designer.

Open the Toolbox, and find the FlipView control.

Although you could use this control now to create the flip view object you'll use, I'm going to
direct you to create the object using XAML markup. This step allows you to set more precise
dimensions for the FlipView frame, and you can also use XAML markup to nest the images
nicely within the FlipView control.

Learning to nest a child control (/mage) within a parent control (FlipView) is an important skill
that you'll practice often in this book.

Close the Toolbox, and open the XAML tab of the Code Editor, which should be open now
beneath the Designer window.

After the line of markup that includes the keywords Grid Background, enter the following
XAML markup to define the FlipView control and six Image controls within it:

<F1lipView Height="750" Width="1000">
<Image Source="Assets/Tree.jpg” />
<Image Source="Assets/Carrots.jpg” />
<Image Source="Assets/Mountain.jpg” />
<Image Source="Assets/Sand.jpg” />
<Image Source="Assets/Ocean.jpg” />
<Image Source="Assets/Monument.jpg” />

</FlipView>
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Notice how you are placing each new image definition on its own new line, and at the top of
the markup, you set the height and width of the FlipView control. While you are entering this
markup, Visual Studio’s IntelliSense feature helps you by supplying some of the keywords,
quotation marks, and indents. (Note that the indenting here is just for clarity; you could also
enter all of the markup on one line in the Code Editor.)

| chose the dimensions 750x1000, measured in pixels, so that the FlipView control would fill up
most of the screen on my computer display. However, if you are using a higher resolution dis-
play setting, the control might not fill up your screen entirely. You can adjust this by specifying
a larger FlipView height and width if you like.

The Designer and IDE will look like this when you are finished:

ﬂ Image Gallery - Microsoft Visual Studio & Y QuickLaunch (Ctrl+Q) P oo m x
FILE EDIT WVIEW PROJECT BULD DEBUG TEAM SOQL DESIGN TOOLS TEST  ANALYZE  WINDOW  HELP Michael ). Halvorson = n
< B-amd 9 9- P Local Machine ~ 6. (5 o Debug - -
e Appxamlvb = Solution Explorer s w X
- @ e-Fuand
Search Salution Explorer (Ctrl+;) Lo~
E Monument jpg -
= Mountainjpg
[ Oceanjpg
[ Sand,jpg

[#] SmallLogo .scale-100.png
[ SplashScreen.scale-100.png
[ StereLego.scale-100.png
F Treejpg
I Appaml
& Image Gallery_TemporaryKey.pfx
b L) MainPagexaml
B5) Package.appxmanifest

-

xag|oa| AR SUN0S ElR(]  FUIRNQ JEWNIOQ

Solution Explorer | Team Explorer

Properties - ax
g Name <NoName> 5
(= Type  Grid
| Search Properties P
a01% - o ] » Arrange by: Categery ~ =
GDsign  t gxaml O OEE gyeh
+
+
5 <Grid Background="{StaticResource ApplicationPageBackgroundThemeBrush}"s | ppeamnce
E <Flipview Height="758" width="1288" > 4 Commen
<Image Source="Assets/Tree.jpg" /> )
<Image Source="Assets/Carrots.jpg" /> ErihTe (@l [
<Image Source="Asscts/Mountain.jipg” /> ToolTipSeric...
<Image Source="Assets/Sand.jpg" /> P
<Image Source="Assets/Ocean.jpg” /> PataContext BEY
<Image Source="Assets/Monument.jpg” /> v
</Flipview> b Layout

o0% - 4

b Transform

Col 11

Your Image Gallery program is now ready to run.

Click Start Debugging on the Standard toolbar.

The program runs, and the first image appears on the page, as shown in the following screen
shot. This photo is of a giant Douglas fir tree in a Washington State forest.
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Notice the small arrow pane or Next button on the right side of the image, which appears
when you first move the mouse or touch the screen. This is a scrolling feature that allows you
to move to the next image in the collection. You can also move forward or backward in the
image collection by swiping or using the direction keys.

Move the mouse pointer to the right side of the page, and click the Next button.
A second image appears of carrots for sale at a farmer's market in Cambridge, England.

Click through the remaining images until the final photo appears, a time-worn stone bust of a
princely figure on the side of a building in London, England.

Your screen will look like the following screen shot. Because this is the last image in the
FlipView control, only the Back button appears on the left side of the image.
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9. Feel free to scroll back through the images, and then move forward again.

As you can see, the FlipView control allows you rapid access to a series of photos, and you can
scroll through them with minimal visual distractions (no scroll bars, buttons, or toolbars to
look at). This graphics-centered content is at the heart of the Windows 8.1 user interface, and
you'll find FlipView to be very helpful when you are designing a photo sorting program, music
catalog tool, or any type of Windows Store app where a large number of images need to be
displayed quickly.

10. Close the application when you have finished examining the photos.

11. Save your changes, specify the My Documents\Visual Basic 2013 SBS\Chapter 05 folder for the
project, and then click the Close Project command on the File menu.

Visual Studio save your files and then closes the project.

You're finished with the FlipView control for now. However, keep in mind that you worked with the
FlipView control in this chapter without adding any Visual Basic program code at all. You can enhance
your program by adding an event handler for the SelectionChanged event so that each time you click
the Next or Back buttons, you perform some additional action, such as playing a sound effect or
displaying information in a TextBox on the page.

You can experiment with these additional features another time. In the next section, you'll learn
how to play entertainment media in a Windows Store app, such as audio clips or a short video file.
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Using the MediaElement control to play entertainment media

In addition to the colorful images that you can display with the FlipView control, a Windows Store
app can be enhanced by the inclusion of entertainment media, such as music or sound effects, video
footage, commercials, or other A/V media. You experimented a little bit with this feature in Chapter 3
when playing a musical sound effect for the Lucky Seven program.

The procedure for integrating entertainment media involves adding the media file or files to the
Assets folder in your Visual Studio project and then adding a MediaElement control to the page to
run the media file when it is needed. The MediaElement control is located in the Windows Store app
Toolbox, and when you add it to a page, it has no visible interface. (However, you'll learn how to add
its interface later in this chapter.) In addition to the basic playback features that you might expect in a
media control, MediaElement offers several features that will allow you to customize how the audio or
video media is controlled and displayed.

In this section, you'll learn the basics of the MediaElement control and its essential features. You
should note that audio and video files are stored electronically in a variety of formats and that some
of the proprietary ones (such as Apple’s iTunes) are not supported by the MediaElement control.
However, popular media formats like MP3, WAV, AVI, and MPEG-4 are all supported and will provide
you with plenty of content choices for your applications. There are also software tools available that
will allow you to create media files, edit them, and translate them from one format to another.

First, you'll play an electronic music file in your Windows Store application. In the next section,
you'll learn how to manage video playback on a page.

Play music with the MediaElement control

1. On the Visual Studio File menu, click New Project.
The New Project dialog box opens.
2. Inthe Visual Basic template group, click Windows Store, and the Blank App (XAML) project.
3. In the Name text box, type My AV Jukebox.
4. Click OK to create the new project in Visual Studio.
Visual Studio opens the new project with a blank application template.
5. Double-click the file MainPage.xaml in Solution Explorer.

Visual Studio opens MainPage.xaml in the Designer window.
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10.

11.

12.

13.

14.

Open the Toolbox, open the All XAML Controls category, and double-click the MediaElement
control.

Visual Studio places a new media player object in the upper-left corner of the application
page. You can set various property settings for MediaElement. However, you will be able to
see the MediaElement control only while you are designing your project. When the program
runs, the MediaElement control remains hidden, unless the control is displaying a video clip.

The Source property of the MediaElement control specifies the name of the media file that will
be loaded into the control for playback. The best way to supply a media file is to add the file
via the Assets folder in your application.

You'll add an electronic music file to this folder now.
Right-click the Assets folder in Solution Explorer to display the shortcut menu of commands.
Point to the Add command, and then click Existing Item.

In the Add Existing Item dialog box, browse to the My Documents\Visual Basic 2013 SBS\
Chapter 05 folder and click Electro Sample, an MP3 file containing electronic music. This file
was created by my son, Henry Halvorson.

Tip You might also be able to locate additional audio files on your system in the
Libraries category, in the My Music folder.

Click Add to add the music file to your project in the Assets folder.
Visual Studio inserts the file, and it appears now in Solution Explorer under Assets.

Now you're ready to assign this music asset to the Source property of the media element
object.

Click the media element object in the Designer window, and then open the Properties
window.

Change the Name property to MediaTool.

Expand the Media category, scroll down to the Source property, and click the Source list box.
Your new media file (Electro Sample.mp3) appears in the list.

Click the media file to link it to the media element object.

Your Properties window will look like this:
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15.

16.

17.

o Name  MediaTool £
Type MediaElement
Search Properties P
Arrange by: Category ~ -
4 Media
AudicCategory Other -0
AudioDeviceType | Multimedia -0
AutoPlay [u]
Balance 0 o
IsLooping O [u]
Ishuted O u}
Position 00:00:00 o
PosterSource -0
RealTimePlayback O [u]
Source |Asse:s,f'EIectrc Samplempd =W
Volume 1 o
v -

Now you're ready to save and run the project.

Click the Save All command on the File menu to save your project, and specify the My
Documents\Visual Basic 2013 SBS\Chapter 05 folder.

Click Start Debugging on the toolbar.

The My AV Juke Box application runs, and the selected music starts playing. Because the
MediaElement control has no user interface to interact with, you'll see only a blank screen. The
“Electro Sample” music track runs until it is complete (a little less than a minute), and then the
program waits for you to terminate it. (This is electronic music created with the Ableton Live 8
software suite.)

Now you'll close the program and add a few buttons to the page to control the playback as a
typical music-sampling program might.

Close the My AV Jukebox program.

In the following exercise, you'll add Play, Pause, Stop, and Mute buttons to the Windows Store app.

Control playback with buttons

Change the Designer's Zoom setting to 100%.

Use the Button control in the Toolbox to add four Button controls to the left side of the page
in the Designer.

Set the Name properties for the button objects to PlayButton, PauseButton, StopButton,
and MuteButton, respectively.

Set the Content properties for the button objects to Play, Pause, Stop, and Mute,
respectively.
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The following screen shot shows how your new button objects should look on the page when
you're finished. (Note also the MediaElement control and the XAML markup for the object in
the Designer.)
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Now you'll write one-line Visual Basic event handlers for each of the four button objects.

5. Click the PlayButton object, open the Properties window, and then click the Event Handler
(lightning bolt) button to see the list of event handlers for the Button control.

6. Double-click the text box next to the Click event to create a new event handler.
7. Enter the following line of Visual Basic program code:
MediaTool.Play()

This line uses the Play method of the MediaElement control to play the loaded media file at
the current play position. If the media file has been paused, the Play method will cause it to
resume. If the media file has been stopped, the Play method will cause it to start again at the
beginning.

Now you'll repeat similar steps with each of the remaining buttons, creating event handlers
with appropriate methods or properties for each action.

8. Return to the Designer, and click the Pause button.
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9.

10

11

12

13

14

15

In the Properties window, double-click the text box next to the Click event and type the fol-
lowing line of code into the PauseButton_Click event handler:

MediaTool.Pause()

This line uses the Pause method to pause the loaded media file at the current play position.
This feature can be used to give users some control as they listen to music or watch video.

Return to the Designer, and click the Stop button.

In the Properties window, double-click the text box next to the Click event and type the fol-
lowing line of code into the StopButton_Click event handler:

MediaTool.Stop()

This line uses the Stop method to end audio or video playback. Different from the Pause
method, which temporarily stops playback but retains the current position in the track, the
Stop method ends playback. If you execute the Play method after the Stop method, playback
will begin again, but at the start of the media file.

Return to the Designer, and click the Mute button.

In the Properties window, double-click the text box next to the Click event and type the fol-
lowing code:

MediaTool.IsMuted = Not MediaTool.IsMuted

This line uses the Boolean IsMuted property to mute or unmute audio playback. The statement
uses the Not operator to switch, or toggle, the current value of IsMuted. If playback is currently
muted, the statement will remove the muting effect. If playback is currently unmuted, the
statement will mute playback.

Click the Save All command on the File menu to save your changes.
Now you'll run the program again to see how the four playback controls work.
Click Start Debugging on the toolbar.

The My AV Jukebox application runs, and the selected audio file begins to play. Your screen
should look like this:
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16.

17.

18.

19.

20.

21.

22.

After a few moments of electronic music, click the Pause button.

The song pauses at the current playback position.

Click the Play button.

Audio playback resumes right where you left off.

Click the Mute button.

The music is muted (volume is temporarily set to 0), but playback continues.
After a few moments, click the Mute button again.

The original volume setting is restored, and you'll be able to hear music again. However, you
might notice that the song has advanced, and if you wait too long, the song will end. That is,
the Mute button is different from the Pause button.

Click the Stop button.

Audio playback terminates.

Click the Play button.

The electronic music file begins again, but at the beginning of the song.

Continue experimenting with the playback controls you just created. When you're finished,
quit the program.

As you can see, the MediaElement control not only allows you to play audio files, but it provides
you with interesting methods and properties to control what happens during playback. You can
create buttons and other features that let the user control what is happening, or you can control
playback behind the scenes in event handlers—playing audio tracks only when you want them to be

played.
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In the next section, you'll modify the My AV Jukebox app so that it plays a video file rather than a
music file.

Play videos using the MediaElement control

1. Display Solution Explorer, and then right-click the Assets folder to display the shortcut menu.
2. Point to the Add command, and then click Existing Item.

3. Inthe Add Existing Item dialog box, browse to the My Documents\Visual Basic 2013 SBS\
Chapter 05 folder and click Merry-go-round, a video file in WAV format created for this book
by Henry Halvorson.

You might also be able to locate valid video files on your system in the Libraries category, in
the Videos folder.

4. Click Add to add the video file to the project’s Assets folder.

Visual Studio inserts the file. All you need to do now is replace the reference to the music file
from the last exercise with the video file that you just added.

5. Click the media player element again in the Designer, and then open the Properties window
and click the Properties button.

6. Expand the Media category, scroll down to the Source property, and click the Source list box.
7. Click the video you just added to link it to the media element object.

Your video file is ready to run. However, for best results, you'll want to resize your media
element object so that it is larger, because the current playback window is a bit small. The
window size you set is up to you, but keep in mind that a variety of devices might need to run
your program (all with different screen dimensions), so pick a size that makes sense for your
application.

8. In the Designer window, move the media element object to the right of the four button
objects.

9. Increase the size of the media element object so that it takes up about one-third of the screen.

You can fine-tune the size after you run the program and get a sense for how big the video
window is. Your Designer will look like this (note the selected media element object on the

page):
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10.

11.
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Now you're ready to test the application.

Click the Save All command on the File menu to save the changes to your project.

Click Start Debugging on the toolbar.

The My AV Jukebox app runs, and the selected video file begins to play in the window you
moved and resized. The media playback controls you created will work just as they did for the
audio file, with the caveat that now you'll have both video and audio. This merry-go-round is

at a local park by my house.

Your screen should look something like this:
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12. Experiment with the Pause, Play, Stop, and Mute buttons in the project.

The MediaElement control is designed to work with both audio and video files, so the pro-
gram’s event handlers manage your playback requests with no code changes. This particular
media file was edited with Windows Movie Maker.

13. When you're finished, quit the Windows Store app.

If you like, you can go back into the project and experiment with additional audio or video
files on your computer. Just be careful not to insert files that are too large, because they can
be cumbersome when it comes time to distribute your app!

14. When you're finished working with the program, close the Visual Studio project.

Use the WebView control to display live web content

Windows Store apps are designed to be sold and installed over the Internet and to take advantage of
information that resides on the web in a variety of ways. One of the simplest ways to access web data
in a Windows Store app is simply to open a browser window on your application page and to allow
the user to access a website directly. Visual Studio allows you to do this programmatically with the
WebView control in the Windows Store app Toolbox.

The WebView control is not a full-featured web browser like Internet Explorer. However, it was
added to the Windows Store app toolbox so that programmers would have an easy way to display live
web content if they needed to in a Windows Store application. In the following section, you'll explore
this feature and some of its practical uses.
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Create a simple browser with the WebView control

1.

10.

11.

12.

13.

On the Visual Studio File menu, click New Project.
The New Project dialog box opens.

In the Visual Basic template group, click Windows Store, and then click the Blank App (XAML)
project.

In the Name text box, type My Web Browser.

Click OK to create the new Visual Studio project.

Visual Studio opens the new project template.

Double-click the file MainPage.xaml in Solution Explorer.
Visual Studio opens the app’s user interface in the Designer.

This program will feature a TextBox control to hold the web address, a Button control to
navigate to the web address, and a WebView control to display the specified webpage. Create
these items now.

At the upper-left corner of the page, create a long, single-line text box object, using the
TextBox control in the Toolbox.

Use the Properties window to set the text box’s Name property to URL, and set the text box’s
Text property to http://michaelhalvorsonbooks.com.

At the top of the page, to the right of the new text box object, create a small button object,
using the Button control in the Toolbox.

Use the Properties window to set the button object’s Name property to NavigateButton, and
set the button’s Content property to Open.

Click the WebView control in the Toolbox. (You'll find it in the All XAML Controls section.)

Using the control’s drawing pointer, create a very large rectangular box on the page below the
text box and button objects.

In this simple test app, the goal will be to display as much of the web browser as possible so
that the user will not need to use scroll bars to examine information that is beyond the edge
of the WebView control window. So make the WebView control really big, taking up all the
remaining real estate on the page.

After you create the object, you might want to close the Toolbox window and adjust the
amount of zoom magnification in the Designer window to make as much of the page visible in
the IDE as possible. (The Zoom tool’s Fit All setting will help you do this.)

Use the Properties window to set the web view object’s Name property to Browser, and set
the HorizontalAlignment and VerticalAlignment properties to Center.

Designing the user interface
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15

The alignment-related properties are located in the Layout category, and they center-align
content in the browser window.

Your final user interface should now look similar to the following screen shot. (Again, note that
the XAML markup for the WebView control has been added to the Code Editor.)
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